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Trademarks and Proprietary Notice 

Copyright 2009-2015 (user assistance, documentation and software) by Mettler-Toledo AutoChem, Inc. All 
rights reserved. 

Printed in the United States of America. 

Neither this document nor the software described herein may be reproduced, transmitted or disclosed to 
third parties, in whole or in part, in any form or by any manner, electronic or mechanical, without the express 
written consent of Mettler-Toledo AutoChem, except to the extent provided for by specific agreements. 
Mettler-Toledo AutoChem reserves the right to make improvements in this document and the software it 
describes at any time, without notice or obligation. 

iC FBRM™, iC PVM™, iC IR™, iControl™, ParticleTrack®, and ParticleView® are trademarks and FBRM is a 
registered trademark of Mettler-Toledo AutoChem, Inc. Microsoft® and Windows® are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. 

All other brand and product names are trademarks or registered trademarks of their respective owners. 
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iC FBRM™ Introduction 

The iC™ FBRM® software platform interfaces with the ParticleTrack™ series of instruments and provides 
powerful data acquisition and interpretation tools that enable users to quickly evaluate Focused Beam 
Reflectance Measurement (FBRM) data. 

iC Main Features 

iC FBRM software is the result of over 20 years of particle characterization experience.  As a result, the 
software helps users develop a strong understanding of particle system dynamics, optimize experimental 
design, speed development time, and quickly identify and solve production issues. Intuitive report 
generation tools produce professional reports at a click of the mouse. 

The iC FBRM software enables you to: 

• Enhance your understanding of particle system dynamics through innovative tools 

- Innovative distribution display enhances the ability to track changing particle dimensions on the 
fine and coarse tails of the particle distribution at the same time. 

- Mechanisms for particle size and shape change can be understood and quantified using trended 
statistics, distributions, and PVM® inline images, all of which may be linked at a click of the mouse.  

- Particle system kinetics can be qualified through new dynamic rate of change statistics. 

• Optimize your experimental design conditions  

- Optimize batch conditions in the laboratory or during scale up to manufacturing.  

- Target an endpoint particle distribution using one integrated software suite which enables users to 
drag, drop, and overlay distributions and trends from multiple time points and multiple batches 
during live acquisition or post processing.  

- Relate experimental design conditions to particle system dynamics by importing process variables - 
such as temperature, pH, RPM, and dosing - onto FBRM trended statistics.  

• Reduce data acquisition and analysis burden     

- Comprehensive online user assistance, video demos, and webinar based tutorials teach and answer 
questions within seconds.  

- Method-based setup ensures reproducibility of data acquisition. Saving data analysis sessions 
enables consistent data analysis even with interruptions.  

- Single-click report generation is available for professional data presentation. 
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DOCUMENT TYPES 

iC FBRM organizes data into various types of “documents”—Experiments, Result Sets, Distribution Libraries, 
as follows. 

Experiments 

Experiments are the heart of iC FBRM data. They include experiment data plus all related pure measurements, 
system messages, annotations, and analysis settings associated with your experiment. The Start Experiment 
Wizard guides you through the process of preparing your experiment. Once started, you can monitor and 
control your experiment from the Experiment Display which can also be used to analyze previously recorded 
experiments. 

Result Sets 

Result Sets are great for comparing results between experiments. Each result set consists of one or more 
trend graphs each containing one or more profiles. 

 
The easiest way to add a trend profile from an experiment into a result set is to open both files, then 
simply drag and drop profiles into result sets. 

 
Each profile in a result set has a link back to the original experiment—simply right-click on the profile 
and select “Open Trend Source” to display and access the original experiment. 

Distribution Libraries  

Distribution Libraries provide a shared repository for references and distributions. The Working with 
Distribution Libraries section guides you through the process of creating a new library and how to view 
distributions. New Distributions can be collected from the past or live experiments or copied from another 
Distribution Library. 

Note: Document files (experiment, result sets, distribution libraries) are normally writeable and as such 
can be edited. A read-only document file can be opened and edited as normal. When an attempt is 
made to save a read-only document, a Save As dialog box appears requiring the document be 
saved under a different filename. If an attempt is made to close an edited read-only document, the 
following error message appears. 

 

Click the OK button to open the Save As dialog box. 

  



 

Page 9  

SUPPORTED HARDWARE 

All ParticleTrack™ instruments use FBRM® measurement technology to track the rate and degree of change 
of particles and droplets as they occur in their actual process environment. Inline measurements of particle 
dimension, count, and shape are recorded in real time without the need for sample extraction or dilution. 

ParticleTrack is the brand name for all current instruments featuring FBRM technology. ParticleTrack 
instruments include onboard smart chip technology for storage of critical calibration and system 
configuration information—providing better security and traceability in experimental and process FBRM data.  

iC FBRM software supports the following instruments:  

Instrument Description 

ParticleTrack G400 • Laboratory inline particle analyzer, manufactured since January 1, 2013. 

• Includes ParticleTrack ACIO smart chip technology for onboard system memory. 

• Fixed probe or interchangeable probes. 

• Simultaneously measure and record data with two Chord Selection Models (CSMs). 

• Up to two probe systems can be operated per PC. 

ParticleTrack 
G600/G600 Ex 

 

• Plant/pilot scale inline particle analyzer, manufactured since January 1, 2013. 

• Includes ParticleTrack ACIO smart chip technology for onboard system memory. 

• Simultaneously measure and record data with two Chord Selection Models (CSMs). 

• Low maintenance design (pneumatic scanner/air bearing configuration). 

• Ex systems include purge overpressure and are rated for operation in 
IECEx/ATEX/Class I, Division 1 environments. 

ParticleTrack E25 • Plant/pilot scale inline particle analyzer for non-hazardous environments 

• Fixed 25 mm probe. 

• Includes ParticleTrack smart chip technology for onboard system memory. 

• Simultaneously measure and record data with two Chord Selection Models (CSMs). 

• Electric scanner probe design, not intended for hazardous environments. 

The smart chip technology in ParticleTrack instruments enables the unit to store key calibration parameters 
and make the instrument configuration much easier. When moving a ParticleTrack instrument from one PC 
to another PC, there is no need to re-configure the instrument. The control computer automatically detects 
ParticleTrack instruments when they connect to the iC FBRM PC. The following parameters store in the 
ParticleTrack instrument and transfer to the iC FBRM software: 

• Unit serial number 
• Probe type 
• Probe diameter 
• Scan circle diameter 
• CP1, CP2 and CP 3 
• Calibration Validation date 

DATA STORAGE AND TRANSFER OPTIONS 

iC FBRM supports a central data storage feature (see iC Data Center™) and OPC UA-compliant data transfer. 
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QUICK REFERENCE GUIDES 

Quick Reference Guides are single sheets that introduce commonly used functions of the iC FBRM software. 

MK-PB-0030-AC QuickRef-Experiment Setup in iCFBRM.pdf 

MK-PB-0029-AC QuickRef-Data Review and Analysis in iCFBRM.pdf 

These documents are included in the online iC FBRM Documentation Portfolio. 

For introductory information, watch video tutorials to become familiar with the iC FBRM software. Links to 
the videos are on the Start Page under More Information. 

FBRM DATA ANALYSIS WEBINARS 

METTLER TOLEDO FBRM provides an information-rich method for tracking the number and dimension of 
particles or droplets as they actually exist in process. In any given particle or droplet system, there are 
specific and possibly unique changes that are of critical importance to the user.  

This four-part webinar series explores how you can maximize data analysis.  

Beginners FBRM Data Analysis—The Maximize Data Analysis with METTLER TOLEDO FBRM webinar provides 
an introduction to iC FBRM. 

View the Maximize Data Analysis with METTLER TOLEDO FBRM webinar. 

Advanced Part 1: Mechanisms of Particle Change—How does FBRM track particle agglomeration, breakage, 
attrition, growth, and shape? How can users extract a mechanistic understanding of these changes from 
FBRM data? By using the correct analysis tools, weighing, and statistics, specific particle changes can be 
understood and optimized with maximum precision.  

View the Mechanisms of Particle Change webinar. 

Advanced Part 2: Correlating to Process Efficiency and Product Quality—How can FBRM be correlated to predict 
downstream process efficiency or product quality? How can FBRM be correlated to an offline particle 
measurement such as laser diffraction, sieving, or microscopy? This webinar will provide examples of direct 
correlations between FBRM data and process efficiency such as filtration, flow properties, or dissolution rates 
as well as correlations with product quality such as bulk density, stability, color, and particle size. 

View the Correlating to Process Efficiency and Product Quality webinar. 

Advanced Part 3: Overcoming Pitfalls to Data Interpretation—How do changes in the particle system physics 
affect FBRM data? The FBRM measurement principle has inherent sensitivity which can affect results in ways 
unexpected by chemists and engineers. Understanding these particle system properties can significantly 
increase success with FBRM data interpretation. 

View the Overcoming Pitfalls to Data Interpretation webinar. 

 

Using iC Menus 

The iC application contains four pull-down menus located on the main menu bar. 
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FILE MENU 

The Files menu contains options for experiment file functions such as opening and saving and exporting 
experiment data. (Recall that iC files—experiments, Result Sets, Distribution Libraries—are referred to as 
documents, as described under the Document Types section.) 

 

The menu contains the following options. 

New  Experiment—Creates a new experiment document.  

Distribution Library—Creates a new Distributions Library for comparisons and analysis of 
selected distributions from different experiments. 

Result Set—Creates a trend comparison module for overlaying and synchronizing 
trended statistics from multiple experiments or from multiple iC platform software, such 
as iC IR. 

Open When you select ‘Open,’ the system remembers the most recently used folder for each 
type of iC document file and displays the list from that location. 

Experiment—Opens an existing experiment document (*.icFbrm).  

Distribution Library—Opens an existing Distributions Library (*.icDistribs) for comparison 
and analysis. 

Result Set—Opens an existing Result set (*.icResults) for analysis or insertion of additional 
measurement from other experiments. 

Import Imports .LST and ICFBRMRAW files from previous versions of FBRM. 

Close Closes the current document file. 

Save Saves the current opened document file. 

Save As Saves the current experiment as a new file with a name defined by the user. 

Save as 
Template Saves the current experiment as a template. See Saving an Experiment as a Template. 
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Export Exports a CSV (Comma 
Separated Values) 
formatted report of 
experiment data.  

See Exporting 
Experiment Data for 
more information. 

Create MS 
Word Report Generates a pre-formatted report of the current experiment in MS Word format. 

Create Read-
only Report Generates a pre-formatted, read-only report of the current experiment in XPS format. 

Exit Closes all document files and 
closes the iC FBRM software. If 
there are any unsaved changes 
to open documents, a dialog 
prompts you to save the 
changes before exiting. Use 
the check box to save changes 
to all open documents. 

 

TOOLS MENU 

The Tools menu contains the following menu options: 

 

• Preferences—See Preferences Dialog. 

• Connect to other iC/iControl applications—See Interaction with Other iC Applications. 

• Configure iC Data Center—See Configuring iC Data Center. 

• Instrument Connections Dialog—Configures the connections to FBRM Service 4.4. 

• Manage Probes—Manages probe tips. See Managing Probes. 

• Run AutoStats—Executes an automated analysis evaluation. See AutoStats. 
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Preferences Dialog 

Clicking the Preferences item in the Tools menu opens the Preferences dialog box.  

 

Click a check box to enable a preference. Clicking Reset All returns the preferences to the factory default 
states. Clicking Cancel exits the window without saving changes. Clicking OK saves the changes and exits the 
window. 

Below are the Preference options. 

Display the Start Page 
when iC starts 

If this option is checked, the Start Page with a list of top-level functions displays 
when the software starts. When unchecked, the software opens with a blank 
screen and the pull-down menus must be used to start a program. 

Display the Toolbox when 
iC starts 

If this option is checked, the toolbox displays when the software first starts. 
Otherwise, the toolbox is closed and can be opened when needed by clicking 
along the right edge of the application window. 

Show documents as tabs If this option is checked, multiple documents (experiments, Result Sets, 
Distribution Libraries) display as tabs to the right of the Start Page tab. 
Otherwise, multiple documents appear as separate windows similar to other 
Windows programs. 
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Allow docking controls to 
be undocked 

If this option is checked, you can drag controls such as the Surface Viewer off the 
form and arrange them as independent windows. This is particularly useful if you 
have a multi-monitor display. When selected, this option takes effect on newly 
opened documents but has no effect on currently open documents.  

In Trend Viewer ‘Sample’ 
mode, align samples by 
elapsed time 

This option relates to Reference Trends and how the Trend Viewer handles the x-
axis time display if you switch between “Relative Time” and “Sample Number.”  

• If this option is unchecked, Reference Trend shifts if you toggle the X-Axis 
between Relative Time and Sample Number. 

• If this option is checked, Reference Trend does not shift—Relative Time is 
the elapsed time from the start of the experiment. 

Note: To switch the X-Axis Format, use the right-click context menu to change 
between “Relative Time” or “Sample Number.” 

In Trend Viewer, snap 
vertical time bar to 
nearest sample 

When this option is checked, the Trends Viewer behavior is: Release the mouse 
button within the Trends Viewer and the vertical bar snaps to the nearest sample 
position. 

When this option is unchecked, release the mouse button and the vertical bar 
stays at the location where the mouse button is released. 

Suppress network drive 
warning 

If the option is checked, warning messages about saving data to a network drive 
do not appear. 

Items in Recent 
Documents list: 

Specify the number of recent documents to display on the Start Page and File 
menu. 

Use alternate rendering 
(3D graphics) 

Use this option if you are having problems with displaying 3D graphics in the 
Surface Viewer. Problems with 3D graphics are usually solved by switching the 
graphics card to 16-bit graphics. If that does not work, switch the graphics card 
back to 32-bit and then check this option. 

Hide Surface Viewer Hides the Surface Viewer in all viewing configurations (see Surface Viewer). 

Always bypass the New 
Experiment wizard 

When checked, the New Experiment Wizard is bypassed. An experiment is 
created using ‘One-Click experiment’ even when user clicks the ‘New Experiment 
Wizard’ button on the Start Page. Experiment duration and measurement interval 
are determined by previous experiment or by experiment template (see One-
Click experiments). 

Allow PVM images to be 
viewed 

If this option is checked, Particle Vision and Measurement (PVM) image display is 
enabled (see PVM Viewer). 

Remove relative time 
gaps when samples 
discarded after pause 

If the option is checked, when the user comes out of pause mode and chooses to 
discard the samples, the time gap for the pause period is removed (in relative 
time mode). Refer to Starting the Experiment. 

Show iC Process task 
pane 

When checked, a Process task pane appears in the toolbox to enable viewing and 
analyzing batch and continuous process runs of instruments controlled by iC 
Process for FBRM software. 
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Instrument Connections Dialog 

ParticleTrack instrument connections are automatically established and the instrument configuration is 
automatically synchronized with the system configuration stored on the instrument PC based on the 
instrument selected during software installation.  

If necessary, use the Instrument Connections dialog box to verify the FBRM Server connections to the iC 
FBRM software by scanning for the instrument. You can also check the Instrument Connections if you 
encounter any connection issues.  

Notes:  

• Only one FBRM Server can be defined and used at a time.  

• The Instrument Connections window will not open while experiments are running. 

1. Access the Instrument Connections window from the Tools menu.  

 

 

The window contains the defined server connection and its name, URL, equipment type, and number of 
probes. The ‘FBRM Server Running’ field displays the current operational status of the server. Verify the 
correct probe type and number of probes. 

2. Click Edit to scan for the connected instrument. Since ParticleTrack instruments are automatically 
detected, they cannot be edited. The following message verifies the connection.  
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If the instrument is not connected to the PC, clicking the Edit button shows no instrument Type. 

 

Connecting a ParticleTrack Probe with iC FBRM 

Follow the steps below to connect a ParticleTrack G400, G600, or E25 probe with iC FBRM. In the case of 
ParticleTrack G400 systems, up to two may be configured on a single control PC. This is known as a dual-
probe configuration, and the software labels them as ProbeA or ProbeB. When installing a dual-probe 
configuration, complete the configuration of a single system first. Do not connect the second system to the 
control PC until the first system has been configured. 

Configuring a single ParticleTrack system: 

1. Start with the computer OFF. 

2. Plug the ParticleTrack base unit into the computer and power the instrument ON. 

3. Power ON the computer. 

4. Log on to the PC and start the iC FBRM software application. 

5. Follow the steps for Configuring the Instrument through the software to prepare the probe system 
for use in an experiment. The probe configuration must be completed in the software before an 
experiment can be run.  

Adding a second ParticleTrack G400 for a dual-probe configuration: 

1. Plug the second G400 base unit into the computer and power the instrument ON. 

2. Select Tools > Instrument Connections, and click Edit. The software displays a message that the 
instrument is connected and cannot be edited. 

3. Follow the steps for Configuring the Instrument through the software to prepare the probe system 
for use in an experiment. The probe configuration must be completed in the software before an 
experiment can be run. 

Note: It is important to note that if two G400 probes are connected to a system, both probes must be 
configured before an experiment can be run. If an attempt is made to start an experiment without 
first configuring both probes, the following error dialog is displayed.. 
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WHAT TO DO IF IC FBRM TELLS YOU IT CANNOT TELL THE PROBES APART 

In a G400 dual-probe configuration, if two new un-configured G400 probes are connected to the control 
computer and the FBRM server cannot uniquely identify the two attached G400 instruments, the following 
dialog box appears: 

 

The FBRM server labels the pairings as ‘ambiguous.’  

 

Follow these steps to resolve this issue:  
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1. Unplug one of the G400 USB cables from the PC and click the Scan button. The FBRM server will detect 
the instrument and after a few seconds display the following dialog box: 

 

2. Plug in the other G400 USB cable and click the Scan button. After a few seconds, the second G400 will 
be configured and the dialog box updated with information identifying the new probe. 

 

3. Click the Close button to initialize the probes. 

  

IC FBRM DOES NOT RECOGNIZE THE G400/G600/E25 PROBES 

If the G400/G600/E25 probes are not recognized in the Instrument Connections dialog, perform the 
following procedure to correct the problem. 

• Power down the PC or stop the FBRM Service (see Changing Time Zones and Regional Settings for 
information on stopping the FBRM server). 
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• Remove the power from the instrument. 

• Disconnect the USB cable between the instrument and the PC. 

• Start the PC or start the FBRM Service (see Changing Time Zones and Regional Settings for information 
on starting the FBRM server). 

• Start the iC FBRM software application. 

• Follow the procedure for. Connecting a ParticleTrack Probe with iC FBRM. 
For G400 dual-probe systems, follow the recommended procedure. If necessary, refer to What to Do If 
iC FBRM Tells You It Cannot Tell the Probes Apart. 

Managing Probes 

The Manage Probes dialog box stores the probe calibration parameters for your ParticleTrack probe. Editing 
probe calibration parameters should only be done by a METTLER TOLEDO representative.  

 

The Manage Probes button on the Instrument Connection page displays the Manage Probes dialog box.  
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The Manage Probes dialog box can also be accessed from the Tools menu. 

 

Select the probe tip to use for an experiment from the Configure Instrument wizard. 

 

 

WINDOW MENU 

    

The menu contains the following options. 

Show documents as 
windows 

Show documents as tabs  

• Clicking the ‘Show documents as windows’ option when tabs appear 
displays the files as separate windows.  

• Clicking the ‘Show documents as tabs’ option when windows appear 
changes the files to the default tabbed format.  

New Tab Groups 
Arranges the display as tabs—either horizontally or vertically. See Tab 
Groups allow you to view multiple documents at once. 

List of open files 
Lists all open files (tabs) with the file currently displayed identified by the 
check mark. Clicking on an open file tab displays that file.  
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HELP MENU 

 

The menu contains the following options. 

Help with iC Opens the iC online Help. 

Show Start Page Opens the Start Page or displays it if it is already open. 

Show Release Notes Displays a list of changes for the installed release of the software. 

Show Documentation 
Portfolio Opens the PDF Portfolio of user guides and publications for iC FBRM software. 

Check for Updates Connects to the MT website and checks for recent software updates. Note that an 
internet connection is necessary to use this option. 

Send iC FBRM Logs to 
Customer Care 

Opens a window where you select date parameters for the system utility that 
generates a zipped file that you can email to Customer Care for analysis. 

License Manager Opens License Manager to enable the user to review and enter licenses. 

About iC FBRM Displays software version and contact information along with technical and 
copyright/trademark details. 

The About iC FBRM Dialog 

The About iC FBRM dialog  box displays information detailing the software application version number and 
contains buttons to access various application/system tools. 
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Clicking the System Info button opens the Windows System Information dialog box that contains information 
about the Windows operating environment. 

 

Clicking the Components Info button opens the Component Versions dialog box with information detailing 
the version numbers of all iC FBRM software components. 
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The License Manager option provides the way to activate software and other licenses and apply activation 
codes. Refer to the iC FBRM Install Guide for Administrators in the Software Documentation Portfolio for 
complete instructions. The iC Licensing topic in this Help system provides an introduction. 

 

Check for Updates Menu Option 

The Check for Updates option on the Help menu opens the AutoChem Customer Community website where 
an automatic check occurs to determine if the system is running the latest version of the iC software. 

 

The user has the option to download and install the latest version from the website. 
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Working with the iC User Interface 

All iC data displays are interactive. For example, when a time point is selected in the Trend Viewer, the 
corresponding distribution and statistics are displayed in the Distribution Viewer and Statistics Viewer. The 
same interaction applies if the PVM Viewer, Surface Viewer, or Events Viewer are displayed. Refer to Linked 
Views for more information. 

IC USER INTERFACE INTRODUCTION 
The iC user interface combines power and simplicity to help you collect and analyze your data. Depending 
on the specific iC application, a variety of interactive viewers display in the iC Main Window or dashboard.  

 

The information below introduces the areas of the user interface. 

The Menu bar and Toolbar provide standard Windows menus for accessing program functions. The toolbar 
contains icons for common functions and is positioned next to the menu bar to display useful functions for 
the current display. The user interface also includes a Live Experiment Toolbar with icons for common 
functions. While the iC FBRM system records data, this toolbar also provides a button to pause recording of 
the active experiment. 

The Document area organizes multiple open documents (experiments, Result sets, Distribution libraries). By 
default, documents appear as tabbed windows, but you can choose to display them in separate windows. 
Tabbed documents can be grouped to allow side by side comparison. (Refer to the Window Menu).  

Interactive Viewers—The figure above features an Experiment display that consists of several interactive 
viewers. Three of the viewers (Trends, Distributions, and Statistics) are featured. In the example, the Statistics 
Viewer, Events Viewer, Surface Viewer, and PVM Viewer share the same tile. Selecting a tab displays the 
viewer in the tile. The PVM Viewer and the Surface Viewer must be enabled in system Tools > Preferences 
Dialog, to appear as tabs in the Statistics Viewer pane.)  
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The “active viewer” is highlighted (name changes to bold and title bar to white) to provide feedback on 
which data viewer will respond to keyboard commands. Refer to Experiment Display for details on all the 
viewers. 

• The Trends Viewer displays chord length statistical profiles over time. You can show or hide profiles from 
the Trend List. You can also manipulate the trend view (for example: zoom, change colors, show/hide 
legends, export data, and more) from the toolbar along the top edge of the Trends Viewer. 
Manipulation of trend profiles can also be performed by right-clicking the mouse to display context 
menus. One way to open a Details table on all trends is by double-clicking the lower left corner of the 
viewer. 

• The Distributions Viewer displays a graph that represents the chord length distributions at selected times 
during the experiment. The X-Axis shows the channel boundaries in microns. The Y-Axis shows either 
the number or percent of chord counts, depending on which is selected. One way to open a Details 
table on all distributions is by double-clicking the lower left corner of the viewer. 

• The Statistics panel contains up to four tabs, as follows. 

o The Statistics Viewer plots chosen statistics over time by collecting the time each measurement was 
taken and displaying the number of counts in each statistical category for that measurement.  

o The PVM Viewer displays images loaded from an iC PVM experiment or from a completed sequence 
file (*.seq). Both the Trends Viewer and Distributions Viewer can optionally link the trend crosshair 
to a PVM image for an associated point in time. This is supported after an experiment is complete.  

o If activated through Tools > Preferences, the Surface Viewer displays a 3D graph of the distribution. 
Surface Viewer is synchronized with the Distribution Viewer. 

o The Events Viewer displays system messages and user annotations. A Sample message is appended 
each time the system acquires a measurement. The system also reports Info, Warning and Error 
messages, when appropriate. The Annotation panel can be displayed to create or edit user 
annotations. When a sample is annotated, an option is offered to have a marker displayed on the 
Trends Viewer. 

The Toolbox provides access to a set of task panes that launch programs or manipulate the active document. 
For example, the Data Treatments task pane provides access to analysis functions such as channel grouping 
and averaging. The Toolbox can be popped open as needed or “pinned” to remain open and readily 
available. Refer to Using the Toolbox for details including the individual task panes. 

The Live Experiment Toolbar displays useful system information. The most recent system message displays on 
the left side. When an active experiment is in progress, experiment status indicators and controls are shown 
on the right side. A Status Bar on the bottom of the document area also shows system status messages. 

Refer to Working with the iC User Interface for details about toolbars, tabbed displays, and linked views.  
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MAIN TOOLBAR 

The main toolbar contains a series of buttons that function as shortcuts to commonly used menu options. 

 

Buttons are only activated when the button function is available. Unavailable buttons appear as “grayed-out.” 

Button Description 

 Opens the iC Help system. 

 Displays the Start Page. 

 New—Create a new experiment, Result Set, Distribution Library or a One-Click Experiment. 

 
Open—Opens an existing experiment, Result Set, or Distribution Library. 

 Import—Imports an external experiment or measurement file. 

 Save—Saves changes to the active document. 

 Save As—Saves changes to the active document with a new filename. 

 Save As Template—Saves the current experiment as a template. 

 Export—Exports the selected experiment data to a CSV file. 

 Create Microsoft Word Report 

 Create Read-Only Report—generates an XPS report for the currently active document. 

 Dockable Viewer—Enables repositioning viewers within the window. See Dockable Viewers. 

Layout Buttons—The following buttons are mutually exclusive with each other. Only one layout can be in 
effect at a time. 

 Tab View—displays the active documents as tabs.  

 Tiled View—displays the active document viewers in a four-quadrant arrangement. 

 Horizontal Layout—displays the active documents as horizontal panes.  

 Vertical Layout—displays the active documents as vertical panes.  

 
Standard View—Trends Viewer and Distributions Viewer on the left and Statistics Viewer tabbed with 
Events Viewer on the right 
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TABBED DISPLAYS 

iC software presents tabbed displays at multiple levels within the user interface to provide flexibility and a 
maximum amount of available screen space for each analysis window.  

Multiple documents can be opened at once and shown as tabs across the top of the document area. Within 
a document such as an experiment, multiple viewers can appear as tabs across the top of the document 
window. 

TABBED/TILED VIEWS ORGANIZE DATA WITHIN A DOCUMENT 

 The default view displays the Trends Viewer and the Distributions Viewer on the left side. The Statistics 
and Events Viewers appear on the right side as tabbed views within a third panel.  

 Alternately, the data displays can be organized as tabs with only one viewer occupying the document 
area at a time. When a document contains multiple tabbed controls, the tabs appear on the upper portion of 
the display window. 

 

In the example above, the experiment is viewed as tabbed which means the entire window appears as a 
single viewer. As a result, the data detail is easier to see. 

Note: PVM Viewer and Surface Viewer tabs only appear if activated through Tools > Preferences Dialog. 

TAB GROUPS ALLOW YOU TO VIEW MULTIPLE DOCUMENTS AT ONCE 

When multiple documents (for example: experiments, results sets, distribution libraries) are open, they 
display as tabs located at the top of the display window. Clicking a tab displays the document. The tabs are 
added in the order they are opened.  

 

To view two experiments at once, right click on a tab and select one of the tab group options from the 
context menu. 

 

In the figure below, the New Horizontal Tab Group option was selected on an experiment.  

Note: The screen is now divided into a lower tab group containing a single document and an upper tab 
group containing the remaining documents. 
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Once a new tab group has been created you can right-click on the tab again to rotate through the tab 
groupings by clicking the Move Next option. Once all tabs have been rotated, the window returns to its 
original configuration. 

 

The context menu also has several options for opening and closing document tabs. 

Close All—closes all open tabs except the Start Page. 

Close Other Tabs—closes all open tabs except the current tab and the Start Page. 

Close—closes the current tab. 

Open Document Folder—opens the folder (in a file browser) where the active document resides.  

Other display configurations are available on the Main Toolbar. 

LINKED VIEWS 

The four main data viewers in the document display link interactively. When you select a data element in one 
viewer, the corresponding data elements in the other viewers are also highlighted. 
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Synchronized Highlighting 

If you select a time point (record) from the Trends Viewer, the distribution becomes highlighted on all 
displays automatically.  

 

Any of the following actions coordinate the linked views to reflect your selection: 

• Click on an event in the Events Viewer. 

• Select a time point in the Trends Viewer. 

• Click on the measurement in the Distributions Viewer or the Details table. 

• Click on the selected measurement in the Events Viewer. 

• Click on a column and/or row in the Statistics Viewer. 

• Select an image in the PVM Viewer (if applicable). 

• Select a point on the Surface Viewer (if applicable). 

Below are some examples of how all four viewers update and highlight the chosen event: 

• Thickness of the selected measurement increases to enhance visualization. 

• Associated y-axis title changes color to match the selected measurement. 

• Time line in the Trend Viewer moves to show the point in time when the measurement was 
recorded. 
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• Event Viewer highlights the selected event. 

• Selected measurement is highlighted on the Statistics Viewer. 

• Corresponding PVM image is displayed (if loaded). 

Selected Distribution 

Select a distribution measurement using one of the following actions and observe how the linked views 
change to reflect your selection: 

• Click on an event in the Events Viewer. 

• Select a time point in the Trends Viewer. 

• Click on the measurement in the Distributions Viewer. 

• Click on the selected measurement in the Events Viewer or Distribution Details table. 

• Click on a column and/or row in the Statistics Viewer. 

• Select an image in the PVM Viewer (if applicable). 

 

All viewers respond with corresponding data by:  

• Highlighting the row in the Event Viewer. 

• Positioning the Trend Viewer time line to the measurement’s timestamp value. 

• Displaying the measurement in the Distributions Viewer with a widened plot line. 

• Adding the measurement to the Distributions Viewer’s Details Panel and highlighting it. 
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• PVM will display the corresponding image. 

• Highlighting the column in the Statistic Viewer. 

DOCKABLE VIEWERS 

The iC software allows the user to reposition the various viewers anywhere on the display window. 

Note:   The Allow dockable controls to be undocked option in Tools menu > Preferences must be checked for 
the docking button to appear. 

 Docking button—(Inactive) To reposition viewers, click the button on the toolbar. 

 Docking button—(Active) To exit the docking feature, click the button again to return to inactive.  

The following example illustrates how to reposition the PVM at the bottom of the Events Viewer: 

1. In the main toolbar, click the docking button to activate the docking feature. 

2. Click-and-drag the title bar or tab of the PVM Viewer (shown floating in example below) to the desired 
location. 

 

Docking guides appear to help you relocate the window to the top, 
bottom, left, or right. 

3. Release the mouse button to drop the viewer in the new location. 
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  In addition to being docked, viewers can remain floating. 

 

To undock a viewer, click the Docking button again. In the example, the PVM Viewer will return to its original 
docking position. 

To return the window to one of the standard layouts, click one of the layout buttons on the toolbar. 

 

PINNING 

All trends and measurements in iC viewers can be pinned. When pinned, a measurement appears in the 
graph and in the corresponding Details table. Pinning is similar to the show/hide concept but pinning is 
application wide (one pin applies to all linked views). Show/hide is local to each individual viewer (or tile).  

 

 
Pin/Unpin—Button on the Trends Viewer and Distribution Viewer toolbars 

The following rules apply to pinning: 

• Pin/Unpin is enabled/available whenever there is a selected measurement.  

• With a selected measurement, the Pin button provides visual indication of whether the selected 
measurement is pinned or not (+ and – symbol and color on the Pin/Unpin button).  

• If unpinned, the selected distribution/sample is gray in the Distributions Viewer. It will change if another 
distribution/sample is selected.  

• Pinning from the Trends Viewer or Distributions Viewer assigns a color to the selected 
distribution/sample and keeps it in the Measurement/Distributions Viewer even when another 
distribution/sample is selected.  
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• Unpinning removes the permanent status of the selected sample and de-allocates its color, but the 
distribution is still selected and displayed in gray to reflect its temporary status. It will disappear entirely 
when another distribution/sample is selected.  

• If a distribution is identified as a Reference Distribution, the Remove Distribution option from the right-
click (context) menu deletes the Reference Distribution from the viewer. 

SHOW/HIDE 

The Details tables for the Trends Viewer and Distributions Viewer provide show/hide capabilities. 

• Show displays the measurement distribution in the Distributions Viewer.  

• Show displays the trend in the Trends Viewer.  

• In the Distributions Viewer, if the user clicks the check box to show an unpinned, selected measurement, 
the selected measurement becomes pinned. 

• Hide removes the measurement distribution from the Distributions Viewer and globally deselects the 
measurement (this will also cause the time bar in the Trends Viewer to disappear).  

• Whether or not a selected, unpinned measurement is initially checked is a user preference (default value 
is pinned. Refer to Preferences Dialog).  
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Using the Start Page 

The iC FBRM Start Page is the launching point for acquiring or analyzing data. Start Page buttons lead to 
wizards that guide you through such functions as starting an experiment. Recent experiments appear along 
the bottom of the page. The Start Page also contains Reminders, More Information links to video demos, 
and user assistance, plus Contact links. 

 

The Start Page offers the following command buttons: 

Button Function 

New Experiment 
See Working with Experiments 

Open Experiment 

New Result Set 
See Working with Result Sets  

Open Result Set 

New Library 
See Working with Distribution Libraries 

Open Library 

Run AutoStats See AutoStats 

Configure Instrument See Configuring the Instrument  

Display Settings See Viewing Display Settings 

Send System Logs See The Customer Care Log File Utility 

Note:  If your instrument is due for Preventive Maintenance service, a prompt appears under Reminders. 
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Viewing Display Settings 

As a convenience, the Display Settings button on the Start Page opens the Microsoft® Windows®, Display 
Properties window to enable adjustments to the display setting for optimal viewing of the iC application. The 
display settings windows differ depending on the operating system. Examples below are from Windows 7. 

The following two display settings are important for optimal viewing of iC FBRM software: 

• Graphics Requirement 

Computer should meet minimum requirements for graphics, as stated in the installation guide: SXGA 
1280 x 1024 with 3D hardware acceleration. 

If you launch iC FBRM on a PC with lower settings, a Suboptimal Display Settings prompt describes the 
optimal settings and provides a link to the Control Panel Display-Screen Resolution dialog box. If 
available, select the recommended resolution. (The example below exceeds the minimum Resolution.) 

 

• Set Font Size—Details 

1. Select Make text and other items larger or smaller to open the Control Panel Display settings 
page. (Alternatively, type 'font' in the Start menu search box to access this dialog box.) 

2. Select 'Smaller – 100%' if it is not already selected (this change may require you to log out and log 
back in). 
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The Customer Care Log File Utility 

The Customer Care Log File Utility creates a compressed (ZIP) folder of all system log files. These log files are 
used by Mettler Toledo Customer Care as an aid in diagnosing problems with the iC software. 

 
It is advisable to create a log file folder and include it with any problem 
reports. To create a log file, click Send System Logs on the Start Page. 

 

Select the date period in which you encountered the issue and click on the Create Zip File button. A log 
folder is created on the Desktop and a completion message appears. 

 

The log folder is saved to the Desktop or the location specified in the Zip File Name field. The filename for 
the folder is ICFBRM Traces.Zip. 

 

The hyperlink on the Start Page can be used to email the report to METTLER TOLEDO Customer Care. 
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Calibration Validation Procedures 

The Start Page includes a reminder to check instrument calibration regularly, and the Start Experiment 
Wizard includes a Calibration timer that communicates when an instrument calibration validation is due.  

System Calibration and Calibration Validation procedures are included in your Hardware Documentation 
Portfolio. Locate and/or print the ‘Calibration Validation’ and ‘System Calibration’ procedures for use with iC 
FBRM.  

You may wish to save these procedures to your desktop or other local directory for future reference. 

Hardware Documentation Portfolios are provided on a separate CD/DVD-ROM along with your initial 
instrument shipment. The latest Hardware Documentation Portfolio documents are also available for 
download from the AutoChem Customer Community Site. 

https://community.autochem.mt.com/index.php?q=welcome
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Working with Experiments 

Create experiments by one of the following methods: 

Click the New Experiment button on the Start Page. 

 

or 

Select the New > Experiment option in the File menu. 

 

ONE-CLICK EXPERIMENTS 

By default, experiments creation is through a New Experiment wizard. However, experiment creation can 
directly bypass the schedule and cleaning stages. A One-Click experiment will use the first available probe 
and will be named as ‘Experiment [Probe name] [mm-dd-yyyy hh-ss]’. One-click experiments apply the 
following settings from the previous experiment to new experiment: 

- Experiment path 

- List of statistics 

- Experiment phases 

- Data averaging (with either moving or exponential window size) 

- Channel grouping (with resolution, spacing, and range) 

If the previous experiment was based on a template, the one-click experiment will use the settings from the 
template plus any modifications made in the previous experiment. 

Start a One-click experiment by any of the following settings or procedures: 

• If the Always Bypass the New Experiment Wizard option in the system Preferences Dialog is checked, all 
experiments will bypass the schedule and cleaning phases.  

• Start a One-Click experiment from the toolbar button or menu, as follows: 

New toolbar button 
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 File > New menu 

 

• Holding down the Control key while clicking the New Experiment button on the Start Page is another 
method of starting a One-Click experiment. 

OPENING AN EXISTING EXPERIMENT 

To open an existing experiment, select Open > Experiment from the File menu. 

 

Alternately, click the Open Experiment button on the Start Page and choose an 
experiment from the Windows Explorer. Notice that the most recent 
experiments appear along the bottom of the Start Page.  

The experiment opens in the Experiment Display. Changes can be made to experiment (trends, annotations, 
data treatments, statistical definitions, etc.) and the experiment can then be saved as another experiment file 
using the Save As ... option in the File menu. 

Version 4.0 of the iC FBRM software saved an experiment as the raw distributions and the experiment 
separated into two separate files. Starting with version 4.1 of the iC FBRM software, the system saves the raw 
distributions and the experiment data into one file. Version 4.3 of the software will open a version 4.0 
experiment normally. When the 4.0 experiment is saved however, the system saves the file in the 4.3 format. 
This file cannot be re-opened by the older iC FBRM software. 

The user is advised to always perform a Save As and give the file with a new name whenever a 4.0 
experiment is opened in 4.3. Once a 4.0 experiment file is over-written in 4.3 format, it cannot be opened by 
a 4.0 version of the iC FBRM software. 

MULTIPLE EXPERIMENTS 

Where two ParticleTrack G400s are connected, an experiment for each G400 (ProbeA and ProbeB) can be 
run simultaneously. Each experiment runs in a separate tab and contains its own Live Experiment Toolbar. 
Experiments start in the normal manner. The New Experiment wizard displays the available probes for the 
experiment.  
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If more than one G400 is available for the experiment, the Probe drop-down list displays the next available 
G400 probe. If only one G400 is available for the experiment (that is, the other G400 is in use) the drop-down 
list does not appear. 

Select the serial number that identifies the probe tip being used on the G400 from the drop-down list.  

If experiments are running for all of the probes and you attempt to start a new experiment, a warning 
message appears. 

 

In this case, you must wait until an experiment is complete, free up a probe, or abort a running experiment. 

TEMPLATES 

An experiment can be saved as a template for reuse in subsequent experiments. You can select a template to 
use as a “method” for a new experiment. A template is actually an existing saved experiment or experiment 
saved specifically as template file. The template automatically includes all hardware settings (scan speed, 
Chord Selection Models, serial I/O configuration) and software settings (measurement interval, experiment 
schedule phases, statistics definitions, references, Y-Axis settings, and display settings from a completed 
experiment.  
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Saving an Experiment as a Template 

The user can save a completed experiment as a template file. The template does not include any acquired 
measurement samples but includes all experiment settings/conditions. When saved as a template, an 
experiment name includes a ‘Template’ suffix to the filename:  (Experiment ProbeA 06-20-2015 09-33 – 
Template.icFbrm).  

Experiments saved as templates are significantly smaller than the original experiment since all data, 
messages, and so on, are deleted. 

To save the current experiment as a template, select Save As Template from the File menu. 

 

Alternately, you can click the  icon on the main toolbar to save the currently selected experiment as a 
template. 
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Start Experiment Wizard 

When you click New Experiment from the Start Page (or select New > Experiment from the File menu or 
Toolbar), a wizard-guided series of pages appears. Follow the wizard to complete all requirements to create 
a new experiment. If you have the iC Data Center™ server set up, the New Experiment page is different. 
Follow the instructions under Start Experiment Wizard (iC DC). 

Use the first Start Experiment wizard page (Experiment Name) to define the name and location of the 
experiment document file. The wizard automatically assigns a name and folder location for the experiment. 
The location defaults to the most recently used folder. System-assigned names are as follows: 

• For single probe systems—Instrument type, text string “Experiment,” followed by date and time.  
• For multi-probe systems—Probe name, text string “Experiment,” followed by date and time.  

The page also displays the current instrument configuration and includes a Configure Instrument button. If 
instrument configuration tasks are required, the system will display a message.  

In most cases, you simply click Next to use the default settings and go to the next wizard page. For more 
about naming options and all the fields on the Experiment Name page, see Creating the Experiment for 
details about the Experiment Name Page. 

 

The iC FBRM software does not allow you to click the Next button from the first wizard page until instrument 
configuration is complete. The software verifies the proper probe configuration and displays the following 
error message if configuration is required: 
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In addition, the Configuration required prompt on the bottom of the wizard page displays as True (in red).  

Note: If the Calibration Validation is due (see Calibration Validation Timer), a red message informs you. 

 

A Note about Dual-Probe Configurations 

It is important to note that if two G400 probes are connected to an iC FBRM computer, both probes must be 
configured before an experiment can be run. If an attempt is made to start an experiment without first 
configuring both probes, the following error message appears: 
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CREATING THE EXPERIMENT 

The steps below go through each section of the Experiment Name page for your reference. 

 

1. Most new experiments start as a new file. However, you have the option to append a new experiment to 
an existing file if necessary (see Append to Existing Experiment).  

Experiment File—Name: You can configure an experiment name based on the recent experiment name, 
or use name format ‘tokens.’ The most recently used name appears by default. When basing a new 
experiment on a previous one, you must modify the name to make it unique.  

A drop-down list shows token name options. System-defined names are editable. 

 

• $(Date)—the current date 
• $(Time)—the current time 
• $(Instrument)—the instrument type by brand name 
• $(Probe Name)—the probe type (usually A or B), available for multi-probe instruments only 
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After you define one or more experiment name formats,  

Experiment File—Folder:  The default location for storing iC documents comes from the most recently 
used location. You can browse to a different folder location. 

Note: It is recommended that experiments be saved to drives local to the PC running iC FBRM. You 
can move the experiment to a different drive after the experiment completes. If the experiment 
is being saved to a remote disk drive, a network interruption may cause an irrecoverable failure 
and the experiment will have to be re-run. 

2. Experiment File—Template: To start the experiment based on an experiment template, browse to the 
location of the template file (see Templates). 

Instrument Information 

If instrument configuration is complete, this bottom section of the Experiment Name page is for information 
only. If the system indicates that configuration is required or if you want to change your instrument settings 
before recording an experiment, click Configure Instrument from this window. (See Configuring the 
Instrument.)  

APPEND TO EXISTING EXPERIMENT 

The New Experiment wizard provides the option of creating a new file for an experiment or appending the 
new experiment to an existing one. To append the new experiment to an existing one use the buttons at the 
top of the New Experiment. When you select ‘Append to existing file,’ the Experiment File section of the 
Experiment Name page changes as shown below. Click the ‘browse’ icon to select the existing file.  
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CREATING THE EXPERIMENT SCHEDULE 

Use the next page of the wizard to create the experiment schedule and to partition the experiment in 
multiple phases. Each phase can be defined with specific duration and measurement interval. The phases 
execute in sequence. 

 

The default duration for an experiment is 1 day.  

If the experiment is very large, a warning appears at the bottom of the page.  

 

Consider reducing the number of samples to conserve disk space. 

If the schedule exceeds the maximum, the following message appears: 

 

If you click Next to go to the next Start Experiment Wizard page, the following message appears: 
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Click the Next button and iC FBRM checks for available disk on the drive designated to store the experiment. 
If there is not enough disk space available, an error appears. 

 

To proceed with the experiment, either free up adequate disk space or select another location for the 
experiment. Use the Back button to return to the first page of the wizard and select another drive location. 

Adding/Removing Phases in The Experiment Schedule 

 

Click the Add Phase button to add a phase to the experiment. A new row appears in the 
Phases list. Edit the Duration and Measurement Interval fields as desired. The system 
automatically calculates the number of samples.  

 
When multiple phases have been defined:  To delete a phase from the schedule, select it 
and click Remove Phase.  

The Duration and Measurement Interval fields have a drop-down list for selecting the time values.  

 

Alternatively, enter a number into the fields followed by “h” for hours, “m” for minutes or “s” for seconds. 

 

When the cursor leaves the field, the entered time converts to the current time format. 

 

Warning: Experiments with total samples greater that 10,000 will take up approximately 120 MB of disk 
space and will be very difficult to analyze. If the number of samples exceeds 20,000, a warning 
message is displayed that prompts the user to reduce the number of samples.  
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CLEANING THE PROBE 

The final page of the wizard checks the cleanliness of the probe. The colored bar indicates if the probe is 
clean (green) or dirty (red). The total number of counts should be less than 300—in the green region—when 
the probe is immersed in clean deionized water or pure solvent. If the counts are too high—in the red 
region—clean the probe using deionized water or pure solvent and a paper tissue. 

Clean the probe from the previous experiment using the most appropriate solvent(s) to dissolve the particles. 
A final cleaning with distilled water is recommended. Paper makes an ideal cleaning tool. Note:  Many cotton 
swabs have lubricants and are not a good choice for a cleaning tool! 

Watch the video tutorial on cleaning the probe window from the iC FBRM Start Page. 

 

Click Finish to close the wizard and proceed to Starting the Experiment.  
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Configuring the Instrument 

To access Instrument Configuration, click the Instrument Configuration button on the Start Page or from the 
Start Experiment wizard. The first page of the Configure Instrument wizard displays general information 
about the instrument. In most cases, you can simply click Next to move to the next wizard page after 
reviewing information. If you navigate to this page as part of starting an experiment, one or more 
configuration or calibration validation settings may be required. 

 

The Instrument Connection page varies slightly based on instrument type. 

For multi-probe G400 configurations, the Probe selection list appears. If the currently selected probe is being 
used for an experiment, a warning message prompts you to select a different probe. Configuration will not 
continue until you select an available probe.  Note that each probe must be configured individually. 

 

After editing/verifying the settings, click the Next button to advance to the next page of the wizard. 
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CALIBRATION VALIDATION TIMER 

The first page of the Configuring the Instrument wizard also includes a calibration validation timer that 
displays the date of the last calibration validation and due date for the next calibration validation. After 
performing a new calibration validation, click Reset Calibration Validation Date to reset the due date. 

Note: For information about Calibration Validation Procedures, refer the procedures in the hardware 
documentation portfolio.  

SCAN SPEED PAGE 

The next page of the wizard is used to select the scan speed of the instrument.  

 

After verifying or editing the setting, click Next button to advance to the next page of the wizard.  

Note: E25 and G400 probes have a 2 m/s scan speed. The default scan speed for the G600 is 2 m/s 
with an optional scan speed of 4 m/s available. 
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SELECT CHORD SELECTION MODEL PAGE 

The next page of the wizard enables the user to select the appropriate Chord Selection Model (CSM) that will 
be used to convert the raw signal collected by the probe into chord length data. Available Chord Selection 
Models depend on the instrument type and the purchased license options. Refer to Chord Selection Models 
for additional information. 

Up to two Chord Selection Models can be specified per probe. Use the check boxes in the wizard window to 
specify whether to save one or both Chord Selection Model conversions for each measurement. Use the 
buttons in the ‘Default distribution to display’ column to specify which Chord Selection Model displays by 
default in the experiment. During a live experiment, if two CSMs have been saved, you have the option to 
display distributions from both CSMs as described later in this section and also under Multiple Chord 
Selection Models. 

Note: If new Select Chord Selection Models are installed, you must restart the FBRM server to display the 
latest CSMs. 

 

After editing or verifying the settings, click Finish to close the Configure Instrument wizard.  

• If the wizard was initiated from the Start Page, the Start Page appears.  

• If the wizard was started from within the Start Experiment wizard, continue with the experiment 
definition and go to the Live Experiment in paused mode.  

When an experiment starts, the distribution measurements save to the Events Viewer along with the Chord 
Selection Model version number used to calculate the measurement.  
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A drop-down list on the Data Treatments task pane enables selection of which Chord Selection Model to use 
for the distributions display in the experiment.  The user can switch between the displayed Chord Selection 
Models at any time; this does not affect the saved data. The system recalculates the trends and statistics and 
displays the resulting data. Notice that you can also display two distributions by marking the ‘Also show’ 
check box (see Multiple Chord Selection Models). 

 

Note: If you start a new experiment based on a template experiment, the Start Experiment wizard 
compares the Chord Selection Model option in the template with the Chord Selection Model option 
of the currently selected instrument and reports any discrepancies.  
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Starting the Experiment 

After all the preparation steps for the experiment are complete, the Live Experiment Toolbar appears.  

 

The toolbar contains a calendar button that enables addition or removal of phases during a 
running experiment, or editing of existing phases.  

When the experiment window appears, it is automatically in a paused state. The experiment tab is color 
coded (yellow) to match the Live Experiment Toolbar.  

 

The experiment collects data while in the paused mode. When you click the Run button to start the 
experiment, a message appears that prompts for a decision to save or discard the data collected while in the 
paused state. 

 

Click one of the buttons to start the experiment and save the data. 
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If the Remove Relative Time Gaps when Samples Discarded After Pause option is selected in the system 
Preferences Dialog, when you resume a paused experiment and select Discard the measurements during the 
pause period, the measurements are discarded and the time gap is eliminated for the Relative Time x-axis 
mode (The x-axis has a choice of modes—Sample Number, Absolute Time, or Relative Time. Refer to 
Changing the X Axis).  

• The first sample after the Resume is appended after the last sample prior to the pause period.  

• The eliminated time gap is not visible in the Sample Number mode either, but it is visible in the 
Absolute Time mode.  

• A system annotation is added to the Events Viewer log to record the time the experiment resumed and 
an audit entry is added to record how many (if any) samples are discarded, whether or not the 
preference to eliminate the time gap is in effect. 

The experiment starts and data collection begins and is saved. Upon the start of data collection, the Live 
Experiment Toolbar and the experiment tab turn green. 
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A running experiment can be paused by clicking the Pause button in the Live Experiment Toolbar. When in 
pause mode, the toolbar and all data collected during while paused appear with a yellow background.  

 

If the Stop button is clicked the following confirmation prompt appears:  

 

When the decision to stop an experiment is made or after the experiment schedule ends, the experiment is 
considered complete. When the experiment is complete, the Live Experiment toolbar changes to blue and 
displays a summary. 

 

Click the OK button to close the completed experiment.  
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The Live Experiment Toolbar 

The Live Experiment Toolbar displays in color to indicate experiment status. 

 

The toolbar initially appears in yellow indicating a paused experiment. When the Run button is clicked, the 
experiment starts and the toolbar changes to green. 

 

After the experiment completes, the toolbar color changes to blue with a summary of samples taken. If any 
error or warning messages occurred, the toolbar reports the number. 

 

This toolbar also includes the following experiment control tools: 

   
(Run) 

Use the Run and Pause buttons to control the execution of the experiment. 
The buttons toggle depending on the current run state of the experiment. 

 
(Pause) 

   
(Stop) Permanently stops the experiment. 

 
Click Clean Window to initiate a manual window cleaning operation during 
an experiment. See the Clean Window Dialog. 

Elapsed Time Total time of the experiment from when it was first started. 

Time Remaining: Calculated time remaining until the completion of the experiment. 

Next Measurement: Time remaining until the next measurement scan. 

Current Interval: Enables changing the scan interval during the experiment. 

 

Use the calendar button to add, remove, or edit phase(s) of a live 
experiment. Access this button at any time during a live experiment (run 
mode or pause mode). Refer to The Experiment Schedule for instructions 
on editing the schedule during a live experiment. 

 

Insert an Annotation about the experiment. The annotation receives a 
timestamp equal to the time indicated by the orange time line. By default 
the time line is positioned at the current time. 

 
By default the Distributions Viewer always shows the current or latest 
acquired distribution, along with any pinned distributions. 

 
Mark the check box to open an additional display tab that shows the 
statistical values in a large, matrix format. Refer to Large Values Viewer. 

If an error or warning occurs, a red or yellow icon appears on the left side of the toolbar.  
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CLEAN WINDOW DIALOG 

Note:  A Window Cleanliness Warning (Fouling Index High) appears when the percentage of stuck particles 
exceeds a factory set limit. 

Use the Clean Window dialog to manually initiate a cleaning operation during a live experiment.  

 
Clicking the Clean Window button on the Live Experiment Toolbar displays an 
informational prompt that describes how the action will affect the experiment. 

 

If you proceed with the Clean Window function, the following actions will occur: 

• Experiment will be paused during the cleaning process. 

• Stuck particle detection will be temporarily disabled.  

• Collection interval will be set to two seconds during the clean operation. The interval will return to 
its previous setting after the cleaning process is complete. 

1. Click Yes to proceed with the clean operation. 
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2. The total number of counts should be less than 300—in the green region—when the probe is immersed 
in clean deionized water or pure solvent. If the counts are too high—in the red region—clean the probe 
using deionized water or pure solvent and a paper tissue. 

3. Click the Close button to complete the clean operation and restart the experiment. 

THE EXPERIMENT SCHEDULE 

The Edit Schedule window enables addition or removal of phases during a “LIVE” running experiment, or 
editing of existing phases. 

 
To edit the schedule, click the calendar button on the Live Experiment Toolbar. The Edit Schedule 
window appears. 

 

Functionality of the window is identical to the Experiment Schedule discussed in Adding/Removing Phases in 
The Experiment Schedule. 

Unlike the experiment schedule during experiment setup, the Edit Schedule dialog box includes the current 
and remaining time in the live experiment. 

LARGE VALUES VIEWER 
 

 

The Large Values option displays the current values of the statistics in an enlarged 
table format. The display is available during live experiments and opens by clicking 
the check box in the Live Experiment toolbar. Statistical values update as 
measurements are taken. 
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By default the values for all defined statistics appear.  

Note: The Chord Selection Model used to calculate the statistic appears in parentheses after the statistic. 

To customize the display, right-click in inside it and choose from the following options: 

 

The following options are available: 

Hide . . . Hides the currently selected statistic. 

Show all values Displays all defined statistics. 

Select values Opens a Select Values dialog box that enables you to select which statistics display. 

Select Values Dialog 

Use the Select Values window to choose which statistics appear on the Large Values display. The window 
lists all defined statistics. Check the statistics to be displayed. 
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Experiment Display 

The experiment display is the primary tool for viewing experiment data. When an experiment is running or 
when it is open for review, the document area of the iC FBRM user interface displays experiment data in 
several viewers. 

• Trends Viewer 

• Distributions Viewer 

• Statistics Viewer 

• Events Viewer 

• PVM Viewer (optional and accessible during a live experiment when iC PVM is running on the same 
control computer) 

• Surface Viewer (optional) 

These viewers interact with each other to facilitate data interpretation and analysis. The viewers can also 
appear in a tiled configuration or singly as tabbed views. Notice the panel to the right in the example below 
includes the Statistics Viewer, PVM Viewer, Surface Viewer, and Events Viewer tabs with the Statistics Viewer 
selected.  
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Trend Viewer 

Trend profiles of several selected chord lengths statistical components for the experiment generate in real 
time and display in the Trends Viewer. User-defined trends also display in the viewer. 

This enables you to compare the behavior of particles of different size classes over time (for example: growth, 
breakage, agglomeration, fines generation). The display rescales automatically with the addition of different 
trend profiles. This enables you to track real-time changes in the observed process. 

When you select a trend, the Y axis label for that trend moves to the right-most position on the graph.  

 
You can move the selected trend time point one step to the left or right using the Events Viewer by: 
(1) showing all unpinned sample messages (horizontal pin) and (2) selecting one sample, then (3) 
moving the curser up and down.  

• Use the Right and Left arrow keys to step through the X axis one point at a time.  

• Use the Up and Down arrow keys step through the Y axis. 

• You have the option to send selected trends to a ‘Result Set’ library (see Working with Result Sets). 
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Note: By default, the Trend Viewer chart displays a maximum of 20,000 data points for all trends. When 
the number of data points being trended exceeds this amount, trended values are subsampled. 
When subsampling occurs, a message appears at the bottom of the trend chart. 

 

The message provides the ratio of subsampling that is being performed. If it becomes necessary to view the 
full 100 percent of data, the user has the option of reducing the number of trends being displayed to bring 
the maximum number of data points below 20,000. The number of data points is calculated by multiplying 
the number of trends being displayed by the total number of samples acquired. The number of samples 
acquired is displayed in Document Information task pane. 

 

It is important to note that subsampling only effects the data being displayed in the trend viewer, all data for 
every interval is always collected and stored.  
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THE TREND CONTEXT MENUS 

The Trends Viewer incorporates several right-click or context menus that contain tools for customizing the 
displayed data. Menu options appear when the user right-clicks on the data area of the display. 

 

Main Trends Viewer Context Menu 

Right-click in the Trends Viewer to display the following options: 

Show Toolbar Displays the toolbar at the top of the display. 

 
The toolbar contains the following tools:     

 
 Prints the display. 

  Copies the display to the clipboard. 

  Zooms the display. See Trend Profiles Zoom Operation. 

 
 

This button is only visible when the Zoom function is enabled. The button 
resets the zoom to the original scale. 
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  Rescales only the X-axis on zoom. 

 
 

Auto scales the Y-axis to 0-100% for all but the selected trend to enable 
comparisons. Refer to Trend Autoscale Operation. 

 
 Displays the Legend to the right of the graph 

 
 Displays the Details table below the graph. 

 
 

 

Pins the trends selected in the Trends Viewer to the Distributions Viewer. 
Clicking the button when Distributions Viewer is already pinned unpins 
those distributions. This tool can be used to add distributions from the 
Events Viewer to the distributions list. 

 
 Adds a Reference Trend to the graph. Clicking the button opens the Add 

Trends window where you can select or import trends. 

  Adds annotation at the specific active point in the trend. 

 
 Displays user-generated annotation markers on the graph. 

 
 

Shows system generated annotation markers on the graph. 

  Displays all pinned sample markers. 

Show Legend  Displays a legend that lists each trend by name with the CSM in parentheses. 

 
The Legend also offers a context menu that enables you to perform some of the 
functions discussed in this section. To access the menu, right-click on the legend. 

 

Show Details Displays information about the trends and allows access to hide and show options. 

Copy to Clipboard Copies the display to the clipboard. The display can be copied as a bitmap, Windows 
metafile or as text-only. 

 

Paste from 
Clipboard 

Pastes the contents of the clipboard into the trend graph. 

Print Opens the Print dialog to print the display. 
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Send Sends (exports) the trends to a Result Set. If there are any existing Result Sets currently 
open, a list appears so you can select the destination Result Set. There is also an option 
to create a new result set. See Sending Trends to a Result Set. 

 

High Contrast Displays the graph with a black background. 

Zoom Zooms the display. Refer to Trend Profiles Zoom Operation. 

Reset Zoom Resets the zoom to its original scale. 

Rescale on Zoom Rescales only the X-axis on zoom. 

Auto-scale Automatically scales the Y axis. Refer to Trend Autoscale Operation. 

Line Thickness Selects the line thickness for the plots. 

X Axis Format  Allows the user to change the format of the X axis as follows: 

• Record or Sample Number 

• Actual time of the measurement 

• Relative time (elapsed time during the experiment)  

See Changing the X Axis. 

Add Trends Allows the user to add trends from open Experiments and Result Sets. 

Show User 
Annotation 
Markers 

Displays user-generated annotations on the graph. 

Show System 
Annotation 
Markers 

Displays system generated annotations on the graph. 

Show Pinned 
Sample Markers Displays all pinned sample markers. 

Add Annotation Adds a new annotation to the event log. 

Hide All User 
Annotation Texts Hides the text on user annotations. The marker is still displayed. 

Show All User 
Annotation Texts 

Displays the text in user annotations next to the marker. The text can be moved by 
dragging it to a new location. 

Trend Line Context Menu 

Use the mouse to right-click on a line in the trend graph and display another context menu. 
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The context (right-mouse click) menu contains the following items. 

Hide . . . Hides the selected trend. 

Change Color Opens a color browser to change the color of the trend line. 

Change Y Axis Opens a window so you can select one of the defined Y axes or name a new one. 

 

Copy to Clipboard Copies the trend data to the clipboard as tab-delimited text. 

Add Annotation Adds an annotation to the to the trend point.  

Y-Axis Area Context Menu 

Use the mouse to right-click in the Y-axis area of the graph to see a third context menu. 

 

Edit Axis Settings Changes the range and name of the Y axis. When AutoScale is not in 
effect, multiple Y-axes can be defined. See Changing the Y Axis. 

X Axis Format  Changes the units of the X axis as follows: 

• Record or Sample Number 

• Actual time of the measurement 

• Relative time (elapsed time during the experiment) 

See Changing the X Axis. 

Add Trends Enables addition of trends from open Experiments and Result Sets. 

Show User Annotation Markers Displays a visual marker on graph for user-generated annotations. 

Show System Annotation Markers Displays system generated annotations on the graph. 

Show Pinned Sample Markers Displays all pinned sample markers. 

Add User Annotation Add an annotation to the trend point. 

Hide All User Annotation Texts Hides all user annotation texts on the graph. 

Show All User Annotation Texts Shows all user annotation texts. 
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THE TREND DETAILS PANEL 

The Details table offers a list of current trends along with the value and source.  To display the Trend Details: 

• Click the Details button   in the toolbar of the Trends Viewer, or  
• Placing the cursor anywhere on the Trends Viewer plot area and double-clicking on it, or  
• Double-click in the lower left corner of the viewer, or 
• Right-click on the trend graph and select the Show Details option.  

 

Checking the Visible check box displays the corresponding component as shown in the display below. 

 

The Trend Details table enables you to customize the trends in the viewer.  

The View section to the left of the details table determines which trends appear on the graph. The All button 
displays all the trends in the trend list. When the All button is selected, use the Visible check boxes to select 
which trends display. The Hide All button hides all visible data in the graph. The Visible check boxes must be 
rechecked to view the trend again. 

Right-clicking on the Y Axis of a trend enables you to change it. Axis selection is from a drop-down list of 
available axes. 

 

Up to four Y axes can be defined. When you select a trend, its Y-axis legend moves to the right-most 
position on the graph. 
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CHANGING THE Y AXIS 

Note:  The option to change the Y Axis does not appear on the context menu if AutoScale is in effect. 

When AutoScale is not in effect, you can change the Y-axis to display different measurement units and scale 
through a context menu. To access the menu, right-click in the Y axis area of the Trends Viewer and select 
Edit Axis Settings. 

 

The Axis Settings window opens. 

 

Enter a caption to label the axis and/or customization of the min/max limits of the scale. 

CHANGING THE X AXIS 

The X-axis displays the trends by one of the following units: 

• Record or Sample Number 

• Actual time of the measurement 

• Relative time (elapsed time during the experiment) 

To change the X-axis, use a context menu. 
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ADDING A REFERENCE TREND 

Reference trends from an iC FBRM experiment, another iC application or iControl can be added to a trend. 
Refer to Sharing Trend Data with Other iC/iControl Applications for guidelines pertaining to interactions with 
iControl and other iC applications. 

When adding a reference trend from a different experiment, the experiment containing the trend to be used 
as a reference must be opened first. Then, use The Trend Context Menus to add the reference trend to the 
current experiment. 

 

Click the Add Trends option to open the following dialog box: 
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The dialog box contains a list of all active trends in all opened and live experiments. You select which trends 
to use as a reference and click the OK button to insert the reference trends. 

You can also drag-and-drop reference trends from another opened Experiment or opened Result Set to the 
current trend display.  

To add a reference trend using the drag-and-drop method: 

 
1. On a Trend display or Result Set, click on trend to be included in current Trend display. The 

cursor changes to the symbol shown if the plot was correctly selected.  

 
2. Drag the cursor to the tab of the destination Trend Display.  

 

Note: On experiments containing a large number of trends, it is easier to drag the trend from the trend 
name in the legend. 

 
3. When the cursor hovers on the destination tab, focus shifts to the tab and the destination 

Trend Display appears. 

 
4. Drag the cursor down to the graph area. 

 
5. The cursor changes to a shortcut icon, 

 
6. Release the mouse button. The dragged trend is copied to the destination Trend Display. 
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Reference Trends display on the graph with a dotted line. 

 

IMPORTING AN EXTERNAL TREND INTO THE TREND VIEWER 

Data from MS Excel or other spreadsheet program can be pasted into iC FBRM as a plot. The desired data is 
first selected in the spreadsheet and copied to the clipboard.  

Note: Date/Time is always in the first column. The date/time cells must contain the date and time in the 
format corresponding to the International settings of the computer running the iC application. 

In Microsoft® Excel®, select all the time cells and go to Format/Cells and select Number: in the list.  

Select Custom and format the cells as shown. 

 

If the data does not already have a Time column, one can be generated as follows:  

1. Modify the start time of the experiment with the appropriate date. 

2. Then, modify the subsequent cells by adding the time interval. You can do this by using the Time 
function in Excel. For example if your experiment intervals are five seconds, then your formula would 
look something like this: 

=B4+TIME(0,0,5) 

If you had multiple stages with different time intervals, be careful when modifying your time cells. 
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Pasting the newly formatted data enables you to correctly overlay your FBRM data and your imported data 
in the iC FBRM software (Changing the configuration of the X axis should not be an issue).  

 

In the Trend Viewer, select the Paste from Clipboard option from the right-click menu. 

 

The data from the clipboard pastes into the trend graph as a new trend. You can then modify the y axis of 
the newly imported set of data to show a correct label. To rename the axis, right-click on the set of data just 
imported and selects the Change Y Axis option. You can then enter an appropriate name for the Y axis.  
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Here are some general hints for pasting data from the clipboard into the iC application. 

1. What you see in Excel is exactly how it is formatted on the clipboard, and is how FBRM will see the data.  

2. If the data contains a "Units" row, that row (row 2) needs to be removed. The iC import logic assumes 
that the first row is the column header row and subsequent rows are data rows. 

3. The first row is always assumed to be the “Time row”. If using the “Local Time” column, the user must 
first select the column and change the cell format to show both date and time (“m/d/yy h:mm:ss”). 
Otherwise, if the date is not shown then iC will assume the time is relative. 

4. For the time column, the other option is to use the “Experiment Time” column. In this case, iC assumes 
that the values are relative time in seconds from the start of the experiment. 

Note: The "Time" column does not necessarily need to contain absolute Date/Time values. The 
column may also contain elapsed time in seconds. For example: 

Time Temperature 

0 20.23 

5 22.54 

10 4.88 

15 29.12 

20 31.48 

In this case, the start time is assumed to be the same start time as the iC experiment. 

If you are reading in Excel data from a 3rd party source (DCS system, etc.) that is set to a different time zone 
than the iC computer, here is an easy way to format the data (assuming it is date and time data). 

• Set the original time data column (column A) in the correct cell format as noted previously.  

• Create a new blank adjacent column (column B).  

• Create a formula in cell B1 “=A1-(1/24)” to subtract 1 hour from column A time (or the number of hours 
difference for your time zone). 

• Delete column A. 

If data is time only (no date) then the formula is more complicated. Below is an example. 

For a time difference of minus 3 hours and a time span between midnight and 3 am, use: 

=IF(A1<0.125,A1+0.875,A1-0.125) 

What this formula does if the value in A1 is strictly a time value between midnight and 3:00 am is to add 21 
hours (21/24 or 0.875) to the value, providing the expected result of an adjusted time between 9:00 pm and 
midnight. 
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TREND PROFILES ZOOM OPERATION 

There are two methods available for zooming in on the trend display. 

• Right-clicking in the trend graph area and selecting the Zoom option from the right-click menu. 

• Dragging the mouse over the area you wish to enlarge, as shown below.  

 

The zoomed or enlarged image can be moved by moving the corresponding slider bars with the mouse.  

 

 
Reset Zoom—To return to the normal size display, right-click on the zoomed display and select the 
Reset Zoom option from the menu or click the button in the toolbar. 
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TREND ZOOM OPERATION WITH RESCALE ENABLED 

When Rescale is enabled, zooming has a slightly different effect. The x-axis is the only portion of the graph 
that is selectable by the user. The y-axis is automatically autoscaled. 

 

Zoom button—When you click the Zoom button, the cursor changes to the symbol show at the 
right. Move the cursor to the beginning point of the area to be zoomed. A vertical bar appears. Click 
and drag the mouse cursor to the desired end point of the zoom area. 

 

Release the mouse to zoom to display the zoomed graph with the Y axis autoscaled.  

 

Refer to Trend Autoscale Operation. 
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TREND AUTOSCALE OPERATION  

When AutoScale is enabled in the Trends Viewer or the Distributions Viewer, the y-axis automatically scales 
(0 to 100%) for all but the selected plot. The units used for the Y axis reflect those of the selected plot. As a 
result, the AutoScale feature enables a visual comparison of the shape of a trend in two different samples 
where the height in one is much smaller than in the other. 

 

AutoScale button—Click this button to scale the Y axis based on the selected plot in the graph. 
Remaining plots scale to their Y-axis extents (0 to 100%). In addition to the toolbar button, 
AutoScale is also an option when you right-click in the Y-axis area. 

For example, when AutoScale is enabled for the following graph, 

 

The Y axis is automatically scaled based on the selected plot. 

 

If no plots are selected, autoscaling uses the first plot in the graph as the basis and uses a Y axis scale of 0-
100%. 

 

Note: When AutoScale is in effect, the x-axis is the only portion of the graph that is selectable by the user.  
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USER-DEFINED TRENDS  

Users can define custom trends that perform math functions on one or more trends to show information or 
relationships that might not otherwise be apparent. Once a trend is created, it appears in the Trends Viewer 
where it can be tracked and analyzed. User-defined trends are treated the same as other trends in the Trend 
Viewer and also appear in the Statistics Viewer.  

Any number of user-defined trends can be created. User-defined trends can be chained so the result of one 
user-defined trend can be used in another user-defined trend. The iC software has internal checks to ensure 
that circular dependencies are not introduced when referencing other user-defined trends in a trend 
equation. 

The User-defined Trends task pane in the toolbox enables you to create a user-defined trend based a 
selected Calculation Function. The list of available functions appears when you click New. 

 

• To create a user defined trend, click New, select a mathematical function from the list that appears after 
you click New. Then, supply the related field information for the selected function (see Creating a User-
Defined Trend). 

• To edit an existing trend, select it in the list and click Edit. 

• To delete an existing trend, select it in the list and click Delete. Alternatively, select the trend in the list 
and press the Delete key on the keyboard. 
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Creating a User-Defined Trend 

Click New to create a new user-define trend. The task pane expands to display the definition fields available 
for the selected calculation. 

 

Use the Calculation Function selection list to choose the type of calculation that will define the trend. The 
following options are available: 

Add—Create a third trend based on the sum of the two specified trends. 

Subtract—Create a third trend based on the difference between the two specified trends. 

Multiply—Create a third trend based on the product of the two specified trends. 

Divide—Create a third trend based on the ratio of the two specified trends. 

Normalize—Create a normalized trend from the selected trend. 

Scale—Scale a trend based on a user-specified factor and/or an offset. 

Smooth—Uses the Savitsky-Golay filter (polynomial regression) to smooth a trend over a user-specified range 
and smoothing window. 
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Rate of Change—Create a new trend that is the 1st derivative of the selected tracking trend based on a user-
specified sample window. In other words, for each point T[i], rate is calculated based on the different with 
point T[i – w], where w represents the window size. 

Polynomial—Create a trend that is commonly used to support solubility in a crystallization workflow. 
Solubility C* is often a polynomial function of the temperature of the solution. C* = a + bT + cT2+ 

Example:  

 

Exponential—is commonly used to support solubility in a crystallization workflow. Solubility C* can also be 
expressed as exponential function of the temperature of the solution. C* = a*ebT. 

Example:  

 

The remaining fields in the task box will vary depending on the calculation selected. 

The following action buttons control the adding/editing of user-defined trend after a trend is selected: 

 
  

Shows the effect of the added/updated user-defined trend and keeps the editor open.  

The trend appears in the Existing User-defined Trends list, displays in the Trends Viewer, and 
the task pane remains expanded so you can create additional user-defined trends or adjust 
trend parameters 

 
Shows the effect of the added/updated user-defined trend and closes the editing portion of 
the task pane.  

The trend appears in the Existing User-defined Trends list, displays in the Trends Viewer, and 
the task pane collapses to its original view. 

 
To edit an existing user-defined trend, select the trend in the Existing User-defined Trends list, 
make changes, and Refresh. Alternatively, double-click on the trend in the list. 

 
Cancels any currently entered user-defined trend settings and closes the editor portion of the 
task pane. 

For a specific example, see Creating a User-defined Trend Solvent Dilution Adjustment. 
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Creating a User-Defined Trend Solvent Dilution Adjustment 

Users can build their own trends/statistics using simple mathematical operations. During a Live Experiment, 
define a user-defined trend to eliminate/offset the effect of dilution in the count per second trend. With the 
user defined trend, you can apply a correction factor to any of the trends displayed in the Trends Viewer. All 
the mathematical operations needed are in the User-Defined Trends toolbox. It is possible to use math 
operators on newly created user-defined trends. 

To do so, during a Live Experiment, click the User-Defined Trends task pane in the toolbox. 

Let's take the example of an experiment where the process is undergoing dissolution of a substrate/particles 
system by addition of a solvent: 

To eliminate the effect of the dilution, offset the count per second by multiplying the counts per the reverse 
of the dilution factor. 

Counts at time t = counts at time t without dilution effect / (Volume initial of solution 
+Liquid feed rate in mL) X Volume initial of solution 

To acquire the counts at time t without the dilution, use the following method: 

counts at time T without the dilution effect = Counts at time T x (Volume initial of solution  
+ Liquid feed rate in mL) / Volume initial of solution 

To create this new trend counts at time T without the dilution effect: 

1. Import the feed rate curve in the FBRM Trends Viewer (this should come from external data—for 
example from the LabMax instrument.) 

2. Phase 1: Build the dilution factor as follows: 

- Calculation Function: Choose the Scale: Factor*Trend+Offset 
- Trend:  feed rate in mL (imported trend) 
- Offset: 1 
- Factor:  result of 1/volume initial 

• The Trend name can be modified. For our purposes, the newly created user trend can be called, 
Dilution Factor. 

• Click OK to save the newly created trend. 

3. Phase 2: Apply the dilution factor to the counts trend of interest (the one from which we want to 
remove the effect of dilution). To do so: 

- Calculation Function: Choose the Multiply Trend 1*Trend2 
- For Trend 1: Select the Counts statistic that is of interest. 
- For Trend 2: Dilution factor. The trend created in Phase 1 appears at the bottom of the menu. 
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Distributions Viewer 

The Distributions Viewer contains a graph that displays the completed Chord Lengths Distribution (CLD) 
profiles at user-selected times during an experiment. Current measurements can be supplemented by 
pinned distributions or distributions from previous experiments, as references. This enables you to know with 
accuracy the chord lengths composition of the studied particle or droplet system over time and over 
different conditions.  

• Filters like weighted and unweighted offer the option to focus attention on coarse or fine particles or 
both at the same time.  

• The X-Axis shows the channel boundaries in microns.  

• The Y-Axis shows either the number or percent of chord counts, depending on which is selected. 

• On the keyboard, use the right and left arrow keys to step through the X axis one point at a time. Use 
the up and down arrow keys to step through the Y axis. 

• The viewer includes right-click context menus and a toolbar to facilitate performing various functions. 
The right-click menu includes the option to send a selected distribution to a library (see Working with 
Distribution Libraries). 

• For instruments that support more than one CSM, you have the option to display Multiple Chord 
Selection Models on separate tabs. 

 

When the mouse hovers over any point in a distribution, a tooltip shows the parameters for the point under 
the cursor. 
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DISTRIBUTIONS VIEWER CONTEXT MENUS 

The Distributions Viewer incorporates three right-click or context menus—one when you click in the general 
data area and one when you click on a specific distribution measurement. Notice that the y-axis and x-axis 
context menus are the same as the main graph context menu, with the addition of an ‘Exit Axis Settings’ and 
‘Zoom To’ options. 

 

Y-Axis: Edit Axis Settings… 

 

X-Axis:  Zoom To… 

 

 

 

Graph Context Menu 
(including Y-Axis and X-Axis options)  

 Distributions Measurement 
Context Menu 

Distributions Viewer—Graph Context Menu 

The main context menu appears when you right-click on the data area of the distribution graph 
and it contains tools for customizing the displayed data. 

Show Toolbar Displays the toolbar at the top of the display. 

 
The toolbar contains the following tools: 

 
 Prints the current distribution graph to a designated printer. 

  Copies the current distribution graph and legend as a bitmap, metafile, or as text (data 
only) 

  Zooms the display. Refer to Distributions Viewer Zoom Operation. 

 
 This button is only visible when the Zoom function is enabled. The button resets the 

zoom to its original scale. 
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  Rescales only the Y-axis on zoom. 

  AutoScales the Y-axis 

 
 Displays the Legend 

 
 Displays the Detail table. 

 
 Pins the item selected in the viewer. See Pinning. 

 
 Displays crosshairs on the viewer. Crosshairs immediately jump to the selected data 

point and a tool tip displays information about that point. 

 
 Opens the Add Distributions window. 

 
 

Removes selected distribution from the graph. 

 
 Displays selected distribution as unweighted (No Weight). 

 
 Displays selected distribution as weighted (Square Weight). 

 
 Displays selected distribution as both unweighted (No Weight) and weighted (Square 

Weight). 

  Displays the selected distribution as Normalized. 

  Displays the selected distribution as Cumulative, meaning a calculated statistical 
probability based on a running total. 

Show Legend Displays the Legend Box. 

 

Show Details Displays the Details Grid. 

 

Copy to 
Clipboard 

Copies the display to the clipboard. The display can be copied as a bitmap, Windows 
metafile or as text-only. 

 

Paste from 
Clipboard Pastes the contents of the clipboard into the graph. 

Print Opens the Print dialog to print the display. 

Send See Sending Distributions to a Distribution Library. 

High Contrast Displays the graph with a black background. 

Zoom Zooms the display. The cursor changes to a  so you can specify the area to zoom. See 
Distributions Viewer Zoom Operation. 

Reset Zoom Resets the zoom to its original scale. This button is only displayed when the display is in a 
zoomed condition. 
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Rescale on 
zoom Rescales only the X-axis on zoom. 

Autoscale Autoscales the Y-axis to 0-100% for all but the selected distribution to enable comparisons. 
Refer to Trend Autoscale Operation.  

Line 
Thickness 

Selects the line thickness for the plots. 

Weighting The weighting to apply to the distribution. Options include: 

 

Weighting 
Type Selects type of weighing to assign to the middle weighting button from a drop-down 

list. 

 
Square Weight—Chord length squared. A weighted distribution obtained by applying a 
chord-length squared weighting function to the unweighted chord distribution. The square 
weight function enhances sensitivity to change in the coarse aspect of the distribution. 

Inverse Length—A one-over-length weight distribution obtained by applying a one-over-
chord-length weighting function.  

Length Weight—Chord length weight. A weighted distribution obtained by applying a chord-
length weighting function to the unweighted chord distribution.  

Cube Weight—Chord length cubed. A weighted distribution obtained by applying a chord 
length-cubed weighting function to the unweighted chord distribution. The cube weight 
function enhances sensitivity to change in the coarse aspect of the distribution. 

Refer to Channel Weights and ‘Weighting Type’ in the Editing Statistics Definitions topic. 

Default 
Weighting 
Type 

Controls the default behavior for the left-most weighting  button. Button behavior can 
be set to No Weight (unweighted) or Inverse Length type of weighting. 

 No Weight is the most common setting. 

Show 
Normalized Displays distribution by a normalized (percent) of counts. 

Show 
Cumulative Displays distribution by an absolute number of (cumulative) counts. 

Crosshairs Displays crosshairs on the Distributions Viewer. Crosshairs immediately jump to the selected 
point and a tooltip displays information about that point. The Trends Viewer and Events 
Viewer highlight the corresponding time. When you turn on the crosshairs option in the 
Distributions Viewer, they will jump to the highlighted point. Additionally, moving the 
crosshairs in the Distributions Viewer changes the column in the Statistics Viewer and the 
image in the PVM Viewer. 
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Axis Context Menu 

When you right-click in the Y-Axis or X-Axis area of the graph, each context menu includes lower sections of 
the main graph context menus, plus a special option specific to the axis. 

Y-Axis context menu   /   X-Axis context menu 

   

Y-Axis: 
Edit Axis 
Settings… 

Enables you to change the Y-axis label and set the minim and maximum limits for a 
distribution. 

 

X-Axis: 
Zoom To… 

Enables you to enter a zoom range for the x-axis to focus on a specific chord length area.  

 
When the zoom is in effect, a  the graph includes a grey slider bar to navigate within the full x-
axis range. 

 

 To reset the graph, use the toolbar icon or select Reset Zoom from the context menu. 
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Distributions Viewer—Measurement Context Menu 

An additional context menu data for customizing the distributions measurement data appears when you 
select a distribution. Access this menu by right-clicking on a measurement in the distribution graph or by 
right-clicking on a selected measurement in the legend or Details table. The last two methods may be 
preferable because it might be difficult to select a precise data point. Note that only available options are 
enabled and some options only appear when distributions have been imported or selected as references. 

 

The menu contains the following items. 

Hide . . .  Hides the selected distribution. The distribution is hidden in the graphic area but 
remains listed in the Details grid. 

Rename This option only appears when a reference distribution has been added to the 
Distributions Viewer. Select a reference distribution and rename it, as needed. 

Change Color 

 

Copy to Clipboard Copies the selected distribution data to the clipboard as text. 

Remove Distribution Permanently removes the selected reference distribution from the viewer. A 
confirmation dialog box appears before the distribution is removed.  

View Original 
Experiment 

If Reference Distributions have been imported to the Distributions Viewer, this option 
opens the source experiment, if available. 

Create Reference Designates the selected distribution as a reference. 

Designate/Remove 
as Target 

Assigns and removes the selected distribution as a verification target. The menu option 
toggles depending on the current state of the distribution. Target distributions can be 
used to calculate % difference from a target in the Statistics Viewer. 

Note:  If you right-click in the column heading of the Details table, additional options appear so you can 
customize the table or copy/print it. 
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The Distributions Viewer Details Panel 

A Details table enables you to customize the distributions in the viewer.  

 
Details button—Click this button from the toolbar to open the details table. Click it again to close the 
table. You can also double-click in the lower left corner of the viewer to display the details. 

Alternately, right-click in the distributions graph and select the Show details option in the context menu. 

 

 

Use the View buttons to the left of the details table to choose which distributions display on the graph.  

 

The All button displays all the distributions in the list. When the All button is selected, the Visible check 
boxes are used to select which distributions are displayed. The Hide All button hides all visible data in the 
graph. The Visible check boxes must be rechecked to view the distribution again. Unpin All button unpins 
(removes) all distributions on the graph. 
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CREATING A REFERENCE DISTRIBUTION 

A Reference Distribution can be created by right-clicking the Create Reference option from the measurement 
context menu. Reference Distributions are special because they are retained when loading/importing an 
experiment template. Reference Distributions include all distributions imported from other Experiments and 
Distribution Libraries. 

 

To create a reference using a distribution from a different experiment, you can drag the distribution from the 
Distributions Viewer in another experiment or Distribution Library to the current Distributions Viewer.  

Note: On experiments containing a large number of distributions, it is easier to drag the distributions 
from the distribution name in the legend. 

To add a reference distribution using the click-and-drag method: 

 
1. On a Distribution display or Distribution Library, click on distribution to be included in current 

display. The cursor changes to the symbol shown if the plot was correctly selected.  

 2. Drag the cursor to the tab of the destination display.  

 

 3. When the cursor hovers on the destination tab, focus switches to the tab and the Distributions 
Viewer is displayed. 
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 4. Drag the cursor to the graph area.  

 
5. The cursor changes to a shortcut icon.  

 

 

 6. Release the mouse button in the Distributions Viewer. 

 The dragged trend is copied to the destination Distributions Viewer. 
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DISTRIBUTIONS VIEWER ZOOM OPERATION 
 

 
Zoom in on a distribution by one of two paths: (1) Right-click on the chart and select the Zoom 
option, or (2) Click the Zoom icon button on the toolbar. 

Using the mouse as a drawing tool, drag the mouse over the area you wish to enlarge, as shown below.  

 

The area zooms to a close-up view of the selected area. 

 

 
To return to the normal size, right-click on the zoomed display and select Reset Zoom or reset by 
clicking the Reset Zoom icon button on the toolbar. 
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DISTRIBUTIONS VIEWER  ZOOM OPERATION WITH RESCALE ENABLED 

When Rescale is enabled, zooming has a slightly different effect. The x-axis is the only selectable portion of 
the graph. 

 When the Zoom button is clicked the cursor changes to a zoom icon. Move the cursor to the 
beginning point of the area to be zoomed. A vertical bar appears. Hold the mouse button and drag 
the cursor to the end point of the zoom area. 

 

Release the mouse button to display the zoomed graph with the x-axis rescaled.  

 

Applying Data Treatments to Experiment Data 

Several data treatment tools can be applied to experiment data (Distributions and Trends) to simplify 
analysis and comparison. These tools are on the Data Treatments task pane located in the right corner or 
right side of the Experiment display page.  

 

 

To open the Toolbox, click the Toolbox icon in the upper-right corner of the main window. 
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 Notice the pin button that appears to the right of the open Toolbox. It toggles in the Toolbox to 
appear or collapse  when you click it, as follows: 

 Horizontal pin means the Toolbox only appears while the cursor is in a task pane. This is the auto-
hide option where the Toolbox remains open until you move the cursor out of the task pane; then 
it closes automatically. Auto-hide is useful when you want to maximize the document viewing area. 

 Vertical pin means the Toolbox is pinned to always appear. Pinning is useful if you want to monitor 
or interact with the Toolbox (or one of its task panes) frequently. 

AVERAGING 

Averaging, also referred to as a "smoothing method," is a statistical method to smooth out fluctuations from 
the measurement data.  

Averaging methods can be applied to live experiments or post process as part of data analysis. The 
averaging settings can be altered at any time and are applied to the complete experiment data set.  

Averaging multiple measurements over time can provide more stable chord length distributions. These 
distributions provide greater precision and enhanced sensitivity to change in dimension. The negative aspect 
of averaging is that it slows the response to change and, in some cases, can decrease the reported 
magnitude of change in time (see the FBRM Application Manual for examples). 

There are 1324 each of input and output channels in this operation. Each output channel is an averaged 
version over past values of the corresponding input channel. 

Each channel independently undergoes the same averaging operation. For this reason, the channel number 
is left out in the following discussion. The counts in a particular channel taken over time are denoted as xt, xt-

1, ... , and the corresponding filtered values as yt, yt-1, …. , where t = 0, 1, 2, … for the first, second, and third 
measurement, etc. 

iC FBRM provides two types of averaging—Moving and Exponential. 

Moving—A cumulative moving average calculation is based on a user-defined number of unweighted data 
points in the experiment. The moving average calculation is as follows:  

𝑉𝑉𝑡𝑡 =
1
𝑛𝑛
�𝑋𝑋𝑡𝑡−𝑖𝑖

𝑛𝑛−1

𝑖𝑖=0

 

where:  𝑉𝑉𝑡𝑡 =   𝑡𝑡ℎ𝑒𝑒 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑡𝑡𝑒𝑒𝑐𝑐 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑛𝑛𝑚𝑚 𝑐𝑐𝑚𝑚𝑒𝑒𝑎𝑎𝑐𝑐𝑚𝑚𝑒𝑒 𝑐𝑐𝑡𝑡 𝑡𝑡𝑚𝑚𝑚𝑚𝑒𝑒 𝑡𝑡 

  𝑛𝑛 =   𝑡𝑡ℎ𝑒𝑒 𝑐𝑐𝑢𝑢𝑒𝑒𝑎𝑎 𝑐𝑐𝑒𝑒𝑑𝑑𝑚𝑚𝑛𝑛𝑒𝑒𝑐𝑐 𝑛𝑛𝑐𝑐𝑚𝑚𝑛𝑛𝑒𝑒𝑎𝑎 𝑚𝑚𝑑𝑑 𝑐𝑐𝑛𝑛𝑢𝑢𝑒𝑒𝑚𝑚𝑚𝑚ℎ𝑡𝑡𝑒𝑒𝑐𝑐 𝑐𝑐𝑐𝑐𝑡𝑡𝑐𝑐 𝑝𝑝𝑚𝑚𝑚𝑚𝑛𝑛𝑡𝑡𝑢𝑢 

  𝑋𝑋𝑡𝑡−𝑖𝑖  =   𝑡𝑡ℎ𝑒𝑒 𝑚𝑚𝑒𝑒𝑐𝑐𝑢𝑢𝑐𝑐𝑎𝑎𝑒𝑒𝑚𝑚𝑒𝑒𝑛𝑛𝑡𝑡 𝑐𝑐𝑐𝑐𝑡𝑡𝑐𝑐 𝑝𝑝𝑚𝑚𝑚𝑚𝑛𝑛𝑡𝑡 𝑐𝑐𝑡𝑡 𝑡𝑡𝑚𝑚𝑚𝑚𝑒𝑒 𝑡𝑡 − 𝑚𝑚 

Exponential—An exponential moving average calculation is based on all of the past data points in the 
experiment. This calculation applies weighting to all of the data points used in the calculation. The weight of 
a given data point used in the calculation decreases exponentially with time. The exponential moving 
average is calculated as follows: 

𝑉𝑉𝑡𝑡 = 𝛼𝛼𝑋𝑋𝑡𝑡 + (1 − 𝛼𝛼)𝑉𝑉𝑡𝑡−1 

where,   𝑉𝑉𝑡𝑡  =   𝑡𝑡ℎ𝑒𝑒 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑡𝑡𝑒𝑒𝑐𝑐 𝑒𝑒𝑒𝑒𝑝𝑝𝑚𝑚𝑛𝑛𝑒𝑒𝑛𝑛𝑡𝑡𝑚𝑚𝑐𝑐𝑐𝑐 𝑐𝑐𝑚𝑚𝑒𝑒𝑎𝑎𝑐𝑐𝑚𝑚𝑒𝑒 𝑐𝑐𝑡𝑡 𝑡𝑡𝑚𝑚𝑚𝑚𝑒𝑒 𝑡𝑡 
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   𝑉𝑉𝑡𝑡−1  =   𝑡𝑡ℎ𝑒𝑒 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑡𝑡𝑒𝑒𝑐𝑐 𝑒𝑒𝑒𝑒𝑝𝑝𝑚𝑚𝑛𝑛𝑒𝑒𝑛𝑛𝑡𝑡𝑚𝑚𝑐𝑐𝑐𝑐 𝑐𝑐𝑚𝑚𝑒𝑒𝑎𝑎𝑐𝑐𝑚𝑚𝑒𝑒 𝑐𝑐𝑡𝑡 𝑡𝑡𝑚𝑚𝑚𝑚𝑒𝑒 𝑡𝑡 − 1 

  𝑋𝑋𝑡𝑡  =   𝑡𝑡ℎ𝑒𝑒 𝑚𝑚𝑒𝑒𝑐𝑐𝑢𝑢𝑐𝑐𝑎𝑎𝑒𝑒𝑚𝑚𝑒𝑒𝑛𝑛𝑡𝑡 𝑐𝑐𝑐𝑐𝑡𝑡𝑐𝑐 𝑝𝑝𝑚𝑚𝑚𝑚𝑛𝑛𝑡𝑡 𝑐𝑐𝑡𝑡 𝑡𝑡𝑚𝑚𝑚𝑚𝑒𝑒 𝑡𝑡 

  𝛼𝛼 =   𝑡𝑡ℎ𝑒𝑒 𝑢𝑢𝑒𝑒𝑚𝑚𝑚𝑚ℎ𝑡𝑡𝑚𝑚𝑛𝑛𝑚𝑚 𝑐𝑐𝑚𝑚𝑒𝑒𝑑𝑑𝑑𝑑𝑚𝑚𝑐𝑐𝑚𝑚𝑒𝑒𝑛𝑛𝑡𝑡.  

FBRM Averaging Settings Editor 
1. Select the Data Treatments task pane from the Toolbox. 

2. Click the More options button (  ) next to the Averaging data treatment to open the Averaging 
Settings Editor. 

 

 

3. In the Averaging Settings Editor, check the box to Enable averaging data over time. 

4. Select Averaging Method—Moving or Exponential. Then, use the ‘Window size’ or ‘Alpha factor’ 
slider to adjust the degree of averaging.  

Moving Average, Window Size (2 to 60): Use the slide bar to adjust n (user defined number of 
unweighted data points). The larger the n, the smoother the data. 

Exponential Average, Alpha factor (1.00 to 0.00): Use the slide bar to adjust alpha (α) factor to a 
value between one (no smoothing) and zero (maximum smoothing). 

5. Click OK in the Averaging Settings Editor to apply the settings.   
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In the following examples, different averaging methods are applied to the same FBRM data. 

No Averaging: 

 

Moving @ n=5 

 

Exponential @ α = 0.35 
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CHANNEL GROUPING 

Channel grouping provides the ability to put the primary chord length distribution of 1324 channels into a 
channel grouping more appropriate to the application under investigation.  

Understanding the difference between channel grouping on a linear X-Axis versus a logarithmic X-Axis is 
important, as the choice of grouping can significantly affect both the data display and the statistic 
calculation.  

 Logarithmic (Log) Grouping  Linear Grouping 

Channel width Progressively wider  All equal 

Distance between midpoints Proportionate to the logarithm Equal 

Result High resolution on small-particle 
side of distribution 

Significantly lower resolution 
(channel-averaging) on large-
particle side of distribution 

Equal resolution throughout the 
distribution. 

Each channel has equal 
probability of a receiving a count 

When deciding whether to use a logarithmic or linear grouping, consider the number of channels selected 
and the effects caused by the number of channels selected. From a display perspective, significantly different 
data attributes may be highlighted depending on the chosen grouping. 

• Counts per channel: The more counts per channel, the better the statistical stability. The fewer channels 
chosen, the more counts there will be per channel.  

• Number of channels: The more channels chosen, the higher the potential resolution of change and the 
more counts required for statistical stability. The fewer channels chosen, the lower the potential 
resolution of change and the fewer counts required for statistical stability.  

FBRM Channel Grouping Settings Editor 

 

Use the Channel Grouping Settings Editor to specify the parameters for a channel group. Open the 
window by clicking the browse icon on the Channel Grouping section of the Data Treatments task 
pane. 
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The dialog box contains the following fields: 

Resolution  Changes the Y-axis which effectively changes the resolution between Standard and High. See 
Effects of Channel Grouping on Resolution. The Log spacing scale only supports standard 
resolutions.  

Spacing  Specifies if the spacing between chords is in a linear or log scale. 

Range  Specifies the overall scale of the X-axis. 

 

Click the OK button after making changes to have iC reprocess the data and display a progress 
window. 

EFFECTS OF CHANNEL GROUPING ON RESOLUTION 

E25, G400, G600 Hardware  

 Standard Resolution 

(Linear/Log) 

High Resolution 

(Linear) 

Range (microns) # of bins # of bins 

0-100 50 250 

0-1000 / 1-1000 100 500 

0-2000 / 1-2000 200 500 

0-4000 / 1-4000 200 500 

Note that logarithmic spacing only supports standard resolution. (Refer to Channel Grouping.) 
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Statistics Viewer 

The Statistics Viewer plots chosen statistics over time so you can see how the particle or droplet system is 
changing. The viewer collects the time each measurement was taken and the Chord Selection Model used, 
along with the value for each loaded statistic. Statistics of the pinned measurements in the other viewers 
appear in separate columns showing counts of the different chord lengths in customizable buckets. In 
addition, user-defined trends and trends imported using copy/paste or drag-and-drop appear as a statistic. 

You can load, merge, save, and edit statistics using the toolbar above the Statistics Viewer. 

STATISTICS VIEWER DISPLAY 

Particle or droplet counts display in distributed Statistic Sets that can be edited, loaded, and saved using the 
tools provided with the viewer. 

A default statistics set loads when initially starting an experiment unless you select a template experiment 
with customized statistics in the Start Experiment wizard.  

 

• Use the right and left arrow keys on the keyboard to step through the columns one column at a time.  

• Use the up and down arrow keys to step through the rows one row at a time. 

User-defined trends display on the viewer with the name of the trend listed. 

 

Trends imported via copy/paste or drag/drop appear at the bottom of the statistics table with dashed lines. 
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Statistical trends defined through the Edit Statistics window also appear in the list. 

 

 

The lock symbol beside the color bar in the Statistics Viewer (and in the Trends Viewer Details 
table) indicates that the color has been locked (manually assigned) by the user. 

LOADING, MERGING AND SAVING STATISTIC SETS 

The toolbar at the top of the viewer offers functions such as editing, loading, merging, saving, printing, or 
comparing the statistics list, as described below. 

Note: Changing statistics is a display change only and does not alter the raw data. Loading, Merging, or 
Saving functions have no effect on the data. These functions enable you to tailor the statistics 
viewer to suit individual needs. 

 

 Print the current statistics set to a designated local or network printer. 

 Copy the statistics set to the clipboard. The statistics paste as a table. 

 Load statistics definitions from a file (*.icStats format). This replaces the default statistics. 
IMPORTANT: Loading a Statistic Set overwrites the current Statistic.  

A set of default statistics can be uploaded to the system and return the Statistics Viewer the default. 
The default statistics set is located at: 

C:\Program Files (x86)\METTLER TOLEDO\iCFBRM #.#\default.icStats  

Note:     The default Statistic Set cannot be modified by the user. 

 Save the current statistics as a file (A set of statistics definitions save in the *.icStats file format). 

 Merge statistics definitions from a file (*.icStats) with the current statistics. 

 Edit Statistics—Opens a window where you can define additional statistics, delete a statistics, or edit 
the current definitions. See Editing Statistics Definitions. 

 Percentage of Target—After a Distribution has been ‘Designated as Target,’ click this button to 
display a “Target” column in the Statistics Viewer to compare the current values to the target. The 
system recalculates the statistics using the target distribution as the basis. 
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Designate a Distribution as “Target” 

A distribution can be designated as a “target.” A target distribution is a distribution used as a mean upon 
which all other distributions can be measured against when calculating the statistics. iC FBRM offers the 
possibility to show the statistics of the remaining distributions as a % of the target statistics. 

To designate a distribution as a target, right-click on the distribution heading and select Designate as Target 
from the menu. 

 

The figure on the left shows a Statistics Viewer with the left column designated as a target. The figure on the 
right shows the viewer after the % of Target button has been clicked to recalculate the values to a percentage 
of the target.  
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Statistics Viewer Context Menus 

The Statistics Viewer incorporates several right-click ‘context’ menus. 

• Right-clicking in a data cell opens a menu that includes options for copying all or some of the contents 
of the viewer to the clipboard as text. 

 

• Right-clicking on a distribution heading in the Statistics Viewer opens another context menu that 
enables the format of the distribution to be edited.    

 

The menu contains the following options. 

Show/Hide . . .  Shows or Hides the selected distribution. The distribution is hidden in the 
graphic area but remains listed in the Details grid. 

Rename Allows the user to rename a distribution. 

Change Color 

 

Copy to Clipboard Copies the column data from the table to the clipboard. The data copies as 
text. 

Remove Distribution Permanently removes the selected distribution from the viewer. If the 
distribution is a reference, a confirmation window displays before removal.  
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View Original 
Experiment 

If a Reference Distribution is included, this option appears so you can open the 
experiment that contains the source of the distribution.  

Create Reference Designates the selected distribution as a reference. 

Designate/Remove as 
Target 

Assigns and removes the selected distribution as a verification target. The 
menu option toggles depending on the current state of the distribution. Target 
distributions can be used to calculate % difference from a target in the 
Statistics Viewer. 

• Right-clicking on a statistic set row name displays a third context. 

 

The menu contains the following options. 

Show/Hide Shows or Hides the selected statistic in the Trends Viewer. A hidden statistics 
remains listed in the Trend Viewer Details table with the Visible check box 
unchecked. 

Change Color 

 
When you change a color, a locked symbol appears to the right of it in the Statistics 
Viewer as well as in the Trends Viewer Details table. 

Change Y Axis Enables changing the Y-axis in the Trends Viewer. 

 

Copy to 
Clipboard 

Copies all the data for the selected statistic to the clipboard. The data copies as 
text. 
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EDITING STATISTICS DEFINITIONS 
 

 Edit—Click this button on the Statistics Viewer to edit the current statistics definitions. Clicking the 
button opens the Edit Statistics window. 

 

Whenever a change is made to a statistic, the change must be saved using the Save button. This button is 
normally disabled until an edit to a statistic is made. Edit made for a statistic must be saved before any edits 
can be made to another statistic. When all changes are complete, the user clicks the OK button to recalculate 
the statistics. The OK button is disabled until edits are saved. This indicates that recalculation of the statistics 
in unnecessary since no statistic properties have changed. 

 

Below is the normal order for editing statistics or defining a new statistic. 

• Choose the Statistic Type 

• Define the Range 
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• Specify Weighting 

• Specify Rate of Change 

•  Click to add a new statistic to the set.  

•  Define the new statistic or edit an existing statistic and then click Save.  

To rearrange the order of the statistics in the table and the Statistics Viewer, use the Move Up/Move Down 
buttons. First, select the statistic to move. Then, click the appropriate button to place the statistic in the 
desired location. 

Defining New Statistics 

To define a new statistic, click the New button and define the following properties: (When editing an existing 
statistic, select it and modify one or more of these properties.) 

Statistic type—Select from standard types or from special sets of statistical types. 

Rate of Change—A first derivative trend can be calculated based on another trend. Click the rate of Change 
check box and select the time window over which the first derivative will be calculated. 

 

Range—Select the chord length range (in µm) over which the statistic is calculated using the Full Range check 
box or the Start/End fields. 

 

Weight Type—Select the weighting type for the statistic. 

 

The No Weight setting applies no weighting.  

The Square Weight setting applies a weight factor to each channel’s counts of:  
chord length ^ 2 / Avg. (chord length ^ 2).  

The Inverse Length setting applies a weight factor to each channel’s counts of: 
(1 / chord length) / Avg. (1 / chord length). 

The Length Weight setting applies a weight factor to each channel’s counts of:  
chord length / Avg. chord length.  

The Cube Weight setting applies a weight factor to each channel’s counts of:  
channel chord length ^ 3 / Avg. (chord length ^ 3). 
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Statistic Types 

In the Edit Statistics window, select a statistic type and view or edit its properties (refer to Editing Statistics 
Definitions for details about the editing window).  

To change the type of statistic, choose from the Statistic type selection list. Basic statistic types appear at the 
beginning of the selection list.  

 

Sets of related statistic types appear below the basic list in brackets. For example: <Advanced…> 

 

When you choose one of the sets, an additional submenu of types appears to further define the statistic. For 
example, the submenus for <Advanced>, <CSM Diagnostics>, and <Hardware Diagnostics> statistics 
include the following options: 

 
 

 

CSM Diagnostics and Hardware Diagnostics: Details about these are in the Diagnostic Statistics topic.  

Note: Serial Inputs (up to 30), such as diagnostics and temperature values, can be trended as defined in the 
Serial I/O Configuration Task Pane.  
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The upcoming tables describe the available statistic types. More detailed information is provided in 
Appendix A: Data Processing in the iC FBRM Software. 

BASIC STATISTICS 

Counts The Total Counts statistic calculates the sum of the number of counts over all channels in the 
distribution, reported in counts per meter. 

Mean 
The Mean statistic calculates the mean chord length of the distribution, reported in microns. 

Median The Median statistic calculates the median chord length of the distribution, reported in 
microns.   

Percentile c The Percentile statistic calculates the chord length, reported in microns, corresponding to a 
user specified percentile. In addition to the standard weighting and sub-ranging settings, this 
statistic requires a percentile value to two decimal places.   

% > The Percent Above statistic calculates the percentage of the measured chord lengths that are 
greater than a user specified chord length.  In addition to the standard weighting and sub-
ranging settings, this statistic requires a chord length value, in microns, to two decimal places.   

% < The Percent Below statistic calculates the percentage of the measured chord lengths that are 
less than a user specified chord length.  In addition to the standard weighting and sub-
ranging settings, this statistic requires a chord length value, in microns, to two decimal places.   

Standard 
Deviation  

Statistical calculation of the standard deviation of chord lengths of the distribution, reported 
in microns.   

ADVANCED STATISTICS 

Detection 
Count 

Number of detected maxima in the FBRM signal. This value is normalized to maxima/2 m 
scanned. This diagnostic must always be larger than the number of accepted counts. 

Stuck Particle 
Correction 

(When ‘Enable Stuck Particle Correction’ is ON) The percent of the scan circle that has been 
ignored/removed due to stuck particles and corrected for by scaling the remaining counts. 
10% is the maximum. NOTE: This statistic should be added (trended) if ‘Enable Stuck Particle 
Correction’ is selected in the Data Treatments Task Pane. 

Fouling Index Percentage of the scan circle that is covered with stuck particles or “fouled.” If the 
percentage exceeds 50%, the system issues a Fouling Index High alarm. 
NOTE: This statistic should be added (trended) if ‘Enable Stuck Particle Correction’ is selected 
in the Data Treatments Task Pane. 

Chi Square The Chi-Square statistic calculates the value of the chi-square test for the distribution 
compared to the target reference distribution. This statistic is reported as a dimensionless 
number.  

Running Chi 
Square 

The Running Chi-Square shall calculate the chi-square test for the current distribution 
compared to a previous distribution that is n records back from the current distribution. In 
addition to the standard weighting and sub-ranging settings, this statistic requires a value 
for n, the number of distributions back from the current. Chi-square test is actually a ratio. 
Therefore, if two distributions are identical, the value is 1 (default). The user must enter an 
integer value when the statistic type is running chi square. 
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Moment The N-th Moment statistic - full range. The user can specify the value for n, the order of the 
Moment. The value for n ranges from 0 to 4. The unit of the statistic is: 

0th moment = the total number of particles 

1st moment = the total length of the particles (micron) 

2nd moment = the total area of the particles (micron^2) 

3rd moment = the total volume of particles (micron^3) 

4th moment = micron^4 

The user must enter an integer value when the statistic type is moment. 

Mean Sq Wt 
/Median No 
Wt 

The Mean/Median statistic calculates the ratio of the square-weighted mean and the 
unweighted median over the full range of the distribution. This statistic shall ignore any 
user-defined weighting and sub-ranging settings.  

c90-c10 The c90-c10 statistic calculates the 90th percentile statistic minus the 10th percentile 
statistic, reported in microns. 

c75-c25 The c75-c25 statistic calculates the 75th percentile statistic minus the 25th percentile 
statistic, reported in microns.   

DIAGNOSTIC STATISTICS 

Below is a list of available diagnostic statistics for hardware and Chord Selection Modules (CSMs). Available 
diagnostic statistics correspond to specific instrument types. For example, with the G600 hardware, all 
diagnostics statistics are available. For G400 and E25 hardware, as these are electronic probe systems, air-
pressure related alarms are suppressed and the air-pressure diagnostic is not available. CSM Diagnostics 
apply to all ParticleTrack instruments. 

Hardware Diagnostics 

Air Pressure Air supply pressure to the air motor (does not apply to electronic probe systems).  

Box Temperature Field unit enclosure temperature. 

Laser Current Electrical current being drawn by the laser (mA) 

Scan Speed Voltage The error between the desired scan speed and the actual scan speed. A value close to 
zero indicates the probe is running at the desired speed (air-driven probes only). 

TEC Temperature Temperature of the Thermoelectric Cooler (TEC) adjacent to the detector/laser 
assembly inside the field/base unit. 

CSM Diagnostics 

Acquisition Time Number of seconds’ worth of data that was used in calculating the distribution. For 
example, only 7 seconds of data may have been used to create a distribution after 10 
seconds.  

Algo Time per Seg Amount of time (seconds) required to process the CSM algorithm. 

Average Peak Height 
(A-D units) Average height above the dark area mean of any detected maxima. 

Average Signal 
Intensity (A-D units) Height of the average FBRM signal above the dark area mean. 

CP1 Calibration Parameter configured during manufacturing and service. This is usually a 
straight line on the Trend chart.  
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Dark Level Mean (A-
D units) Average FBRM signal height when the laser is turned off. 

Dark Level Standard 
Deviation (A-D units) The FBRM signal STD deviation when the laser is turned off. 

Effective Duration 
(%) 

The processing efficiency of the Gen 3 unit. It is defined as the total time of the signal 
processed divided by the measurement duration. 

Estimated Scan 
Circle Diameter 
(mm) 

Estimated scan circle diameter in millimeters is a calculation based on the instrument 
scan speed. The diameter should be within ± 10% of the calculation. 

Scan Circle Diameter 
(mm) 

Actual parameter configured during manufacturing and service. This is usually a 
straight line on the Trend chart. 

Scan Frequency (Hz) Number of rotations the scanner makes per second. 

 

AUTOSTATS 

AutoStats is an automated analysis function tool that provides the user with the most amount of information 
in the least number of statistics. By applying a D2i (Data to Information) algorithm called AutoStats, a 
minimum number of statistics are automatically calculated to maximize the sensitivity to change for the 
particle system under investigation. 

Smart AutoStats algorithms reduce analysis time by maximizing sensitivity to change while simplifying the 
number of trends to analyze. 

Examples 

• The default fine statistic range can often be expanded to encompass all the fine particles.  

- In this example fines can extend out to 30 μm.   
- Between 2:07 and 2:55 there is a decrease in particles <30 μm and an increase in particles >30 μm. 
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• The default statistic range may mask changes if it extends through a transition where there are 
changes to the fine and coarser particles.   

- The range can be split to enhance resolution to changes in the particle system.  
- Below a decrease in particles 10-30 μm is offset by an increase in particles 30-50 μm.   

 

• The coarse default stat range can often be expanded to encompass all the large particles.  

- This simplifies the statistics and adds to the statistic resolution.    
- The default range 1000-4000 μm can be combined with 150-300, 300-1000 μm.   
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• By applying AutoStats, a mathematical algorithm analyzes changes to: 

- Simplify analysis by minimizing the number of statistics.  
- Maximize resolution to change for the specific particle system. 

 

 

 

Applying AutoStats to Multiple Experiments Simultaneously 

If the default statistics are compounded by multiple experiments such as in a design of experiment (DOE), 
complexity increases and the default statistics potentially become less sensitive to specific changes across all 
the particle systems.   
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- Users may run AutoStats that provides rapid analysis of all four experiments choosing the 
minimum number of statistics. This maximizes sensitivity to change. 
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- By applying AutoStats, a minimum number of statistics are automatically calculated to maximize the 
resolution to change for the particle system under investigation.  

- Smart AutoStats algorithms reduce analysis time by maximizing sensitivity to change while simplifying 
the number of trends to analyze.  

How to Apply AutoStats in iC FBRM 

1. Before running AutoStats, save the experiment after selecting the same Chord Selection Model (Primary 
or Macro) as the Chord Selection Model to be effective. 
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2. Select to Run AutoStats from the Start Page. 

 

3. Select to Run AutoStats on all four open files. 
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4. Highlight an experiment and open the results. 

 

Running AutoStats 

Choose one of two methods to perform an AutoStats evaluation. 

• Run AutoStats button on the Start Page that is used to initiate an AutoStats evaluation. 

 

or 

• Run AutoStats option from the Tools menu that that runs an AutoStats evaluation on currently opened 
experiments. 
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When initiated, an ‘AutoStats Select and Save Tool’ window displays a list of all opened experiments. 

 

 
Click the Browse button to open a file browser and select the 
experiment/s to use for the evaluation. Use the Shift and Control keys 
on the browser to select multiple experiments. You can use the Browse 
button multiple times to add additional experiments to the list of 
experiments. 

 
Existing experiments in the list can be removed by first selecting the 
experiment and then clicking the Remove button. 

Name and Folder  Enter a file name and browse to the location for the new statistics file 
that will be created when you run AutoStats. 

 
Click this button to run the AutoStats evaluation. 

A progress dialog appears during experiment data analysis. 
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When the evaluation completes, a success dialog appears. 

 

 

 Load Statistics Definitions from a file—When saved, the new AutoStats file is a statistics definition file 
and can be used in any experiment by clicking on this ‘Load Statistics Definitions from a file’ button 
in the Statistics Viewer toolbar. After you select the AutoStats definition file, the optimized statistics 
are used for the experiment. 

Note: If an AutoStats evaluation contains multiple experiments, the default Chord Selection Model (CSM) 
must be the same for all experiments. If the CSMs for the experiments do not match, the user 
should change the default CSM using the Data Treatments task pane and Save the experiment prior 
to running the AutoStats evaluation. 
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PVM Viewer 

The PVM (Particle Vision and Measurement) Viewer in iC FBRM processes and displays images from an iC 
PVM experiment or a saved sequence (*.seq) file. 

 
To load and adjust PVM images, use the PVM Task Pane in the Toolbox.  

1. Choose the image source: 

• iCPVM export folder  

Starting with iC PVM 7.0 SP1, choose this option to load images from the folder designated in the 
iC PVM export. User can import during live experiment or after the experiment is complete.  Images 
can be in .png or .jpg format. To enable the live images feature, iC PVM must also be running on 
the same control computer as iC FBRM. 

Note:  Please use the same prefix for the image files as specified in the iC PVM export. By default, 
the prefix is IMG_. If the prefix is changed in iC PVM, you must change the prefix in the iC 
FBRM PVM task pane. 

• Sequence file (completed experiment) 

For sequence files exported from iC PVM 7.0 or from PVM v8.x software (.seq format), choose this 
option. 

Note: Importing sequence file is for completed experiment only.  

To import a sequence file, the sequence file (*.seq) for the experiment and its accompanying image 
folder must have the same name (disregarding the extension) and reside in the same upper-level 
folder. The date and time that the image was taken appears in the PVM title bar. 



 

Page 117  

 

Click Load on the PVM task pane to navigate to one of the following, depending on the image source 
you selected: 

a. iC PVM export folder of images: 
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b. Or, the Sequence file (*.seq) and its accompanying images. 

 

2. Select the file to import and click Open to load the selected images into the iC FBRM PVM Viewer.  

3. Timestamp Offset:  If the loaded sequence file was created in another time zone or on a PC with a 
different time setting, use the up/down arrows to adjust the image time stamp to the current PC time 
zone (in minutes and seconds). 

You can now observe PVM images appear in the PVM Viewer. 

USING THE PVM TOOLBAR 

Use the PVM toolbar to manipulate the displayed image. 

 

Arrow buttons at the top of the image enable navigation through the images in the file. Information 
identifying the currently displayed image appears between the arrows. 

 

The toolbar above enables you to perform the following actions: 
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Copies the displayed image to the clipboard. When copied, 
the image is in its native resolution. To obtain a high 
resolution, expand the image to its maximum (Tab) view 

before copying. The copy function is also available through the context menu. 

 
Zoom/Restore zoom—Use the magnifying glass buttons to zoom the image.  

 
Move image—When hen in zoom mode, the Hand button enables you to pan the image. 

 
Measure particles—Use the ruler button to measure particles. 
With the button is enabled, drag the cursor over the particle 
area to be measured to create a measurement line. 

An arrow appears on the image with the particle size 
displayed in microns. Multiple measurements can be drawn 
on an image. To clear measurement arrows, move to another 
PVM image and then return to the image of interest. When 

the original image redisplays, the measurement arrows are cleared. 

Individual measurement arrows can be removed by using the Ctrl-Z key combination. 

NOTE: The measure loses accuracy as the image is zoomed multiple times. This effect is the 
result of the pixel size of the image. 

 
Prints the PVM image to a local or network printer. This 
option is also available from the context menu. 

 

 
Undock viewer—The PVM viewer can also be displayed as a floating window. To open the viewer 
in a floating window, click the Undock button on the toolbar (see example in this section). 

 Dock viewer—To close the floating PVM viewer and return it to the docked position, click the 
button again. 

 

As with other viewers, the PVM Viewer is linked. When a measured time in a trend or distribution is selected, 
the corresponding PVM image displays. 
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Surface Viewer 

The Surface Viewer shows a three dimensional view of the entire experiment with a time line and two 
planes—one in the x axis and one in the z axis—for an in-depth analysis. The display can be enlarged or 
reduced in size, completely rotated about all three axes, and moved within the Surface Viewer. Colors can be 
changed to emphasize different parts of the experiment and a wire frame can be added for detailed analysis.  

The data displayed in the 3D Surface Viewer matches the data treatment settings including averaging 
settings, channel groupings settings and selected Chord Selection Model (when more than one Chord 
Selection Model is selected).   

The Surface Viewer supports the view currently displayed in the Distributions Viewer (weighting type, 
normalization, cumulative). If both weighted and unweighted distributions are displayed in the Distributions 
Viewer, unweighted distributions display in the 3D Surface Viewer. 

During live experiment, the 3D surface is linked to the Trends Viewer, Distributions Viewer, and Statistics 
Viewer. During post-processing review mode, the 3D surface is linked to the Trends Viewer, Distributions 
Viewer, Statistics Viewer, and PVM image. 
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To rotate the Surface Viewer about its three axes: 

Place the cursor anywhere on the display, hold down the left mouse button and move the cursor. The display 
will rotate about its axis in response to vertical and horizontal movements of the mouse. 

To move the display up, down, or sideways in the display area: 

Put the cursor anywhere on the display, click the right mouse button, and move the mouse in the desired 
direction. The display moves in the same direction as the mouse.  

To enlarge or reduce the size of the Surface Viewer: 

Put the cursor anywhere on the display, rotate the mouse wheel counterclockwise to reduce the size of the 
display, or rotate the mouse wheel clockwise to enlarge the display.  

 

Keyboard Control Keys 

Place the cursor in the 3D display and use any of the following keyboard keys to adjust or navigate the 
image: 

• Press the C key to change the color to one of the selections in the Color Schemes submenu. The 
color changes each time you press the C key until it cycles through all Color Scheme options. 

• Press the W key to display the wire frame display. Pressing it again turns off the wire frame display.  

• Press the R key to reset the Surface Viewer display. 

Press the keyboard up or down key  to move the time sequence on the topographic surface. 

Press the x key to display the chord length on the topographic display. Press the left or right keyboard keys 
 move the chord length line to the right or left.  
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Surface Viewer Context Menu 

There are several options available in the Surface Viewer context (right-click) menu. 

 

Print Prints the display to a local or network printer. 

Copy to Clipboard The Copy function copies a bitmap image of the surface to the clipboard. The 
image can be pasted into any application supporting bitmaps. 

Copy with High 
Resolution 

Copies the image to the clipboard with a higher resolution than the normal 
copy function. 

Save as Image Saves the view as a PNG image file. 

Show/Hide Wire 
Frame 

Show wire frame – When checked, displays a wire frame on the surface. 

 

Reset View To reset the display to its default setting, select Reset View. 

Color Schemes  To select a color scheme for the Surface Viewer, select the desired color 
scheme from the drop-down list. 
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Event Viewer 

The Events Viewer is a log of various events, including: 

• Hardware and Software configuration 
• Annotations made by the user 
• System messages including Pause and Resume actions 
• Error and warning messages 
• Audit events 
• Sample events that record the date and time a sample was taken 
• A list of pinned distributions. 

Event Viewer Display 

The Events Viewer logs the time each sample measurement was taken during an experiment. When the user 
clicks a sample in the list, the sample displays in the Distributions Viewer. 

IMPORTANT: Observations about an experiment can be added to the Events Viewer during an experiment 
by (1) right-clicking on a row in the Events Viewer and selecting Annotation from the context 
menu or by (2) entering an annotation in the The Live Experiment Toolbar. 

To select multiple samples in the Events Viewer use the keyboard. Press the Ctrl key (for individual), or 
Shift+Ctrl keys (for a range). Use the context menu to pin or unpin selected multiple samples. 
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Event Viewer Context Menu 

The Events Viewer incorporates a right-click or context menu that contains an option for copying the 
contents of the viewer to the clipboard. The data can be copied as: 

• A table of all events 
• The table of events as an image 
• Copy the selected row as text 

A Print option can be used to print the contents of the display to a local or network printer. 

 

Adding an Annotation 

Annotations can be added to the Events Viewer by right-clicking on a row in the Events Viewer or by using 
The Live Experiment Toolbar (only while an experiment is running). 

 

A blank annotation window opens. Enter the text for the annotation and click OK to save it. 

 

 User Annotation markers display in the Events Viewer with  Date/Time information 

 Pinned icon displays to designate a pinned sample. 

 System Message icon displays when a system message generates. 
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When the mouse hovers over the marker on the Measurement graph, a tool tip is displays the annotation 
text. Double-clicking the marker will open a popup with the annotation text. 

Existing annotations can be edited by double-clicking the annotation in the Events Viewer or by using the 
Edit option in the right-click menu. 

 

The menu also contains options for deleting an annotation.  

Right-clicking on an Annotation in the Trends Viewer displays a context menu with two additional options. 

 

When choosing the Move Annotation option, the marker can be dragged to the new location with the cursor. 
When the marker is at the desired location, click the mouse button to set the marker at that location. The 
annotation can be moved by right-clicking either directly on the marker or the marker text. 

The annotation text can be moved by clicking on the text. The cursor changes to an arrow that can be 
moved to the decided location on the graph. 

 

The Show/Hide Annotation Text will display or hide the text of the annotation next to the annotation marker. 
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Event Viewer Toolbar 

The Events Viewer contains a toolbar that provides filters for selecting which type of messages will be 
displayed. The toolbar contains the following filters. 

 

 Prints the contents of the display 

 Copies the table to the clipboard 

 Show/Hide all user annotations 

 Show/Hide all system messages 

 Show/Hide all pinned sample actions 

 Show/Hide all unpinned sample actions 

 Show/Hide all error messages 

 Show/Hide all warning messages 

 Show/Hide all informational messages 

 Show/Hide all audit messages 

Customize the Events Viewer filters in any combination to show or hide the log items according to you 
individual preferences or requirements. 

Working with Distribution Libraries 

Multiple Distributions can be saved in library sets for comparison and analysis purposes.  

To create a new Distribution Library: 

Click New Library on the Start Page, or 

Select the New > New Distribution Library option in the File menu. 

 

To view an existing Distribution Library: 

Click Open Library on the Start Page, or 

Select the Open >Open Distribution Library option in the File menu. 
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ADD DISTRIBUTIONS DIALOG 

The Add Distributions window opens when you create a Distribution Library or when you add distributions to 
a library. 

 

The window contains a tree-list of all pinned distributions in opened experiments. Check the desired 
distributions and click OK. The window closes and the Distribution Library view opens as a new tab in the 
display area. 

Add Distributions by one of the following actions: 

Click toolbar button  or 

Select the Add Distributions option from the right-click menu. 

 

Both these options open the Add Distributions window. 
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Copy-and-Paste Spreadsheet Data into Distributions Library 

The user can also copy data from an Excel spreadsheet to the clipboard and paste the data into the 
Distribution Library viewer to create distributions. The paste function is available on the context (right-click) 
menu of the distributions viewer. 

 

The first column of the data must contain the midpoints, with subsequent columns containing the values for 
the distributions. The first row must be a header row containing the distribution names.  

• Distributions copied into iC FBRM from Excel are not be affected by Data Treatments or weighting. 

• Statistics cannot be calculated for the distributions that are created from clipboard data. 

Drag Distributions from an Experiment to the Distributions Library 

The user can also drag distributions from an experiment to the Distribution Library display.  

Note: On experiments containing a large number of distributions, it is easier to drag the distribution from 
the name in the legend. 

To add distributions by this method: 

 1. On a Distributions display, click on trend to be included in new Distribution Library. The 
cursor changes to the symbol shown on the left if the plot was correctly selected. 

 2. Drag the cursor to the Distribution Library tab. 

 3. When the cursor hovers on the destination tab, focus changes to the tab and the Trend 
Display displays. 

 4. Drag the cursor down to the graph area. 

 
5. The cursor changes to a shortcut icon. 

 6. Release the mouse button. 

The dragged trend is copied to the destination Distributions Library window. 
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Note: Once inserted into the library, distributions can be renamed using the Details table. Select the 
Distribution Name field and type in a new name. 

 

SENDING DISTRIBUTIONS TO A DISTRIBUTION LIBRARY 

Distributions in an experiment’s Distributions Viewer can be sent to a Distribution Library using the Send 
option in the Distributions Viewer context menu.  

 

The Send option automatically sends all experiment distributions to a selected Distribution Library. When the 
option is selected, it expands to list any opened Distribution Libraries. There is also an option available to 
send the distributions to a new library. If no libraries are currently opened, the only option displayed is to 
send the distributions to a new library. 

DISTRIBUTION LIBRARY DISPLAY 

The Distribution Library display is a two-paned window that incorporates a Statistics Viewer and a 
Distributions Viewer. The operation of these viewers is identical to the ones used for viewing experiment 
data. Refer to Statistics Viewer and Distributions Viewer. 
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Working with Result Sets 

A Result Set is a separate file containing trends selected by the user. Trends from several experiments can be 
put into one result set for comparison. Result Sets are maintained using several methods. 

• Create a new blank Result Set – see Creating a Result Set 

• Send trends directly to a new or existing Result Set – see Sending Trends to a Result Set 

• Adding trends to an existing Result Set – see Adding Trends to a Result Set 

• Adding a New graph (tab) to an existing Result Set – see Adding a New Graph to a Result Set 

CREATING A RESULT SET 

Measurements and trends from a file can be easily transferred to another file called a Result Set.  

To create a new Result Set, click the New Result Set button on the Start Page. 

or 

Select the New/Result Set option from the File menu. 

 

The Add Trends window opens. 

 

The window contains a tree-view of all trends in open Result Sets and Experiments. Select one or more 
trends to include in the new Result Set and click the OK button.  

Click OK to close the window and display the new Result Set.  
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Also see Interaction with Other iC Applications. 

 

It is good practice to save the new Result Set for future reference. To save the set, select the File/Save As 
menu option. 

SENDING TRENDS TO A RESULT SET 

The Trends Viewer contains a context menu option that allows the user to send trends from an experiment 
directly to a result set. If there any existing result sets currently opened, a list is displayed that allows the user 
to select the destination result set. There is also a heading that allows the user to create a new result set. 

 

All trends from the experiment are automatically inserted into the result set.  
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ADDING TRENDS TO A RESULT SET 

Trends from an iC FBRM experiment, another iC application or iControl can be added to a Result Set. Refer 
to Sharing Trend Data with Other iC/iControl Applications for guidelines pertaining to interactions with 
iControl and other iC applications. 

Additional trends can be added to an existing Result Set using two methods. 

Users can right-click in the graph area of the display and select the Add Trends menu option. 

 

The Add Trends window opens. 

 

Check the trends to add and click OK.  
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You can also drag trends from an experiment’s Trend Viewer to the Result Set display.  

Note: On experiments containing a large number of trends, it is easier to drag the trend from the trend 
name in the legend. 

To add trends by this method: 

 1. On a Trend graph, click on the trend to be included in new Result Set. The cursor changes to 
the symbol shown to the left, if the plot was correctly selected. 

 2. Drag the cursor to the Result Set tab.  

 

 3. When the cursor hovers on the destination tab, focus is given to the tab and the Trend Display 
appears. 

 4. Drag the cursor to the graph tab.  

 
5. The cursor changes to a shortcut icon. 

 6. Release the mouse button. The dragged trend is copied to the destination Result Set Display. 
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Note: If the trend was added from a live experiment, the trend will be updated in real time. 
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ADDING A NEW GRAPH TO A RESULT SET 

A new graph can be added to create a specific result set. New graphs appear as tabs along the top of the 
Result Set display. 

 

To create a new graph, select the New Graph option from the right-click menu. 

 

A new blank graph opens. Add trends to the graph as described previously. Refer to Adding Trends to a 
Result Set. 
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THE RESULT SET CONTEXT MENU 

The Result Set display incorporates two right-click or context menus. 

The first menu appears when you right-click within the graph (but not directly on a data point). This menu 
contains tools for customizing the displayed data. 

 

The menu contains the following items: 

Show Toolbar Displays the toolbar at the top of the display. 

  
The toolbar contains the following tools: 

 
 Prints the display. 

  Copies the graph to the clipboard in one of the selected formats: 

 

  Zooms in on the display. 
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 Resets zoom to original scale (button only appears when the Zoom feature 

is enabled) 

  Rescales only the X-axis on zoom. 

  Trend Autoscale Operation the Y-axis. 

 
 Displays the Legend box 

 
 Displays the Details table 

  Displays Add Trends window where you can select trends that adds a 
Reference Trend to the graph. Clicking the button opens the Add Trends 
window. 

Show Legend  Displays a legend box that lists each trend and its name and the CSM used to 
calculate the statistic. 

 

Show Details Displays the Details table. 

Show Tooltips If selected, a tooltip appears when the cursor hovers over data areas in the trend. 

Copy Chart to 
Clipboard 

Copies the display to the clipboard. The display can be copied as a bitmap, 
Windows metafile or as text-only. 

 

Paste from Clipboard Pastes the contents of the clipboard into the trend. The data must be in an X-Y 
table format such as a time/temp table from MS Excel. The first Y row should 
contain the column names for the table. 

Print Opens the Print window so you can select a printer and print the display. 

Send Sends a copy of the entire Result Set to one of the open Result Sets or to a new set 
with “1” appended to the name.  

High Contrast Displays the trend graph with a black background. 

Zoom Zooms the display. 

Reset Zoom Resets the zoom to its original scale. This button only appears when the display is 
in a zoomed state. 

Rescale on Zoom Rescales only the X-axis on zoom. 

Autoscale Autoscales the Y-axis. 

Line Thickness Selects the line thickness for the plots. 

X Axis Format Selects the format for the X axis. 

 

Add Trends See Adding a Reference Trend.  
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Show User Annotation 
Markers 

If a trend includes associated annotations, the orange marker appears at data points 
that have comments 

Refresh Data on This 
Chart 

Refreshes all the data on all the charts from their sources. This option only appears 
when the Result Set contains multiple graphs. 

New Graph Creates a new graph in a new tab. 

Rename Graph Renames the currently active graph. 

Delete Graph Deletes the currently active graph. 

Hide All User 
Annotation Texts 

This option only appears when you right-click on a data point in the graph. If a 
trend includes associated annotations, the orange markers do not appear at 
applicable data points in the graph.  

Show All User 
Annotation Texts 

This option only appears when you right-click on a data point in the graph. If a 
trend includes associated annotations, the orange markers appear at data points 
that have comments. 

The second menu appears when you right-click on a data point in the display, the legend, or the details table. 
The menu contains tools for customizing the data. 

 

The data context menu contains the following items: 

Hide . . .  Hides the selected trend in the graph. The trend remains listed in the Details table. 

Rename Use this option to change the data point name from the default statistic name. 

Change Color Opens a color browser to change the color of the trend line. 

Change Y Axis Opens a window that enables 
changing the Y Axis name. 

 

Copy to Clipboard Copies the display data to the clipboard. The data can be pasted into such 
applications as MS Word or Excel. Note: To copy the graph to clipboard, use the 
first context menu (right-click off a data point) and select Copy Chart to Clipboard. 

Remove Trend Permanently removes the selected trend from the viewer.  

View Original 
Experiment Opens the source experiment for the selected trend in a new tab. 
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Adjust Reference Time  

 

When the X-axis is in Relative Time mode, you can synchronize the trend times 
from separate experiments using the slider bar on top of the viewer graph. Two 
additional buttons appear in the toolbar with the time reference bar.  

 
When the adjustment is correct, the click the green check button. 

To cancel the time adjustment, click the red X. 

Clear Reference Time 
Offset 

If the Adjust Time Reference option adjustment has been applied, this option 
enables you to remove the adjustment. 
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Generating Reports of iC Data 

The iC FBRM software provides several methods for generating reports of experiment data: 

• One-click pre-formatted report in MS Word® format. See One-click Reporting Function. 

• Using the Microsoft Office® Clipboard to copy and paste data. See Copying Experiment Data and 
Copying Experiment Events. 

• Export function to export data in CSV format. See Exporting Experiment Data. 

One-click Reporting Function 

The One-click Reporting feature creates a pre-formatted report in MS Word or Microsoft XPS format. The 
XPS format is read only. Reports can be made for any current document: Experiments, Spectra Libraries, and 
Result Sets. The Report contains all data in the document.  

 

CREATING A MS WORD REPORT 

Access the Microsoft Word Report feature from the File/Create Word Report menu or from the corresponding 
button on the main toolbar. 

 

Click the report option and iC creates a report of the selected experiment. A progress indicator displays 
during the creation process. 

 

When processing completes, the report opens in MS Word as a new document. 
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Example Report 

Note that the format of the report is based on an MS Word template, iC Report Template.dot, located in the 
Program folder for the iC application. This template can be edited by the user to create custom report 
formats. It is advisable to make a backup copy of the template file before any edits are made. The name of 
the template file must not be changed.  
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CREATING AN READ-ONLY XPS REPORT 

The XPS report contains the same information as a MS Word report except that it is in a read-only format. To 
create this type of report, select File > Create Read-only Report or click the associated toolbar button.  

 

When the Create Report menu option is selected, iC creates a report of the selected experiment. A progress 
indicator appears during the creation process. 

 

When report generation completes, it opens in an XPS viewer. 
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Example Report 

 

The report resides in a temporary directory and must be saved to permanently store the report. Note that 
the report is read-only and can be opened by any application supporting the XPS format (Internet Explorer, 
Microsoft XPS Viewer, etc.) 
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Copying Experiment Data 

Data from the various viewers in the iC software can be used to create experiment reports. The Microsoft 
Office® Clipboard is used to copy and paste data into a suitable application such as Microsoft® EXCEL®. 
Data can be copied to the Clipboard using the viewer’s context (right-click) menu. The menu offers three 
options for copying data. 

• Bitmap—Copies the trend data as a bitmap (BMP) graphic file. 

• Metafile—Copies the trend data as a Windows metafile (WMA) graphic file. 

• Text—Copies trend data as text. See the explanation below for a description of the textual format. 

 

Both the Bitmap (BMG) and Metafile (WMA) options copy the data as a graphic image. The Windows 
Metafile format provides a clearer image but is not supported by some non-Microsoft applications. A bitmap 
image is universally supported but the file size tends to be large. 
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When trend data is copied as textual data, the data is copied as tab-delimited text. This format can readily be 
pasted into an Excel spreadsheet as a table. The first row of the data always contains the column headings 
for the table, as illustrated below. 

Time Median, 
No Wt 

Mean, 
Sqr Wt 

counts, 
No Wt, 
<10 

counts, 
No Wt, 
10-50 

counts, 
No Wt, 
50-150 

counts, 
No Wt, 
150-300 

counts, No 
Wt, 300-
1000 

counts, 
No Wt, 
10-50 

Annotations 

00:00:00 8.38664 85.5195 14235 9317.94 1766.99 92.0063 0.900364 9317.94  

00:00:30 8.61091 89.1336 13415.8 8930.36 1867.02 95.1139 1.48858 8930.36  

00:00:45 8.5736 82.3313 13488 8944.32 1847.71 92.5469 0.157523 8944.32  

00:01:00 8.70881 80.077 13083.7 8893.84 1891.96 78.1062 0.0562899 8893.84  

00:01:15 8.81392 77.0005 12901.3 8954.17 1929.94 50.2944 0.140725 8954.17  

00:01:30 8.79801 76.0715 12841.1 8840.86 1930.03 45.5922 0.257169 8840.86  

00:01:45 8.92954 75.2779 12668 8864.32 1955.16 42.0234 0.0642921 8864.32  

00:02:00 8.85344 73.7476 12788.2 8880.3 1929.53 38.011 0 8880.3  

00:02:15 8.90314 73.2215 12638 8918.22 1930.48 36.1398 0.0642921 8918.22  

00:02:30 8.88081 72.8214 12583.4 8881.02 1943.34 35.1468 0.0281449 8881.02  

00:02:45 8.85836 73.8016 12527.2 8810.9 1940.48 39.5767 0.0562899 8810.9  

00:03:00 8.8685 73.0732 12505.8 8745.74 1934.7 33.9485 0.148727 8745.74  

00:03:15 8.98394 73.7486 12281.1 8749.86 1935.57 37.1146 0.109235 8749.86  

00:03:30 8.99017 73.2592 12259.1 8712.34 1949.57 36.7452 0.0924371 8712.34  

00:03:45 9.15155 73.5342 12049.7 8778.09 1945.99 35.8438 0.184874 8778.09  

00:04:00 9.12329 73.0258 12091.4 8769.91 1926.62 35.2053 0.0642921 8769.91  

00:04:15 9.17598 72.4017 12065 8843.07 1930.13 34.1722 0.0642921 8843.07  

If the viewer contains data sampled at different time intervals, the format of the exported data varies 
depending upon which data is selected, as explained below. 

• If data is selected in the viewer when the user selects the Copy function, iC exports the raw values for all 
the visible data based on the set of timestamps associated with the selected data. Note that in a typical 
experiment all the data have the same timestamps, so data is copied without manipulation. 

For the more complex case in which there are multiple sets of timestamps to deal with, interpolation is 
used on those data with different timestamps to estimate the value at each timestamp in the selected 
data. In this case the selected data is copied ‘as is” since its timestamp is used as the master. Data with 
different timestamps will have their data copied as interpolated data. 

• If there is no selected data when the user selects the Copy function, the viewer creates a composite set of 
timestamps combining together ALL the timestamps for all the data and then eliminates any duplicates. 
Timestamps that vary by less than second are also eliminated. 

Interpolation based on the timestamps of the selected data is useful for analyzing data collected across 
multiple experiments. On the other hand, to export the most complete data set when multiple sets of 
timestamps are involved, make sure that no data is selected.  That way, all the actual data points plus 
additional interpolated values are copied. To deselect all data, click outside of the actual graph area in 
the viewer.  
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Copying Experiment Events 

Annotations and messages from the Events Viewer can be copied to the clipboard for use in experiment 
reports. Events copy as tab-delimited text that can be pasted as a table into MS Excel or Word. You also have 
the option to copy the entire Events table, an image of the currently displayed portion of the table, or the 
currently selected row to the clipboard. 

 

Before copying event data, format the data displayed in the Events Viewer window. Do this by using the filter 
buttons on the Events Viewer toolbar to select which types of events to include. The Copy function copies all 
the event data currently displayed in the window. The following example features informational, audit, 
annotation, and pinned sample ‘events.’ 

Type Date/Time Description 

Info 2:39:44 PM 8/5/2015 START OF EXPERIMENT (Relative time zero) 

Audit 2:39:44 PM 8/5/2015 Schedule = 1 hour @ 10 seconds 

Audit 2:39:44 PM 8/5/2015 Estimated completion time: 3:39:44 PM 

Audit 2:39:44 PM 8/5/2015 Phase 1 started: 1 hour @ 10 seconds 

Audit 2:40:23 PM 8/5/2015 Experiment AutoSaving 

Sample 2:42:54 PM 8/5/2015 Sample 19 acquired at 00:03:10 (10.0s) 

Audit 2:44:09 PM 8/5/2015 Statistic "Percentile c, (0.5), No Wt, >1000" removed 

Audit 2:44:46 PM 8/5/2015 Added trend: Normalize: Normalize(counts, No Wt, 10-50 (Primary)) 

Audit 2:45:13 PM 8/5/2015 Replaced trend: Normalize 

Audit 2:45:23 PM 8/5/2015 Experiment AutoSaving 

Annotation 2:45:24 PM 8/5/2015 Increased temperature by 15 degC-JU 

Audit 2:46:31 PM 8/5/2015 Replaced trend: Normalize1 

Sample 2:46:34 PM 8/5/2015 Sample 41 acquired at 00:06:50 (10.0s) 

Audit 2:47:10 PM 8/5/2015 Experiment stopped by user request. 

Audit 2:47:10 PM 8/5/2015 Phase 1 stopped: 1 hour @ 10 seconds 

Info 2:47:10 PM 8/5/2015 Experiment Complete 

Audit 2:47:10 PM 8/5/2015 Experiment saving to \\us10s-users\users\joeuser-1\My Documents\iC 
FBRM Experiments\Experiment 2015-08-05 14-36.icFbrm 

Audit 2:58:00 PM 8/5/2015 Annotation "Increased temperature by 15 degC-JU" added at 2:45:24 PM on 
8/5/2015. 

Refer to the Event Viewer topic for more information. 



 

Page 152  

Exporting Experiment Data 

Data including all distribution values [X, Y] from an entire experiment can be exported to an external CSV file 
that can be directly opened by Microsoft® Excel®. Depending on the actual experiment, the resulting file can 
be very large.  

Note: Instructions below assume the decimal separator is the period. To use comma as the decimal 
separator, follow the instructions under Exporting CSV Files with Comma as Decimal Separator. 

To export experiment data, select the Export button in the File menu. 

 

The following dialog box describes the exported data, explaining that it uses the current display settings for 
the Distributions Viewer (WYSIWYG): 

 

• Averaging and Channel Grouping settings come from the Data Treatments Task Pane. 

• Weighting, Normalized vs. Absolute counts, and Cumulative vs. Discrete Channel counts are 
settings in the Distributions Viewer toolbar (see Distributions Viewer—Graph Context Menu). 

Note: If you are using Microsoft® Excel® 2003 or earlier, you should use low resolution (Standard) channel 
grouping.  This is because with higher channel grouping settings, the exported file will contain too 
many columns to be read by Excel 2003 or earlier. 

A standard Save As window opens (shown with Folders collapsed). 
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Enter a filename for the file and click the Save button.  

Note: Data is exported with the current averaging, channel grouping, weighting and Y axis applied. To 
change the data to be exported, you must first change the display settings. See Editing Statistics 
Definitions. If you wish to edit the display settings, click Cancel to abort the export operation.  

The saved CSV file can be opened directly by Microsoft® Excel®.  

Note: Refer to Contents of Exported CSV File for details on the exported CSV file. 

CONTENTS OF EXPORTED CSV FILE 

Below is an example of the distribution values exported in CVS format from an iC FBRM experiment. 

 

The first four rows contain the following information: 

No Weight—Distributions can be weighted or not, based on the setting in the Distributions Viewer toolbar. 

Ch.# —Channel or bin index (1 to the total number of bins defined in the channel grouping setting) 

Ch.Bd—Low boundary for each channel or bin. For example, Bin #1 starts from 1.0 and ends at 10.715. 

Ch.Midpoints—Midpoint for the channel boundary for each bin.  
(This is the X-axis value in the Distribution Viewer.)  

Each subsequent row represents a distribution taken and the given Date (2nd column) and Time ( 3rd column) 
and the counts of particles of sizes between the [bin low boundary and high boundary].  
(This is the Y-axis value in the Distribution Viewer.) 

• If you click on the Distribution Viewer chart and do not ‘Copy Chart to clipboard-> As Text (data 
only),’ the data that gets copied are the currently displayed distributions. 

• If you choose the MS Excel transpose option, the data copied to the clipboard is a subset of the 
exported CSV file.  

EXPORTING CSV FILES WITH COMMA AS DECIMAL SEPARATOR 

When exporting a CSV file, iC FBRM uses a comma to separate the values that should be imported into 
separate columns. For countries that use a comma as the decimal separator, a conflict arises. Typically the 
CSV export results in two columns for a number—the whole number in one column and the decimal part in 
the next column. 

To work around this situation, temporarily change the PC’s Region and Language > Additional Settings to 
use a different symbol as the Decimal Symbol.  
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Do the export to CSV and the import to Microsoft® EXCEL® using the temporary setting. After the file is in 
Excel, return the decimal separator setting to a comma.  

The workflow is: 

1. Temporarily change PC Region and Language setting for the Decimal Separator. 

2. Restart iC FBRM. Open the experiment to be exported. 

3. Do the export. Make sure the extension is .txt. 

4. Open Excel; then open the .txt file. 

5. In the Excel import, set the column separator to comma. 

6. Save as spreadsheet (.xlsx). 

7. Change the PC Region and Language setting back to the comma. 

Note: Refer to Contents of Exported CSV File for details on the exported CSV file. 
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Using the Toolbox 

The Toolbox is a windowed pane that provides a collection of “task panes.” Each task pane provides a set of 
controls for performing a task. For example, the Data Treatments task pane provides quick access to various 
data analysis functions that may be applied to the current experiment. 

 

To open the Toolbox, click the Toolbox icon in the upper-right corner of the main window. 

 Notice the pin button that appears to the right of the open Toolbox. It toggles in the Toolbox to 
appear or collapse  when you click it, as follows: 

 Horizontal pin means the Toolbox only appears while the cursor is in a task pane. This is the auto-
hide option where the Toolbox remains open until you move the cursor out of the task pane; then 
it closes automatically. Auto-hide is useful when you want to maximize the document viewing area. 

 Vertical pin means the Toolbox is pinned to always appear. Pinning is useful if you want to monitor 
or interact with the Toolbox (or one of its task panes) frequently. 

The Toolbox is organized as a button bar representing the set of task panes available to you based on an 
XML configuration file stored under your account in the Documents and Settings folder. This configuration 
file is typically stored under the hidden folder, based on the operating system: 

C:\Documents and Settings\<your username>\Local Settings\Application Data\METTLER TOLEDO\  
or 
C:\ProgramData\METTLER TOLEDO 

Below is the iC Toolbox with the individual task panes. 

 

The upcoming sections describe the standard task panes configured with iC software.  
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Data Treatments Task Pane 

The Data Treatments task pane provides data manipulation and analysis tools for the currently displayed 
experiment. The following options can be selected from the task pane (Notice the differences between a live 
experiment and a completed experiment): 

Live Experiment: 

 
 

 

 

Completed Experiment: 

 

Averaging Averaging is used to improve measurement precision of the 
trends. Refer to: Averaging. 

Channel 
Grouping 

Channel grouping gives the user the ability to group the 
primary chord length distribution of 1324 channels into a 
channel grouping more appropriate to the application under 
investigation. Refer to: Channel Grouping. 

Display 

Distribution 
Only applicable if multiple Chord Selection Models (CSM) are 
available. 

Click the Display Distribution selection arrow to choose which 
distribution (CSM) displays in the viewer. The selection list 
shows the distributions (CSMs) that are being calculated and 
displayed.  

To compare two distributions (CSMs), use any of the standard 
tools for moving distributions and trends between documents. 
Document types include results sets for trends, distribution 
libraries, and experiments. 

Note: For the E25, only a single CSM is available. 

Refer to Select Chord Selection Model Page.  

Also show 
<CSM name> 

Only displays if multiple Chord Selection Models (CSMs) are 
available. 

When checked, this Chord Selection Model is also calculated 
and displayed in the Trend, Distribution and Statistic viewers. 
See Chord Selection Models. 

Enable Stuck 
Particle 
Correction  

Only displays during a live experiment. If checked, this check 
box causes the system to attempt to remove/subtract stuck 
from the distributions through mathematical calculation. Note 
that the two diagnostic statistics, Fouling Index and Stuck 
Particle Correction, should be trended when using Stuck Particle 
Detection. Refer to Advanced under Statistic Types. 

Merge 
Experiment 

Enables you to merge two completed experiments into a 
composite experiment file. Clicking the button opens a file 
browser to select the experiment that will be merged into the 
currently selected one.  

Note: It is advisable to use the Save As function to save the 
merged experiment to a new file name. 

Trim 
Experiment 

Enables trimming (deleting) unnecessary samples from an 
experiment. Clicking the button opens a The Trim Experiment 
Dialog. 

Note:  It is advisable to use the Save As function to save the 
trimmed experiment to a new file name. 
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THE TRIM EXPERIMENT DIALOG 

Use the Trim Experiment dialog box to trim samples from a completed experiment. This feature is useful to 
remove insignificant samples from an experiment. It is advisable to save a trimmed experiment to a different 
filename leaving the original experiment intact. 

Move the slider bars to select the range of samples to delete from the experiment. To advance the slider bar 
in one-sample increments, use the arrow keys.  

 

In the above example, samples 1 through 41 are selected to be deleted from the experiment. 

A confirmation window summarizes the deletion so you can see the impact before the software executes the 
trim operation. 

 

An audit message records in the Events Viewer. 

 

Once an experiment has been trimmed, if you open the Trim Experiment window again, the Undo button 
appears. This button enables you to reverse a trim operation.  
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When the button is clicked, the Undo Trim window appears. 

 

The window contains a list of all Trim operations that have been performed on the experiment. The user 
checks the appropriate operation and clicks the OK button. Then, the trimmed samples are reinserted into 
the experiment and an audit message logs in the Events Viewer. 

 

CHORD SELECTION MODELS 

iC FBRM is a powerful technique that tracks the rate and degree of change to particles and particle structures 
as they naturally exist in process. iC FBRM requires no calibration or other information about the particle 
system to track the process with a high degree of precision and sensitivity. However, particulate systems are 
complex—especially when measured in situ at full concentration—and the accuracy of the chord length 
distribution (CLD) measured by iC FBRM will be influenced by particle size, solids concentration, number of 
modes, particle structure, and surface characteristics.  

With this in mind, iC FBRM technology developed two operating models that enable measurement of diverse 
particle systems. These Chord Selection Models (CSMs) are called Primary CSM and Macro CSM. Each offers 
specific advantages depending on the particle system under investigation.  
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Regardless of which CSM is selected, a precise and sensitive measurement is assured—however the accuracy 
of the Chord Length Distribution (CLD) can be improved dramatically by choosing the appropriate CSM. Care 
should be taken not to directly compare Primary and Macro data from the same experiment or set of 
experiments because any differences will be due to a difference in the measurement, not the process itself. 
PVM Viewer is the optimal tool for understanding which mode is the better choice for a given system since it 
provides a validating image and is also measuring in process. The result of using PVM negates the potential 
impact of poor sampling and preparation procedures. If there is any doubt about the appropriate CSM for a 
particle system, the user should contact their local TAC for more detailed support. 

Note: iC FBRM supports showing distributions from two CSMs, where applicable. See Multiple Chord 
Selection Models. 

Primary CSM 

The Primary Chord Selection Model (CSM) has a narrow fixed measurement zone that offers enhanced 
sensitivity to primary and discrete particles. This CSM is best suited for systems with limited surface structure 
and facets. 

Primary CSM has enhanced sensitivity to:  

• Particle Edges 

• Primary particles at high concentration  

• Nucleation 

• Opaque Particles 

• Fine crystals and small needles 
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Macro CSM 

The Macro Chord Selection Model has a wider fixed measurement zone that offers enhanced sensitivity to 
agglomerated and flocculated groupings of particles as well as discrete particles with significant facets and 
surface structure.  

Macro CSM has enhanced sensitivity to:  

• Droplets 

• Low concentration, dissolution 

• Faceted Crystals 

• Agglomerated crystals 

• Transparent crystals 

 

MULTIPLE CHORD SELECTION MODELS 

iC FBRM supports statistical trends and distributions from two Chord Selection Models (CSMs) 
simultaneously.   

The Data Treatments task pane includes a “Display distribution” check box that enables selection of both of 
the chord selection models for converting the raw signal collected by the probe into chord length data.  
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The following sections describe how multiple CSMs appear in the iC FBRM viewers. 

DISTRIBUTIONS VIEWER—MULTIPLE CSMS 

When distributions from two CSMs are available, the current measurement displays two distributions—one 
from each CSM. The Distributions Viewer shows two tabs and the Statistics Viewer shows two sets of values.  
The CSM type displays in the tab heading. The CSM selected in the Display Distribution drop-down list in the 
Data Treatments task pane display in the first tab as the default CSM.  

 

TRENDS VIEWER—MULTIPLE CSMS 

If the user selected the option to display both CSMs, for each statistic defined, two trends display in the 
Trends Viewer—each with a different CSM.     
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As a result, the number of trends displayed doubles in the Trends Viewer graph area, details panel, and 
legend panel. 

For each defined statistic, trends for the default CSM display first in the list, followed by the trends for the 
other available CSM.   

 

STATISTICS VIEWER—MULTIPLE CSMS 

If an experiment has the option to show distributions 
from two Chord Selection Models selected, each 
CSM displays as a separate table in the Statistics 
Viewer. The trend heading identifies the CSM.
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RESULT SETS—MULTIPLE CSMS 

When trends from an experiment that contains multiple CSMs are sent from the Trends Viewer to a Result 
Set, the trends from both CSMs are imported (see Sending Trends to a Result Set). Both CSMs display in the 
Result Set graph area, details panel, and legend panel.  

 

DISTRIBUTION LIBRARIES—MULTIPLE CSMS 

Since distributions from multiple CSMs display in separate tabs, only distributions from the selected tab 
export to a Distribution Library. If the distributions from both CSMs are required in a Distribution Library, 
each of the CSMs distributions must be copied individually.  
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Document Information Task Pane 

The Document Information task pane is an informational display that provides chronological and summary 
information about the currently displayed data document.  

The document information pane displays different information depending on the type of document 
(Experiment, Result List, or Measurement Library). 

The document information pane for an experiment includes the following information. 

 

Experiment 
Information 

Provides statistical information about the 
experiment. 

Date and time of start of the experiment 

Date and time of finish of the experiment 

Samples Acquired 

Instrument 
Information 

Describes the hardware configuration of the 
instrument. 

File 
Information 

The Filename for the experiment document. 

(test1.icFbrm) (example) 

Folder: The folder where the file resides. 

(U:\\Experiments) (example) 

Created: Date, time, author, file name and build 
number.  

Last Updated: Date, time, author, file name and build number 
for last update.  

Additional 
Information 

Miscellaneous information about the 
experiment. 
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User-Defined Trends Task Pane 

The User-defined Trends task pane is where you can create new trends by performing math functions on 
selected trends to show information that might not otherwise be apparent. User-defined trends appear in 
the Trend and Statistic viewers. The User-defined Trends task pane for an Experiment includes a list of any 
user-defined trends that have been defined for the experiment and includes buttons to create and edit 
trends. 

 
 

 

Existing User-
defined Trends 

A list of trends created by the user. 

When you click the New or Edit button, the task pane expands 
to include additional fields available for defining the trend. 
Refer to User-Defined Trends and Creating a User-Defined 
Trend for more information. 
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Serial I/O Configuration Task Pane 

The Serial I/O task pane is only available during a live experiment. Use the task pane to assign input and 
output specifications for the serial I/O. The serial I/O communicates with external devices that support the 
Serial Data Exchange (SDE) protocol.  

Use the Serial I/O task pane to: 

• Read and write specified trends to and from other external programs using the serial data exchange 
protocol. 

• Read specified trends using the serial data exchange protocol. 

• Choose the COM port or source for inputs. 

• Select from the available inputs in the trend list including label names.  

• Define up to eight (8) outputs. 

Define the following parameters to configure the I/O: 

• COM port or destination selection for outputs 

• Statistical trends from the list of active trends you want to output 

• Label that identifies the outputs 

• Trend value range and mapped range must be available 

The Serial I/O task pane contains the following fields: 

 

Input If inputs are configured, select the communications 
(COM) port for the FBRM input from the drop-down list. 
Click the Connect button to establish communications 
with the device. 

Output Select the communications (COM) port for the FBRM 
output from the selection list. Click the Connect button 
to establish communications with the device. 

Output (Label 
column) 

The Label column provides a list of labels (aliases) for 
the outputs. To assign the labels, use the Output 
Settings fields. 

Output 
Settings 

Select the trend and a corresponding label field to 
assign a serial output label to the trend. 

Trend Scaling If the trend values for this output are to be scaled, check 
this box. 

Min/Max Default values reflect the scaling that will be applied to 
each label (Channel Grouping for the selected statistic). 
Default values reflect the settings as they were originally 
set up. You can change to a different min/max range of 
values for a particular statistic. 
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PVM Task Pane 

Use the PVM task pane to load and adjust the viewing properties of the displayed PVM image. Auto Adjust 
options only apply to sequence files loaded from PVM V819 instruments. 

 

 

 

 

Image 
source 

This section defines the PVM image source and settings. 

 iC PVM export folder—Select this option to load images 
from the folder designated in iC PVM export. When set 
up in iC PVM 7.0 (SP1 or later) images will be 
automatically exported in .png or .jpg format to the 
specified folder. 

file prefix—Default prefix from iC PVM is IMG_. If the 
prefix is changed in iC PVM, you must change it here. 

Sequence file (completed experiment only)—Select this 
option to load images in .seq format. 

 Load  Click button to locate and load images to 
the iC FBRM PVM Viewer from the Image 
Source. Enter a prefix for the .png images, 
if desired. 

 Unload Click to remove the currently loaded 
images. 

 Timestamp 
offset 

If the PC time or time zone of the Image 
Source file differs from the iC FBRM PC 
time, enter an offset amount of time in 
hours: minutes: seconds. 

Auto 
Adjust 

(applies to PVM V819 only)  

Auto Adjust is checked, by default. Uncheck to manually 
fine-tune the following settings using the slider bars:  

 Brightness—Manually adjust the brightness of the PVM 
image. 

 Contrast—Manually adjust the contrast of the PVM 
image. 

 Threshold—Manually adjust the threshold for the PVM 
image. Threshold helps you filter out images that are 
blank or have very little content. 

 Gamma—Manually adjust the gamma of the PVM image. 
Gamma deals with lighting adjustment to account for the 
differences between the camera and the human eye. 

 Sharpen—Manually adjust the sharpness of the image. 

 Restore—When clicked, restores image to its original 
view. This button ‘undoes’ any adjustments made. 

See information on the PVM Viewer.   
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Process Task Pane 

If iC Process for FBRM™ software controls a process instruments (ParticleTrack G600, E25) you can connect to 
the instrument through the server and view real-time or post-processing data for advanced analysis. The 
Process task pane in the iC FBRM toolbox enables the following:  

• Instrument Connection for Live Monitoring 
• Reporting Functions 
• Batch Importing of Data 

Use the Process task pane to manage connections with the iC Process for FBRM server and associated 
instruments. The task pane is also used to check instrument status, view real-time or batch processing data, 
import specific data, or import one or more trend files into a Result Set. 

  
 

 

Server 
Name 

Network name (URL/Machine ID or IP Address) of the 
computer where the iC Process for FBRM server is running. If 
iC Process for FBRM and iC Process are on the same 
computer, the server name is the PC name or ‘localhost.’ 

Connect Click Connect to connect to the specified iC Process for FBRM 
server.  The server must be running iC Process, meaning the 
iC Process Service is started. 

Instrument Choose a specific ParticleTrack G600 or E25 instrument from 
the drop-down list for which data will be viewed or analyzed. 
When a connection is established with the server, the 
instrument field will display list of available instruments. The 
instrument does not have to be online in order to connect to 
it. 

Status The current status of the instrument: Stopped, Paused, 
Service or Online (Batch Status: Running or Paused; Current 
Batch name. 

View Click View to display the current real-time batch or 
continuous run processing on the instrument. When clicked, 
a new experiment is created in iC FBRM and populated with 
the live data from the iC Process for FBRM run. View is only 
enabled for online instruments. 

Import: 
Batch or 
Time  

Instrument can be run in either continuous or batch mode.  

• If the instrument is running in batch mode, select Batch. 

• If the instrument is running in continuous mode, select 
Time. Import fields vary depending on which mode you 
select. 

Start Date/ 
Start Time 

When you select the Time Import mode, archived continuous 
run data imports to an iC FBRM experiment.  

Start Date:  Select from a drop-down list of available runs.  

Start Time:  Select from a drop-down list, can be any time 
within the continuous run.  

Duration Select number of hours of data to import from the Start 
Time forward, up to a maximum of 24 hours. This is the 
duration of the experiment data to import and not 
necessarily the actual duration of the run.  
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Trends 
Only 

• If checked, the import only includes trend data.  

• If left unchecked, diagnostic value trend data and Process 
variable trend data from the run are added to the Result 
Set. 

Import 
Trends 

 

Import trends from multiple *.icFBRM experiment files 
generated by iC Process for FBRM into a single iC FBRM 
Result Set. This is a two-phase process: 

I. Import iC Process Data by Batch or Time as described 
above and save the experiments on your local hard drive. 

II. Import batch trends from saved experiments. 

a) Click Import Trends on the Process task pane (“Import 
from file” section). 

b) Select the files containing the desired trends. 

c) Click Open to import the trends into a new Result 
Set.  

DISPLAYING LIVE IC PROCESS FOR FBRM DATA IN AN EXPERIMENT 

Live data from a running iC Process for FBRM batch can be viewed in an experiment. If a batch is active, the 
experiment loads the batch and updates it continuously as new measurements are recorded. If a batch is not 
active, the experiment will start displaying live data from the instrument as samples are acquired. 

A connection with the iC Process for FBRM server and an instrument must first be established to view live 
data. To connect to the iC Process for FBRM server, enter the name of the iC Process for FBRM server 
(localhost) in the iC Process for FBRM task pane and click Connect. 

 

Once a connection with the iC Process for FBRM server is established, the instrument name appears in the 
Instruments field and its status appears on the task pane. 

 

Click View to display live data from the instrument. Note that an instrument does not have to be to select it 
but the View button is only enabled for online instruments. When the button is clicked, a new iC FBRM 
experiment is created and populated with the live data from the instrument. The name of the experiment is 
based on the template and the date/time the run was started. 

While connected to the iC Process for FBRM server, all iC experiment analysis functions are available. 
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• Data treatments 
• Statistics definitions 
• User-defined trends 
• And so on… 

VIEWING ARCHIVAL DATA FROM IC PROCESS FOR FBRM 

Archival data from an iC Process for FBRM batch can be viewed in an iC experiment. In order to view an 
archived batch, a connection must be opened between the iC application and the iC Process for FBRM server 
as previously described. The instrument does not have to be online to import a batch.  

Continuous Data: 

To import archived continuous data, select the start date of the run from the Start Date drop-down list. The 
list shows all available archived runs. 

 

Next select a start time for the data import. Data will be imported starting at this time stamp in the run and 
continue for the specified duration. 
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 Finally select the duration for the experiment. 

 

Trends Only—If left unchecked, the diagnostic value trend data and the process variable trend data from the 
run are added to the Result Set. Check the box to import only trends to a Result Set.   

Batch Data: 

To import batch data, select the Batch button. Then choose the batch name to import from the drop-down 
list. 

 

Trends Only—If left unchecked, the diagnostic value trend data and the process variable trend data from the 
run are added to the Result Set. Check the box to import only trends to a Result Set. 

Click Import to bring the data into a new experiment. A progress window appears during the import 
operation. 
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A new experiment containing the imported data opens. The experiment name is based on the batch ID. 

 

IMPORTING IC PROCESS FOR FBRM TRENDS INTO A RESULT SET 

Trends from one or more experiments containing iC Process for FBRM trends can be imported into a Result 
Set. To import batch trends, click the Import Trends button on the iC Process for FBRM task pane. 
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A standard File Open window appears. 

 

 Select the files containing the desired trends. Use the Shift and Control keys to select multiple experiments. 
Click the Open button to import the trends into a new Result Set. Trends with the same name will be stitched 
together across the time spans of all the selected files. 
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Interaction with Other iC Applications 

iC FBRM has the ability to interact with other applications in the iC software family. Data can be shared 
between iC and iControl applications. The three common situations are: 

• iC and iControl applications are on the same PC 

• iC and iControl applications are on different PCs on the same network 

• iC and iControl applications are on different PCs connected via an Ethernet cross-over cable 

 iC applications can be running on the same PC or connected through a network using TCP/IP. The degree of 
interaction available depends on the actual iC applications involved. The sections that follow describe the 
features associated with iC FBRM.  

Connections to other iC applications are controlled using the Connect to other iC/iControl Applications 
dialog accessed from the Tools menu. 

THE CONNECT TO OTHER IC/ICONTROL APPLICATIONS DIALOG 

Below are the steps to get iC/iControl applications to connect. 

1. Start the iC or iControl application on each PC. 

2. To establish a link, iC 4.x versions of software must broadcast their existence. 

For iC applications—Go to the main Tools menu and select Connect to other iC/iControl Applications…  

 

a) Click the Find Application button on each PC, if applicable, to begin a network scan for all 
applications. Repeat for all applications to be connected. 

 

b) Once the initial scan is performed, the Application Type list displays all iC /iControl applications 
currently running the user next clicks the Find Applications process on the network. On each PC, the 
corresponding applications should appear on the list and the Status column should show 
Connected. 
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Note: If an application connection cannot be made, the Application Type column entry is 
“Unknown.” Please refer to iC FBRM Install Guide for Administrators for information on 
‘Configuring the Windows Firewall.”  

There is no need to rescan all the networked PCs in the future unless a new iC application or PC 
running iC applications is added to the network. In this case, a scan must be run on all PCs to 
update the “phone book” file. 

Once communications between the iC applications has be established, trend data for all the 
applications appear in the Add Trends dialog box for a Result Set. 

 

For iControl—Refer to the iC FBRM 4.4 Install Guide for Administrators for instructions on how to 
configure iControl to connect to iC FBRM. 

Defining a New Connection 

A new application can be manually defined by clicking the New button on the Connect to other iC/iControl 
Applications dialog box. The New iC/iControl Applications dialog box opens. 
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Enter the network name for the PC and the port number that the application uses. When you click OK, the 
system verifies the connection to the application. If a connection cannot be made to the application, an error 
appears on the Connect to other iC/iControl Applications dialog box. 

Editing iC/iControl Application Info 

The user can edit the port number for an application connection by clicking the Edit button on the Connect 
to other iC/iControl Applications dialog. The Edit iC/iControl Application Info dialog is opened. The dialog 
contains information about the application and has one editable field, TCP Port. Normally the TCP Port is 
auto-detected when the system scans for applications. If a port needs to be changed for some reason, the 
new port number can be edited here. When the OK button is clicked, the TCP Port is verified by the system. 

 

CONTROLLING IC FBRM FROM AN ICONTROL EXPERIMENT 

The application link to iC FBRM allows you to synchronously start, control and stop your iC experiments from 
within the iControl experiment and it allows you to monitor live profile trends. 

Both iC FBRM and iControl must be started from their respective computers. 

Note: If the application is on a networked computer, then you have to ensure that the network firewalls 
allow iControl and iC to communicate with each other.  

Refer to the iControl documentation for detailed information about controlling an iC FBRM experiment with 
iControl. Note that when an experiment is started from iControl, all samples taken while the experiment is in 
the initial paused state are automatically discarded. 

SHARING TREND DATA WITH OTHER IC/ICONTROL APPLICATIONS 

iC applications and iControl have the ability to share trend data with other applications in the iC software 
family. If the iC applications are running on the same PC, trend data from all open experiments in all running 
iC applications will automatically appear in the Result List and Trends Viewer Add Trends dialog for all the iC 
applications. This feature is useful for comparing trend data from various types of instrumentation. It should 
be understood that care must be taken when comparing trends from different types of instrumentation. 



 

Page 177  

 

If an iC FBRM experiment is started from within an iControl experiment, the iControl experiment’s trends 
imported into the iC FBRM experiment are grouped together with the iC FBRM trends for purposes of 
reference time shifting. This applies to trends imported into a Result Set or trend. 

The iC FBRM trends and iControl reference trends are all grouped together while time shifting.  

It is important to note that this grouping only happens when the user started the iC FBRM experiment from 
within iControl AND the user brings the iControl trend into iC Experiment DURING the run (live data). If trend 
data is added after the run is complete, the grouping will not occur. 
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iC Data Center™  

iC Data Center is a central storage tool with a dashboard for your completed iC™ and iControl™ experiment 
files. When you purchase, install, and configure the optional iC Data Center software, each iC IR™, iC FBRM™, or 
iControl instrument can ‘turn on’ the data center. After an iC or iControl instrument is configured for iC Data 
Center, all completed experiments automatically move to a configured central location and optional email 
notification goes to a specified user. iC Data Center not only stores the experiments files, but can also prepare 
Microsoft® Word® or Microsoft® Excel® files from the experiment files. 

Configuring iC Data Center 

Configuration is required in iC Data Center and also in the iC or iControl software. Before configuring a 
connection within iC IR, iC FBRM, or iControl, complete the prerequisite setup in iC Data Center. 

Prerequisites: 

• iC Data Center Server must be running. 

• The iC Data Center Target Experiment Location/Shared Folder must be set up as ‘shared’ through 
the Microsoft operating system. The iC Data Center Server must have write permissions to the 
location. 

• Other optional configuration settings: 

- Experiment Name pattern 

- Project Name field and pattern 

- User Name field and Domain Name 

- Email enabled (If enabled, Domain Name and SMTP server are required.) 

- Configuration on how incoming experiments shall be organized and named based on 
experiment metadata such as Project, User, date/time, etc. 

Please follow the instructions in iC Data Center to configure the above options for iC or iControl.   

After iC Data Center server configuration is complete, do the final setup within iC FBRM, iC IR, or iControl. 
Follow the steps below to configure a connection to the iC Data Center server.   

1. Select Tools > Configure iC Data Center. 
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2. Click ‘Use iC Data Center.’  

 

3. Enter the computer name or IP address of the iC Data Center server. 

 

4. Click Test Connection. 

 

After confirming the connection to iC Data Center, completed experiments will automatically go to the 
designated iC Data Center shared folder. An ‘Uploading Experiment’ tab communicates the upload and 
displays a completion message. If applicable, a warning message appears. The new location will be updated 
in the recent files links on the iC Start Page. When you start an experiment, the Folder path for storing the 
experiment no longer appears. Refer to the Start Experiment Wizard.  
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Start Experiment Wizard (iC DC) 

After iC Data Center™ configuration is complete (Tools > Configure iC Data Center), the first page of the 
wizard appears. The Experiment File section displays the Experiment naming convention defined in the iC 
Data Center Configuration. Notice the Folder location does not appear because the file storage location is 
automatically the designated iC Data Center shared folder. 

 

Use the first New Experiment wizard page (Experiment Name) to define the name and location of the 
experiment document. The page also displays the current instrument configuration and includes a Configure 
Instrument button, if instrument configuration tasks exist.  

In many cases, you can simply click Next to use the default settings and go to the next wizard page. The 
steps below go through each section of the page for your reference. 

1. Most new experiments start as a new file. However, you have the option to append a new experiment to 
an existing file if necessary. 

2. Experiment File—Template: To start the experiment based on a previous experiment, browse to the 
location of the template file. 

Instrument Information 

To change your instrument settings before recording an experiment, click Configure Instrument on the Start 
Page or from this window.  

It is important to note that if a multi-probe configuration is connected to the control computer, both probes 
must be configured before running an experiment. If an attempt is made to start an experiment without first 
configuring both probes, an error message appears and identifies the probe that needs configuration. 
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Troubleshooting Notes 

iC FBRM reports errors and messages to keep you informed of system information. This topic also includes 
common troubleshooting tips. 

ERROR MESSAGES 

The iC software has extensive error handling capabilities. These capabilities range from verifying correct 
program execution and hardware functionality to the validity of variables entered by the user for data 
manipulation. The content of error and warning messages provides valuable information for AutoChem 
personnel when diagnosing problems. 

Instrument-type errors turn the Live Experiment toolbar red and display the error as a tooltip on the toolbar. In 
addition, the errors are logged in the Events Viewer and in the iC Log Manager logs. Instrument type errors 
consist of actual failures with the hardware and communication errors between the iC software and the 
instrument. Communication errors include failures with the PC communications port and cabling issues. 
Many times the tooltip will provide hints for resolving the problem.  

 

System type errors generate an error dialog as shown below. 

 

Normally the user should try and continue. If the error dialog continues to pop up, the user should quit. 
Clicking the Quit button closes the iC application. The user can then restart the iC application and try and 
continue operation. 

General error and warning messages display in the status bar at the bottom of the main window. 

 

These errors are also recorded in the Events Viewer and in the iC Log Manager logs. 

 

The section, The Customer Care Log File Utility describes how to send Log Manager reports to AutoChem. 
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INSTRUMENT ERROR 

If communication with the FBRM Service 4.4 is lost, an error dialog appears. 

 

The iC FBRM software will attempt to re-establish communications with the server either automatically or 
manually as specified in the dialog. The dialog will display a message when attempting to reconnect. 

 

If the iC FBRM successfully connects to the server, a success message is displayed and the dialog closes. The 
experiment continues to run. 

Note: If the server stops responding during the execution of an experiment, it can be restarted manually. 
iC FBRM shall attempt to reconnect to the FBRM Service 4.4 and resume the experiment. If the 
reconnection failed and a new experiment cannot be resumed, the user can start a new experiment 
and append to the previous experiment. If a new experiment cannot be started on a probe because 
the probe is claimed to be used by the failed experiment, user can run the configure instrument 
wizard to reclaim a probe from the failed experiment.. 

If iC FBRM cannot communicate with the FBRM Service 4.4, first verify the following: 

1. Verify that the FBRM Service 4.4 is running by checking the Services tool located in the Windows Control 
Panel/Administrative Tools menu. 
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2. Verify that the communications cable is properly connecting the FBRM Service 4.4 PC and the computer 
running iC FBRM. 

3. Turn off power to the PC running the FBRM Service 4.4. Wait 15 seconds. Turn power back on. 

a. Wait another minute allowing iC FBRM to retry establishing communications. 

b. If communications are still not re-established, do the following: 

4. Exit iC FBRM. 

a. Turn off power to the hardware. Wait 15 seconds. Turn power back on. 

b. Restart iC FBRM. 

If the problem persists, contact customer service (use the Contact information on the iC FBRM Start Page). 
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MISCELLANEOUS WORKAROUNDS 

Problem: I linked to a template for another experiment and every time I click Next I get a warning 
informing that a “More Recent Backup Exists”.  

Workaround This error occurs when there is a backup version of the template file available with a more 
recent modified date than the specified file. Try opening the template from the File Open 
option. You will probably get this same message the first time. Click Yes to open the 
backup file. Then click Save. The software will automatically save to the original path (not 
the backup path). From that point on, you won't see this message again. 

Problem: Communication errors occur when the earlier Version 6 FBRM software is open and iC 
FBRM is also trying to communicate to the probe. 

Workaround: Close the Version 6 FBRM software, only one FBRM application can be run at a time.  

DATA ACQUISITION ERRORS 

When a data acquisition or experiment error condition is detected, the system does not save the distribution 
data since these values are considered invalid. No statistics (trends) are calculated for the invalid distribution 
data. However, hardware diagnostics values are collected. 

In the example below, an error occurred around time 03:55. Entries were inserted into the event log 
indicating that the scan speed was low. No distributions were saved and trend value is flat. When there is no 
distribution data available, no trends are calculated for the measurement. Diagnostics values from the 
hardware system were saved—for the probe air pressure and scan frequency. These values provide 
important troubleshooting data when diagnosing the cause of the error.   
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POSSIBLE DATA LOSS  DURING AN APPLICATION FAILURE 

If the iC FBRM client application becomes inoperable or loses communications with the FBRM server for an 
extended period of time, possible loss in the data can occur. While the iC FBRM client is inoperable, the 
FBRM server continues to collect data and stores the data in its buffer. The data buffer can hold up to 600 
measurements. When the data buffer is full, the oldest measurement is discarded to make space for the 
newest ones.  

• If the iC FBRM client restores its communication to the FBRM server before the server’s data buffer is full, 
all the measurements will be drawn from the buffer and sent to the iC FBRM client so no data is lost.  

• If the iC FBRM client is inoperable longer than the time period equal to 600 times the sample interval, 
the data buffer in the server gets filled up. Old measurements are discarded to make space for new 
measurements. When iC FBRM client resumes the communication to the FBRM server again (this needs 
to be earlier than the original experiment end time), the latest 600 measurements are drawn from the 
buffer and added to the experiment. No data will be available for the time period between when the 
client application failed and the measurements acquired in excess of the 600.  Below is an example. 

 

To avoid data loss, the user should attempt to restore the connection between the iC FBRM client and the 
FBRM server as soon as possible. 

Depending on when the crash occurred in relation to the autosave function of the client (every 5 minutes), 
there may be more distributions than sample acquired messages in the Events Viewer. 

When the iC FBRM client is restarted, a message dialog is displayed indicating that an error occurred with 
the experiment. 

 

When the OK button is clicked, the experiment data is loaded from the server and  the user is given the 
option of continuing the experiment or ending it. 
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G400/G600/E25 INSTRUMENT FAILS TO RECONNECT  AFTER A POWER 
FAILURE 

In certain circumstances, the FBRM Server may not recognize a ParticleTrack instrument after restarting from 
a power failure. If this occurs, the FBRM server will fail to restart. To correct the problem, perform the 
following steps. 

• Disconnect the USB and power cable. 

• Close all applications and shutdown the PC. 

• Reconnected the USB and power cable. 

• Restart the PC. 

• Restart the iC FBRM application. 

CHANGING TIME ZONES AND REGIONAL SETTINGS 

Changes to the time zone/regional settings should be avoided during the execution of an experiment. 

If changes are made to the time zone or other regional settings, the FBRM server must be restarted for the 
changes to take effect.  

To restart the FBRM server: 

1. Exit the iC FBRM application. 

2. Stop the FBRM Server. 

3. From the Windows Control Panel, open the Administrative Tools.  

4. Select the Services option. 
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5. Select FBRM Service 4.4 from the list of services and click the Restart option. 

 

EXPERIMENT  STOPS RUNNING (IC FBRM/ IC PROCESS FOR FBRM 
CONFIGURATIONS ONLY) 
If there is an iC FBRM experiment running, when a iC Process for FBRM run is started, it will stop the iC FBRM 
experiment. iC Process will take control of the FBRM Server.  

There will be a warning displayed in the Events Viewer informing the user "The experiment was stopped on 
the server. This is most likely because iC Process for FBRM took control." This behavior is by design. 

IC FBRM SERVER FAILS TO START 

Older versions of the National Instrument (NI) driver that was shipped with version 4.2 of the iC FBRM 
software is incompatible with iC FBRM 4.3 and later. If this driver is installed on the PC, the FBRM Server will 
not start. The 4.3 and later versions of iC FBRM and iC process for FBRM automatically check for the 
presence of this outdated driver and display a warning dialog box as required. The NI drivers must be 
manually uninstalled using the Control Panel. 

IC FBRM SERVER LOSES COMMUNICATIONS WITH THE INSTRUMENT 

On some PCs it might be possible for the system to put USB communications into the Sleep Mode during 
long experiments. This is the Windows default setting, and it could result in communication errors with the 
instrument.  

On the PC that will be controlling an instrument, you must adjust the power settings to ensure the computer 
will never go into sleep mode. 

1. Search ‘Power Options,’ and select ‘High Performance.’ 

2. Select Change plan settings link.  
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3. Set ‘Put the computer to sleep’ to Never. 

4. Select Change advanced power settings link and set as follows: 

• Sleep → Sleep after = Never 

• Sleep → Hibernate after = Never 

• USB Settings → USB selective suspend setting = ‘Disabled’ 

• For laptop computers: Power button and lid options → Lid Close Action = ‘Do nothing’  

5. Click OK and Save changes. 
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iC Licensing 

iC applications incorporate a licensing scheme to control distribution and use of the software. 

There are different types of licenses. 

• Instrument version—Enables the software application to connect to a live instrument and run 
experiments. 

• Office version—Enables the user to run the software application without a connection to an instrument. 
Experiment data obtained from a computer with an Instrument license can be viewed and analyzed. 

• Trial version—A trial version is equivalent to an Instrument license with a 30-day time limit. 

• Module licenses—Add-on modules, licensed separately. For example, additional Chord Selection Model 
(CSM) licenses may become available. 

• iCare subscription—A special annual subscription license that entitles you to all release upgrades and 
service packs for Instrument and Office versions of iC and iControl software as well as priority telephone 
and email support. 

• Site license—Specific companies with large software agreements with METTLER TOLEDO may also have 
a Site License for one or more products. 

Use the iC License manager to view and manage iC licenses.  Acquire the Machine ID from the License 
Manager window and use the software key provided with the software. Then, activate a software license 
through the AutoChem Customer Care website.  

 

Detailed instructions on activating a license are contained in the Installation Guide portion of the 
Documentation Portfolio. 

Note: If the user activates a CSM license from iC FBRM, the new CSM option will not be displayed in the iC 
Process for FBRM client until the iC Process server and iC Process for FBRM client is restarted.   
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Appendix A: Data Processing in the iC FBRM Software 

Data processing in iC FBRM involves special terminology and statistical formulae described in this section. 

The following terminology provides a brief chronological outline of the steps in FBRM measurement prior to 
data processing using iC FBRM software: 

Chord Length—A straight line between any two points on the edge of a particle. 

Optical Chord Length—Optical effects of the particle system (e.g., refractive index of the solution and particle, 
backscatter properties of the particle at the observed wave length, etc.) will influence the optically measured 
chord length. The optical chord length is a straight line between any two points on the edge of a particle as 
measured by the FBRM optical system. 

Count—A term used to describe the measure of a single chord. Each count represents a single chord of a 
given chord length in microns. 

Channel—A bin with a specific upper and lower limit in microns. Counts with a chord length between specific 
limits are put in a specific channel. 

Primary Chord Length Distribution—This distribution is comprised of 1324 channels covering the range from 0 
to n • 1024 µm on a linear scale where n = 1, 2, 3, 4 for a scan speed of n • 2m / s. The FBRM hardware 
measures each optical chord length individually then stores the counts of equivalent chord lengths in the 
appropriate channel. The result is a count by chord length distribution called a primary chord length 
distribution. This is displayed as a number by micron distribution (number of counts by chord length in 
microns). 

Measurement (or Record)—iC FBRM accumulates counts in a primary chord length distribution for an amount 
of time specified by the user. Once this time span is completed, the measurement is completed and the 
primary chord length distribution is passed from the FBRM hardware to the iC FBRM software. At this point, 
the FBRM hardware will start the next measurement. Once a measurement is saved to a file, it is referred to 
as a record. The record includes all measured data, as well as all instrument configuration information 
relating to this measurement. 

Moments—A finite summation of discrete points. 

PRIMARY CHORD LENGTH DISTRIBUTION 

The FBRM hardware provides 1324 primary channels of data from 0 to n • 1024 µm on a linear scale, where n 
= 1,2, 3, 4 for scanning speeds n • 2m / s. The scale is broken into two ranges, [0,  n • 100] µm and  [n • 100, 
n • 1024] µm. The bottom 400 channels in the  [0,  n • 100] µm range provide finer, n • 1/4 resolution, 
whereas the upper 924 channels provide a coarser, n • 1 µm resolution, but cover a wider micron range  [n • 
100, n • 1024] µm. 

The following Primary Chord Length Distribution table outlines these properties: 

Range [µm] [0,  n • 100] [n • 100, n • 1024] 

Channel width [µm] n • 1/4  n 

Number of channels 400 924 
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CONVERTING COUNTS TO COUNTS PER SECOND 

In iC FBRM 4.2 and later, counts are reported as counts per 2m scan length. (Previous versions of the 
software reported counts/second.) This change in standard reporting was made due to the introduction of 
FBRM systems that can scan at higher and lower scan speeds. By definition, changing the scan speed will 
change the number of particles measured per second (that is, doubling the scan speed from 2 m/s to 4 m/s 
should double the number of chords counted per second). To permit direct comparison between results 
collected at different scan speeds, the counts are now reported as counts per 2m scan length. A 2m 
reference distance is used to provide exactly the same results when using the traditional scan speed of 2 m/s, 
and it allows direct comparison of results measured at alternative scan speeds. 

CHANNEL GROUPING 

Channel grouping gives the user the ability to group the primary chord length distribution of 1324 channels 
into a channel grouping more appropriate to the application under investigation. Channel grouping is 
characterized by four parameters: A, B, N, and the Channel Progression (linear or logarithmic). 

Examples for channel groupings are as follows: 

Channel Grouping A B N Channel Progression 

1-1000 µm 90 Log Ch. 1 1000 90 Logarithmic 

0-500 µm 100 Linear Ch. 0 500 100 Linear 

0-30 µm 120 Linear Ch. 0 30 120 Linear 

N denotes the number of channels that divides the interval [A, B], where A is the left boundary of the lowest 
channel (in µm) and B is the right boundary of the highest channel (in µm). The channel progression is either 
linear or logarithmic.  

In the following discussion, the index i = 1, …, N indexes the first, second, …, Nth channel and its left channel 
boundary. Because the right channel boundary of channel i is always identical to the left channel boundary 
of channel i+1, there is a total of N+1 channel boundaries with: 

ci = left channel boundary for channels i = 1, …, N 

ci+1 = right channel boundary for channels i = 1, …, N 

Linear Progression 

The interval [A, B] is divided into N channels of equal difference d between the left and right channel 
boundary: 

 

(1) 

The channel boundaries are calculated as follows: 

  

(2) 

for 

d B( A ) 1
N
----⋅–=

ci A d i 1–( )⋅+=
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The channel midpoint of channel i is defined as the point that divides the channel via equal differences: 

 

(3) 

Solving Eq.(6) for Mi yields: 

 

(4) 

Logarithmic Progression 

The interval [A,B] is divided into N channels of equal ratio r between the left and right channel boundary with: 

 

(5) 

Noteworthy here is the similarity to Eq. (4) except that all variables with chord-length dimension are now 
operated on by the logarithm and d has been renamed r. Eq. (8) holds regardless of the base of the 
logarithm used (base 10, e, or other). Solving for r yields: 

 (6) 

Modifying Eq. (5) by replacing chord-length variables with their logarithm and renaming d to r, the channel 
boundaries are calculated as follows: 

 

(7) 

Solving Eq. (10) for ci yields: 

 

(8) 

for 

 

Using this formula, it is indeed easy to verify that the ratio between the right and left channel boundary is 
constant: 

i 1 2 … N 1+, , ,=

ci 1+ Mi Mi ci–=–

Mi
ci 1+ ci+

2
-------------------------=

rlog Blog Alog–( ) 1
N
----⋅=

r B
A
--- 

 

1
N
----

=

cilog Alog rlog i 1–( )⋅+=

ci A ri 1–⋅=

i 1 2 … N 1+, , ,=
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(9) 

The channel midpoint of channel i is defined as the point that divides the channel via equal ratios. It can be 
derived from Eq.(6), by considering that - on a logarithmic scale - the midpoint should again divide the 
channel via equal differences: 

 

(10) 

Applying the exponential function to both sides yields: 

 

(11) 

Solving for Mi we get:  

(12) 

 

(13) 

Especially for logarithmic progression, the channel boundaries ci do not necessarily coincide with a primary 
channel boundary. In this case, a primary channel can contribute to more than one channel in proportion to 
its overlap with either grouped channel. 

In the following sections, the grouped channel counts are denoted as ni, with I = 1, 2, …, N. A detailed 
description of the regrouping algorithm is given in the section Example near the end of this appendix. 

Channel Weights 

Channel weighting emphasizes the change in one region of the distribution while de-emphasizing the 
change in another region of the distribution by applying a channel-specific weight wi to counts ni. The 
weighted channels yi are obtained via: 

 

(14) 

For channels 

 

The weights wi are obtained from the channel midpoints Mi via: 

ci 1+
ci

-------------- A r i 1+( ) 1–
⋅

A ri 1–
⋅

------------------------------------ ri

ri 1–
------------- r= = =

ci 1+log Milog Milog cilog–=–

ci 1+
Mi

--------------
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ci
------=

Mi ci ci 1+⋅=

yi wi ni⋅=

yi wi ni⋅=
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(15) 

The upcoming table shows how the different types of channel weight procedures can be calculated by 
varying γ.  

Calculating Channel Weight Procedures 

Method γ 

1/Length Weight -1 

No Weighting 0 

Length Weight 1 

Square Weight 2 

Cube Weight 3 

Using M0
i ≡1 it is easy to verify that for γ = 0, wi = 1 is obtained for i = 1, 2, …, N. 

The rationale for the summation term in the denominator and the multiplication by N is the following: 

If we were to use raw weights ωi = M
ϒ
i  the weights would become very large for square and cube weights, 

which in turn would make the counts per channel and derived quantities (e.g., total counts) very large. For 
this reason, we have scaled the weights (not the counts) so the sum over the weights remains the same as if 
no weighting was chosen. That sum has to be N since each weight for 'No Weighting' has to be 1. The 
operation is equivalent to normalizing raw weights ωi by their average. 

 

with 

 

and their raw weights 

 

(16) 

The result is a much better behaved weighting function. 

wi

M
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∑
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Relative Counts 

For display purposes, the user has the option to convert the weighted counts per channel yi to relative 
counts ri, which indicates the counts as a percentage of the total counts: 

  

(17) 

LIMITED CHANNEL RANGE (ISOLATION OF A POPULATION OF 
INTEREST) 

When the statistics are calculated, each statistic can be calculated from a limited channel range chosen from 
the current channel grouping. In other words, each statistic can have its own sub range of channels out of 
the N total channels. A sub range is specified by channel indices a and b, with a denoting the index of the 
first channel and b the index of the last channel of the sub range. Channel indices i, a, and b are limited via: 

1 ≤ a ≤ I ≤ b ≤ N 

(18) 

The user does not enter the channel range by the respective channel indices a and b, but rather in terms of 
their channel boundaries ca and cb (in µm units). Therefore, it can happen that the user-specified channel 
boundaries do not coincide with any actual channel boundary ci (e.g., when the channel grouping is changed 
or when the user does not have the exact channel boundary available). In these cases, the user-specified 
lower boundary is corrected towards the closest boundary ci that is smaller than the specified value. Likewise, 
the user-specified upper boundary is corrected towards the closest boundary ci that is larger than the 
specified value. Any user-specified channel boundary that lies outside the maximum allowed range [c1,cN+1] 
is corrected towards the nearest of either c1 or cN+1. After these corrective steps, the user-specified channel 
sub range lines up with existing channel boundaries ca and cb, and their corresponding indices are a and b. 
Choosing a channel sub range precedes statistics calculation. 

STATISTICS CALCULATION 

The statistics calculation is chosen individually for each trend and acts upon the channel range of weighted 
channels yi with midpoints Mi with i = a, a + 1, …, b - 1, b. The output of this operation is always a single 
number. The following subsections, which correspond with the statistic options available in the FBRM CI 
software, discuss each of the different statistics. 

Mean 

The mean chord length 
−  
C is obtained from counts per channel yi and midpoints Mi as follows. A proof of this 

formula is given in Eq. (27) and Eq. (28): 

ri
yi

yj
j 1=

N

∑

--------------- 100⋅=
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(19) 

It is legitimate to perform the sums only from i = a to i = b, because taking the channel sub range is 
equivalent to considering yi = 0 for i = 1, …, a - 1, b + 1, …, N. 

It can be shown (proof is given below) that the mean 
−  
C can be expressed directly in terms of the unweighted 

counts ni via 

  

(20) 

Where γ = -1, 0, 1, 2, 3 for 1/length weight; no weighting; and length, square, and cube weight. 

Proof: 

  

(21) 

Where 

 

= 

C

yiMi
i a=

b

∑

yi

i a=

b

∑

---------------------=

C

niMi
γ 1+

i a=

b

∑

niMi
γ

i a=

b

∑

-----------------------------------=

wi

M
γ

i

Mγ

jj 1=

N

∑

------------------ N Mγ

i
G⋅=⋅=

wi

M
γ

i

Mγ

jj 1=

N

∑

------------------ N Mγ

i
G⋅=⋅=



 

Page 197  

 

= 

 

 (22) 

Definitions 

• Unweighted Mean chord (No Weighting)—The sum of the unweighted counts per channel multiplied by the 
midpoint of that channel, divided by the sum of all unweighted counts. 

• Length Weight Mean Chord (Length Weight)—The sum of the length weighted counts per channel 
multiplied by the midpoint of that channel, divided by the sum of the length weighted counts. 

• Length Square Weight Mean Chord (Square Weight)—The sum of the length square weighted counts per 
channel multiplied by the midpoint of that channel, divided by the sum of the length square weighted 
counts. 

• Length Cube Weight Mean Chord (Cube Weight)—The sum of the cube weighted counts per channel 
multiplied by the midpoint of that channel, divided by the sum of the length cube weighted counts. 

Mode 

The mode is the midpoint of the channel with the highest counts. The first step is to find the channel index 

imax belonging to the channel with the highest count yi. 

imax= arg max yi 

 (23) 

Where the search is performed over channels a ≤ i ≤ b. The mode is the center point of the corresponding 
channel: 

Cmode = Mi min 

 (24) 
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Chi Square (ChiSquare) 

The Chi Square statistic χ2 provides a measure of similarity between two distributions based on the shape of 

the distributions. The more the measured distribution yi deviates from a reference distribution Ri, the larger 
χ2 becomes. 

BACKGROUND 

The Chi Square statistic originally applies to an experiment with a finite number N of possible outcomes, 
performed n times, where Y1, Y2, …, YN are the number of experiments that resulted in each possible 
outcome, with probabilities of each outcome p1, p2, …, pN. The definition is: 

;  

 (25) 

The observed results Yi will generally diverge form the expected results npi at least by chance or by a 
significant change in the experimental conditions. The probability Q that a certain value of χ2 is due to 
chance is expressed as a rather complicated integral solution involving the Gamma function, and therefore 
cannot be solved in close form. Values of Q are usually found tabulated for the number of degrees of 
freedom of the experiments (N - 1) and values of χ2. 

But even if the value of Q is not calculated, χ2 can provide a useful measure of the deviation of an 
experiment from an expected or reference result. Over a series of experiments it is possible to establish a 
typical value of χ2 which, if exceeded, indicates a change in the experimental conditions. 

APPLICATION TO CHORD-LENGTH DISTRIBUTIONS 

Equation (31) can also be applied to chord-length distributions. In Eq.(31) Yi can be interpreted as the 
measured number Yi at individual chords that fall into a range determined by channel i with channel 
midpoint Mi. We can interpret pi to be the probability of a chord to fall into channel i and n can be 
interpreted to be the total number of chords to be distributed across those channels. Then the term npi 
becomes the expected number of counts in channel i. If a reference distribution R is representative enough 
to serve as estimator of pi, we can use each of its channels Ri to represent npi. For a given sample distribution 
yi and a reference distribution Ri, χ2 is calculated as follows: 

  

(26) 

χ2 is thus a measure for the combined relative deviation of individual elements of the sample distribution 
from the reference distribution. We arrive at the reference distribution Ri by submitting the reference 
distribution to the same operations as the sample distribution yi. Eq.(32) also applies to a limited range of 
channels, in which case it becomes: 

χ2
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(27) 

If the sample distribution yi and the reference distribution Ri were taken with different measurement 
durations, the value of χ2 would thus become measurement-time dependent. This change in χ2 not only 
reflects the desired measure of variation in distribution shape, but also a difference in absolute number of 

counts. Therefore, a time-normalized χ̂2 is defined as: 

  

(28) 

 ;  

 (29) 

Where Tm is the measurement duration and Tm,R the measurement duration of the reference distribution. 

One problem arises if one or more of the elements   ^Ri of the reference distribution are zero.  ^χ2 is not 
defined in this case. Another problem can arise if   ^Ri > 0, but very close to zero (for example: 0.001). This 
could dramatically drive up the magnitude of  ^χ2, just based on a single channel. A possible modification of 
the Chi Square statistic could be to simply ignore those elements ^yi of the sample distribution for which   
^Ri  = 0 (or close to zero) and sum over the remaining relative deviations. However, by doing so, we are 
ignoring possibly important information contained in those channels i of the sample distribution ^yi for 
which the corresponding   ^Ri  is 0. 

To overcome this problem, we followed a different approach.  

Channels   ^Ri in the reference distribution that are below a threshold (the current implementation uses a 
threshold of ε = 1 to force any fractional counts to be combined with other channels) are combined with the 
nearest channel   ^Rj that satisfies j < i and   ^Rj  ≥ ε. If there is no such channel (as would be the case if one 
or more of the left-most channels fall below the threshold), they are combined with the nearest channel  ^Rj   

that satisfies j > i and   ^Rj ≥ ε. One all channels that need to be combined to form a new distribution R′ are 
identified, a new sample distribution yj′ is constructed by combining those same channels in the sample 
distribution ^yi. 

The following table illustrates this for ε = 1 and a channel sub range from channels a = 1 to b = 8: 

Channel sub range 
i 1 → 2 ← 3 4 5 6 ← 7 ← 8 

^Ri 0.1 70 0.2 20 30 15 0.0 0.02 

^yi 3 60 25 29 32 17 4 3 
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The underlined entries indicate values  
 ̂
Ri  that fall below the threshold and therefore necessitate the channel 

be combined with the nearest channel (indicted by arrows) above the threshold ε. 

The table below shows the new distributions and the channels that were combined to form the new channels: 

Distributions after combining channels 
j 1 2 3 4 

Channels i used to form this channel 1,2,3 4 5 6,7,8 

R′j 70.3 20 30 15.02 

y′j 88 29 32 24 

It is now possible to determine a modified χ′2 : 

 

(30) 

The usefulness of these modifications to the Chi Square statistic will depend on the application. In any case, 
a large number of controlled experiments should be carried out to determine typical values of χ2. Changes of 
χ2 must be observed for controlled changes to the experimental environment, so limiting values of χ2 to 
distinguish random derivations from significant changes of the experiment can be established. 

RUNNING CHI-SQUARE 

The Running Chi-Square (Advanced) statistic calculates the chi-square test for the current distribution 
compared to a previous distribution n records back from the current distribution. In addition to the standard 
weighting and sub-ranging settings, this statistic requires a value for n, the number of distributions back 
from the current. Chi-square test is actually a ratio. Therefore, if two distributions are identical, the value is 1 
(default). 

Standard Deviation (StdDev) 
Standard deviation and variance are indicators of the spread of a distribution about the mean. The narrower 
the distribution, the smaller the variance and standard deviation become. Variance s2 is obtained from 

channel counts yi, mean chord length 
−  
C and midpoints Mi as follows: 

 

 (31) 
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A proof is given in Proof of the Equation used for Mean Chord Length and Standard Deviation. The positive 
square root of the variance is called the standard deviation and is denoted by:  

   

(32) 

%Counts<C, %Counts≥C, Percentile, and Median 
The %Counts<C function returns the percentage P of all chords with chord length smaller than C. The inverse 
of this function is the Percentile function, which returns the chord length C, below which P percent of the 
chords lie. The median is the P=50th percentile and thus represents a special case of the percentile function. 
Finally, %Counts≥C is obtained from %Counts<C via: 

(%Counts≥C) = 100 - (%Counts<C) 

(33) 

The first step for both the %Counts<C and Percentile functions is to calculate the cumulative distribution Qi 
from the channel counts yi and the channel boundaries ci. The cumulative distribution function Qi contains 
the total counts between the left channel boundary ca of the lowest channel a and the left channel boundary 
ci of channel i, where a ≤ i ≤ b and b is the index of the highest channel in the channel sub range. 

Qi is calculated from distribution yi via: 

   
(34) 

Limit cases are 

   

(35) 

for 

 
and 

   

(36) 

where NTotal is the total counts between channels a and b. 

Next, we derive a normalized distribution function that expresses the cumulative counts as percentage of the 
total counts: 

  

 (37) 
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Usage of 
∼
Qi is best illustrated with a concrete example. We start with a linear channel grouping of 100 

channels between 0-1000 µm that yields the following channel boundaries: 

Linear Channel Grouping 

i 1 2 a=3 4 5 B=6 7 … 100 

Left channel boundary ci 0 10 20 30 40 50 60 … 990 

Right channel boundary ci+1 10 20 30 40 50 60 70 … 1000 

Assume that in the statistics setup we selected a limited channel range from 20 - 60 µm, leading to channel 

indices a = 3 and b = 6. The table below shows the calculation of Qi and 
∼
Qi from channel counts yi, using 

equations Eq.(40) and Eq.(43): 

Calculation from Channel Counts 

i Left Bd. ci Right Bd. ci+1    

a=3 20 µm 30 µm 7 0 0% 

4 30 µm 40 µm 23  2.8% 

5 40 µm 50 µm 140  12% 

b=6 50 µm 60 µm 80  68% 

7 60 µm -- --  100% 

The most important columns are columns 2 and 6, which are summarized in the next table. 

Columns 2 and 6 from ‘Calculation from Channel Counts’ Table 

Column 1 2 3 4 5 

Chord length 20 µm 30 µm 40 µm 50 µm 60 µm 

Percent Counts<Chord Length 0% 2.8% 12% 58% 100% 

This table allows us to determine the percentage of total counts below a selected chord length. For instance, 
the table shows that 68% of all counts are below 50 µm. Conversely, it also shows that the 68th percentile is 
50 µm. 

An additional challenge arises when we seek to compute values such as %Counts < 47 µm or the 90th 
percentile, because there is no entry in the table for either of these values. To calculate intermediate values, 
we must employ linear interpolation. The use of linear interpolation is also suggested in [1]. 

In the first example we demonstrate the %Counts < C function by calculating the %Counts < 47 µm. The 
two-point pairs left and right of 47 µm are in columns 3 and 4, namely {40 µm, 12%} and {50 µm, 68%}. 
When we linearly interpolate between two points {x1, y1} and {x2, y2} on an XY graph, any intermediate point 
{x,y} on the line divides both the X-interval [x1,x2] and the Y-interval [y1,y2] into sub intervals [x1,x] and [y1,y], 
such that each have the same proportion to the respective interval: 

  

(38) 

x x1–
x2 x1–
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y y1–
y2 y1–
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Applied to the above point pairs, we get: 

  

(39) 

Solving for P yields: 

  

(40) 

In a second example, we seek to calculate the 90th percentile. The closest two pairs are in columns 4 and 5, 
namely {50 µm, 68%} and {60 µm, 100%}. Using the previous equation for linear interpolation, we get: 

 

 (41) 

Solving for C yields: 

  

(42) 

First Derivative Operation 

This optional operation allows statistical values to be replaced by the difference between the last measured 
statistical value and the previous statistical value. While this is only a crude estimate for the first derivative, it 
can nonetheless be used to indicate sudden changes in the trend. 

Let vk and vk-1 be the current and previous trend values and Tk and Tk-1 the corresponding time stamps (in 
seconds). Then the first derivative is estimated via: 

 

(43) 

Proof of the Equation used for Mean Chord Length and Standard Deviation 

Let X be a discrete random variable with possible outcomes x1, x2, …, xN and pi the relative frequency of 
outcome xi. Applied to our chord length distribution, we can say that we have outcome xi if a single chord 
falls into the chord length interval given by the channel boundaries of channel i. Let yi be the frequency at 
which we have outcome xi, i.e. the number of chords falling into channel i. The relative frequency can be 
determined from the frequency of yi of measuring xi: 

  
(44) 
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The mean is defined as: 

  

(45) 

The standard deviation is defined as: 

  

(46) 

We can consider each channel midpoint Mi as a chord-length measurement xi that occurs with frequency 
yk.  

Combining Eq.(50) and Eq.(51) and replacing xi→ Mi and 
−
x→ 

−
C the mean chord length becomes: 

  

(47) 

Similarly, combining Eq.(50) and Eq.(52) yields the variance. 

Channel Count Conversion 

When converting from the primary 1324 channels to a user-selectable channel distribution (e.g., 38-channel, 
logarithmic progression), the channel counts need to be redistributed based on the relative location of the 
new channel boundaries to the original channel boundaries. 

In the following discussion, let bi be the primary channel boundaries of the 1324 channels, with 0 ≤ i < 1324 
and cj the channel boundaries of the user-selectable channel grouping (e.g., 38 channels with 0 ≤ j  < 38). 
Especially if cj follows a logarithmic progression, the channel boundaries usually will not coincide because 
the 1324 channels are either only 1-µm or 1/4-µm wide (assuming a 2 m/s scanning speed). Therefore, a 
more elaborate scheme is necessary to distribute the channel counts. 

While the target channels are wider than the source channels in most cases, the following calculations hold 
true for either instance and can be used for conversion between any two sets of channel boundaries, no 
matter how irregularly spaced they may be. 

x xi
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N
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∑
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The figure below shows a simple example of how the primary channel counts (mi ) are redistributed to yield 

the regrouped channel counts (nj ): 

 

The counts mi of channel i are distributed into those channels j that overlap with channel i. The channel 
width of channel i is: 

 

(48) 

If dij if the overlap between channel i and channel j, then the fraction of counts channel j receives from 
channel i is the proportion of that overlap to the channel width: 

 

(49) 

If channels i and j have no overlap, then: 

 

and therefore 

 
(50) 

Note that any given channel j can receive contributions from more than one channel, if it overlaps more than 
one channel. To compute the total counts channel j receives, we sum up the contributions from all the 
source channels i: 

 

(51) 

To get the entire re-grouped channel counts, we have to repeat the above process for all j. 

wi bi 1+ bi–=

nij mi
dij
wi
------⋅=

dij 0=

nij 0=

nj nij
i

∑=
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Example 

The following example shows how to calculate the channel counts nj from the source channel counts mi. The 
figure below shows the channel widths for source and target channels. 

 

The non-zero transition widths dij are summarized in this table: 

Non-zero Transition Widths dij 

dij  i=0 i=1 i=2 

j=0 0.5 µm   

j=1 1.0 µm   

j=2 1.0 µm 1.0 µm  

j=3  1.0 µm 4.0 µm 

The corresponding transition counts mij are calculated using Eq.(56), shown here again: 

 

(52) 

The non-zero values of nij as well as grouped channels nj are summarized in this table: 

Non-Zero Values for nij and resulting grouped counts nj 

 i=0 i=1 i=2  

wi 3.0 µm 2.0 µm 4.0 µm  
j=0     
j=1     
j=2     
j=3     

The right-most column shows the new channel counts nj in terms of the old channel counts mi. 

 

 

 

nij mi
dij
wi
------⋅=
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Moment Statistic Equation 

 

 i th  moment of the distribution (order of the moment) 

i th  cumulative distribution 

  

For the Chord Distribution Length (CDL), the integration becomes  

 

 

L  particle size (chord length – midpoint for each channel) 

n(L)  chord counts at size of L 

REFERENCES 

[1] Kennedy, John B. and Neville, Adam M. Basic Statistical Methods for Engineers and Scientists, 1986, 3rd 
Edition (Harper and Row, Publishers, New York) 
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Appendix B: Guidance Document for the use of iC FBRM™, 
iC IR™, iC Raman and iC Quant in 21CFR11-regulated 
environments 

This document outlines the means by which users of METTLER TOLEDO iC FBRM, iC IR, iC Raman and iC 
Quant software can achieve compliance with specific aspects of Title 21, Part 11 of the Code of Federal 
Regulations (commonly known as 21CFR11). All references in italics are taken from the regulation. 

Definitions (from Sec. 11.3): 

(4) Closed System means an environment in which system access is controlled by persons who are responsible 
for the content of electronic records that are on the system. 

(6) Electronic record means any combination of text, graphics, data, audio, pictorial, or other information 
representation in digital form that is created, modified, maintained, archived, retrieved, or distributed by a 
computer system. 

SUBPART B--ELECTRONIC RECORDS 

Sec. 11.10 -- Controls for closed systems 

iC FBRM and iC IR software are closed systems; therefore, these provisions apply. 

a) Validation of systems to ensure accuracy, reliability, consistent intended performance, and the ability to 
discern invalid or altered records. 

The software was developed and tested following approved and controlled SDLC practices within the 
AutoChem ISO9001:2008 certified Quality Management System. Invalid or altered records are detected 
by the software using CRC algorithm technology. When the software detects invalid or altered records, 
the user is presented with a warning dialog as well as a notation in the Document Information pane. The 
user can choose to open the experiment even with invalid or altered data; however, the notation in the 
Document Information pane remains. 

b) The ability to generate accurate and complete copies of records in both human readable and electronic 
form suitable for inspection, review, and copying by the agency. Persons should contact the agency if there 
are any questions regarding the ability of the agency to perform such review and copying of the electronic 
records. 

Records can be viewed in electronic form within the software. Analyzed data records can be printed by 
using the export function in our software and print capabilities in third-party software (such as Excel). 
Audit trails and other document information can be printed using the Copy to Clipboard function in our 
software and print capabilities in third-party software (such as Word or PowerPoint). 

Instructions for exporting to Excel: 

1. Open the experiment that you wish to export. 

2. Click on File - > Export. 
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3. Acknowledge the pop-up message. 

 

4. Enter the name of the file to which you wish to export. Click Save. 

5. The data will now be available for viewing and printing from Excel. 

Instructions for copying to clipboard: 

1. Open the experiment that you wish to export. 

2. Right-click on the area you wish to copy. 

3. Choose 'Copy to Clipboard' and select how you want the data to be copied (as bitmap, as metadata, 
as text (data only)). 

4. Paste into the third party software. The copied information can now be viewed and printed. 

c) Protection of records to enable their accurate and ready retrieval throughout the records retention period. 

Records created by the software are saved as files. It is up to the customer to create SOPs surrounding 
the proper storage and archiving of such files.  

To set the default location for file storage: 

1. Click on Tools - > Preferences. 

2. Set the default document location as specified in the customer SOP. 

d)  Limiting system access to authorized individuals. 

Access to the software is provided to licensed users through the use of the Windows NT logon and 
authentication. Management of user IDs, passwords and control of physical access must be addressed 
through customer SOPs. 

e)  Use of secure, computer-generated, time-stamped audit trails to independently record the date and time of 
operator entries and actions that create, modify, or delete electronic records. Record changes shall not 
obscure previously recorded information. Such audit trail documentation shall be retained for a period at 
least as long as that required for the subject electronic records and shall be available for agency review 
and copying. 

All raw data is secure and cannot be altered once the experiment has been saved as per customer SOPs. 
Any change in the presentation of data, i.e. statistics, averaging, etc., is written to the audit log. The user 
can re-create the presentation of data at a later time. The audit trail cannot be edited, only appended to 
and is retained as long as the experiment document.  Retention of document files is addressed in 11.10c 
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above. The audit log can be reviewed within the software and can be copied using the 'Copy to 
Clipboard' instructions shown above in 11.10b. 

f)  Use of operational system checks to enforce permitted sequencing of steps and events, as appropriate. 

Customer SOPs ensure proper instrument calibration validation and usage.  iC software assists by 
including providing wizards to that guide the user through instrument configuration and experiment 
set-up. 

g)  Use of authority checks to ensure that only authorized individuals can use the system, electronically sign a 
record, access the operation or computer system input or output device, alter a record, or perform the 
operation at hand. 

The software relies on Windows NT logon security for authorization. Management of user IDs, 
passwords and control of physical access is addressed through customer SOPs. 

h)  Use of device (e.g., terminal) checks to determine, as appropriate, the validity of the source of data input or 
operational instruction. 

The software warns the user if the instrument has not had its calibration validated within the last 3 
months. Customer SOPs must be in place to ensure proper instrument calibration validation and usage.  

i)  Determination that persons who develop, maintain, or use electronic record/electronic signature systems 
have the education, training, and experience to perform their assigned tasks. 

Education and training of customer personnel is provided at startup by qualified MT employees.  
Education and training for iC software developers is addressed through the AutoChem QMS. 

j)  The establishment of, and adherence to, written policies that hold individuals accountable and responsible 
for actions initiated under their electronic signatures, in order to deter record and signature falsification. 

Establishment of policies related to personnel accountability is the responsibility of the customer. 

k)  Use of appropriate controls over systems documentation including: 

(1) Adequate controls over the distribution of, access to, and use of documentation for system operation 
and maintenance. 

(2) Revision and change control procedures to maintain an audit trail that documents time-sequenced 
development and modification of systems documentation.  

Document management is addressed through customer SOPs.  This includes document version control. 
Version control of iC software and documentation is addressed by the AutoChem QMS.  

SUBPART C--ELECTRONIC SIGNATURES 
iC FBRM and iC IR software do not have electronic signature capability. 
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